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NOTICES, RESTRICTIONS, DISCLAIMER, WARRANTY 
 

Copyright Notice 
This User’s Manual and the Met Manager™ software are copyrighted © 1999-2002.   
You may print copies of this User’s Manual only for use by you (or your employees) and 
only for use in supporting a valid license of the Met Manager™ software.  You may not 
distribute or transfer the User’s Manual outside of your organization.   
 
Restrictions on Use of the Software 
Installation and use of the enclosed software are governed by the terms of a Software 
License Agreement. This agreement is available during installation of the software and 
from the "Help" menu of the installed software. You can also access this agreement as a 
Microsoft Word® document file from the CD containing the software.  If you (and your 
employer) have not read the agreement or do not understand and agree to all of its terms 
and conditions, then do not install or use the software. 
 
Disclaimer 
Where the definitions and disclaimers defined below are different from the License 
Agreement, the definitions and disclaimers in the License Agreement shall prevail. 
 
Definitions:  
 
a. “Licensor” means vendor, agent, or supplier of the Licensed Product (defined below) 

and as specifically defined in the License Agreement. 
 
b. “Licensee” means the individual or entity acquiring or using the Licensed Product 

(defined below).  
 
c.  “Licensed Product” means (i) the computer program(s) in binary, executable or other 

form associated with the License Agreement, whether resident on media or installed 
on a computer,  (ii) Software Updates (defined below), and (iii) Documentation 
(defined below). 

 
d. “Software Updates” means enhancements, corrections, modifications or additions to 

the Licensed Product including but not limited to replacement versions of the Licensed 
Product. 

 
e. “Documentation” means a user’s manual or other materials and documentation 

accompanying the Licensed Product or related to the installation or use of the Licensed 
Product.  Documentation may be in hardcopy or electronic format. 

  
f. “Instrumentation” means one or more devices, sensors, or subsystems at a single Site 

(defined below) and used directly or indirectly to measure, detect, indicate or control a 
variable or value. 
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g. “Results” means the data or derivative data that the Instrumentation or Licensed 
Product creates, acquires, averages, totals, calculates, displays, presents, records, 
stores, transmits, summarizes, reports, or uses. 

 
h. “Site” means the single, contiguous physical location of Licensee’s operations where 

the Instrumentation is located. 
 
i. “Computer” means a microcomputer containing the Microsoft Windows® operating 

system software (“OS”), provided, however, the Licensed Product is compatible with 
the OS and is intended by Licensor to execute on the same microcomputer with the 
OS. 

 
j. “Authorized Computer(s)” means either (i) in the event Licensee does not obtain a 

Multi User Certificate (defined below), a single Computer located at the Site, or (ii) in 
the event Licensee obtains a Multi User Certificate (defined below), one Computer for 
each Authorized Computer specified in the Multi User Certificate, all of which are 
located at the Site. 

 
k. “Multi User Certificate” means an original and authentic “Certificate of Multi-User 

Software License” purchased by Licensee and signed by Licensor specifying the 
maximum number of Authorized Computers at the Site on which the Licensed Product 
may be installed and used. 

 
Licensor does not have any control over the conditions under which the Licensee uses the 
Licensed Product and does not and cannot warrant the Results obtained by such use.  
Licensor does not warrant the features, functions or contents of the Licensed Product or 
that the Licensed Product or Results obtained from use or operation of the Licensed 
Product will be uninterrupted or error free.  Licensor is not responsible for problems 
caused by operating characteristics of any computer hardware or operating system (OS) 
on which the Licensed Product is installed or operated, or which occur as a result of the 
use of the Licensed Product in conjunction with software or with hardware which is 
incompatible with the OS or with the Licensed Product.  The Licensed Product is 
furnished “AS IS” and without warranty as to the performance or the Results which 
Licensee may obtain by using the Licensed Product.  Licensee assumes the entire risk as 
to the results and performance of the Licensed Product.  
 
Licensee understands that Instrumentation is, by its nature, sensitive, and may be affected 
over time by external forces.  It is, therefore, entirely incumbent on Licensee to routinely 
(i) inspect, maintain, and calibrate the Instrumentation, (ii) perform quality assurance 
with respect to the Instrumentation and its integration with the Licensed Product, (iii) 
perform quality control with respect to the Instrumentation and its integration with the 
Licensed Product, and (iv) validate and verify the Results for reasonability.  The failure 
of Licensee to do any of the foregoing on a routine basis may negatively impact the 
quality and reliability of the Results.  Unless agreed under a separate written contract, 
Licensor shall have no obligation to inspect, maintain, or calibrate the Instrumentation, 
perform quality assurance or quality control, or validate or verify the Results. Licensee 
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further acknowledges that persons using the Licensed Product are responsible for the 
supervision, management, and control of the Licensed Product.  This responsibility 
includes, but is not limited to, the determination of appropriate uses for the Licensed 
Product and the selection of the Licensed Product and other programs or Instrumentation 
to achieve the intended Results.  Persons using the Licensed Product are responsible for 
establishing the adequacy of independent procedures for testing the reliability and 
accuracy of the Results, including all data created, acquired, averaged, totalized, 
calculated, displayed, presented, recorded, stored, transmitted, summarized, reported, or 
used by the Licensed Product. 
 
No representations are made with respect to the contents of this User’s Manual.  Further, 
we reserve the right to revise this manual and to make changes to the content from time 
to time without obligation to notify any person of such revision. 
 
Trademark Notice 
Met Manager™, Met Viewer™ and Met Mirror™ are trademarks of Sensible 
Technologies, Inc., Houston, Texas. 
 
Trademarks or trade names are subject to state and federal laws concerning their 
authorized use or other infringements.  The fact that some product marks or names in this 
manual may not bear a trademark symbol DOES NOT mean that the product name or 
mark is not registered as a trademark or trade name.  Any queries concerning the 
ownership or existence of any trademarks or trade names mentioned in this manual 
should be independently confirmed with the manufacturer or distributor of the product. 
 
Revision Notice (of this User’s Manual) 
 
Release Number Rev Date of Release Description 
450.078.001 1.0 April 20, 2002 Initial release 
450.078.001 1.1 June 18, 2002 Incorporate customer feedback 
450.078.001 1.2 July 21, 2002 Include software enhancements 
450.078.001 1.3 August 14, 2002 Maintenance release 
450.078.001 1.4 September 16, 

2002 
Graph and wind rose auto-scale 
enhancements; new trouble-shooting 
section; new calibration capability 

450.078.001 1.5 December 6, 2002 Add agriculture and energy parameters 
and reports.  Add “difference” as a 
derived parameter. 

 
Warranty 
No warranties are made with respect to this User’s Manual.  The software is warranted 
per the terms of its accompanying Software License Agreement. 
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1 INTRODUCTION 

1.1 General 
Congratulations on your selection of Met Manager™ software with your weather 
(meteorological) station.  Met Manager provides a powerful and easy way to acquire and 
view weather data in a variety of ways. 
 
Weather systems are used in many applications including air quality monitoring, 
diffusion modeling, environmental health and safety (EH&S), environmental studies, 
agriculture, education, energy, fire weather, research, etc.  Generally, the purpose of a 
weather station is to measure and report data that is representative of the local 
environment. This data may include any combination of wind speed, wind direction, 
temperature, humidity, pressure, solar radiation, and precipitation (or rainfall).  
Additional data may include voltage, user-defined parameters, agricultural parameters 
(soil moisture, soil temperature, leaf wetness, and so forth) and many others (see 
Appendix A for a complete list). 

1.2 Features of Met Manager Software 
Some of the features of the Met Manager software include: 
 

• Acquires data in real-time when supported by the data logger in your weather 
station.  The link between the PC computer and the weather station’s data logger 
is serial RS-232 by direct connection.  The connection is usually by serial cable, 
short haul modem, or wireless radio modem.  Depending on the capabilities of the 
data logger, the weather station may measure sensory data as fast as once per 
second. 
 

• Acquires data by capturing it from the internal memory of the data logger (if  
supported by your data logger).  The link between the PC computer and the data 
logger is usually by dial modem or cellular modem, but can also be a direct 
connection. 
 

• Is database-centric.  Acquired data is stored in a database on a PC computer, 
workstation, or a Microsoft®-compatible network file server. 

 
• Stores acquired data into database tables at user-selected intervals of 1, 5, 10, 15, 

20, and 30 minutes and hourly.  The data can represent averages, totals, 
minimums, maximums, standard deviations, change, rates of change, and so forth.  
You can easily view historical data of any of the tables by simple reverse 
scrolling.  
 

• The data records in each data table can be kept indefinitely, or can be deleted 
from the database by a user-defined "wrap" interval (expressed in days).  For 
example, you may want to keep 1-minute data for 7 days, 5-minute data for 90 
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days, and 15-minute and hourly data indefinitely.  
 

• Calculates many derived parameters from the measured parameters.  For example, 
general industrial and non-industrial derived parameters include wind chill 
temperature, heat index temperature, dew point temperature, wet bulb 
temperature, peak wind speed, scalar and resultant vector horizontal wind speed 
and direction, unit vector wind direction, Sigma Theta (standard deviation of 
horizontal wind direction), Sigma Phi (standard deviation of vertical wind 
direction), and so forth.  Energy derived parameters include heating and cooling 
degree days.  Agricultural derived parameters include growing degree days and 
hours, reference and crop evapotranspiration, and chill units and hours.  
Additionally, when acquiring data in real-time from a direct connection to the 
data logger, Met Manager can derive minimums, maximums, change, rates of 
change, difference, and standard deviations for most parameters.  
 

• Is "project-based."  Data is stored in a project folder that you name. 
 

• Makes extensive use of trend graphics.  You can setup named trend charts with 
multiple traces per chart, use of dual y-axis, and so on.  These graphs can also be 
printed and copied to the clipboard.   
 

• Displays a wind rose for graphically viewing wind speed and wind direction data 
as a joint frequency distribution.  You can select time periods of 1, 3, 6, 8, and 12, 
hours, and daily, weekly, monthly or custom-defined. 
 

• Displays readings with one or more indicator views.  You can setup multiple 
indicator views to indicate current readings with the use of digital indicators, 
vertical bar graphs, 120°, 180° and 270° meters, wind direction labels (e.g., SSE, 
CALM, etc.) and wind direction indicators. 
 

• Generates serially-complete data tables.  Missing data records are flagged with a 
missing status tag.  Invalid and calibration data are also tagged within the data 
tables. 
 

• Lets you change the units of measurement for display and reporting purposes. 
 

• Handles sensor slope and offset calibration needs. 
 

• Generates fault, communication error, and system event logs.  Acquired sensory 
data is automatically range-checked against limits that you define.  
Communication faults are logged for system failure diagnostic purposes.   
 

• Generates a number of very useful reports including various data log reports, 
daily summary report, rainfall report, wind frequency distribution report, monthly 
parameter reports, and monthly data recovery.  Agricultural summary reports 
include reference and crop evapotranspiration, chill hours/units, and growing 
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degree days/hours.  Energy summary reports include heating and cooling degree 
days. 
 

• And has many other features including data export to another drive path in 
comma-delimited (CSV), Paradox and dBase formats, a report header that you 
define, and so on. 

 
Met Manager can run on a variety of Microsoft Windows operating systems (Windows 
95, 98, NT 4.0, 2000, and XP).  Met Manager can run on a desktop PC or notebook 
computer, or on a workstation of a Microsoft-compatible network.   Network 
architectures include peer-to-peer and file server. 

1.3 Features of Met Mirror Software 
The use of Met Mirror™ software is optional.  Met Mirror allows you to create and 
maintain a mirror image of data tables on a network file server from a database managed 
by Met Manager on a workstation.  This allows you to acquire and store weather data on 
a workstation independently of the network, but then replicate the data to the network for 
use by others (by the use of Met Viewer as discussed below).  Should the network go out-
of-service for some reason, or be down for maintenance, Met Manager will continue to 
store its data on the local workstation.  Then, when the network is back online, Met 
Mirror can be reactivated to “catch-up” the mirrored data tables.  The Met Mirror 
software is automatically installed with the Met Manager software. 

1.4 Features of Met Viewer Software 
Met Viewer™ software is useful for allowing other network users to have access to the 
weather database.  In a peer-to-peer or file server network, Met Viewer attaches to the 
database maintained by Met Manager, or to a replicated database maintained by Met 
Mirror.  With Met Viewer, you can recall, view, graph, indicate, report, and export the 
data in a variety of ways, and in the same way as Met Manager. 
 
The Met Viewer software product is purchased separately from Met Manager.  Met 
Viewer licenses are available for 1, 5, 10, 20, 50, and unlimited number of users (at one 
physical site location). 

1.5 Organization of User’s Manual 
Section 2 provides an overview of the software including minimum computer 
requirements, and use of Met Manager, Met Mirror and Met Viewer in both non-
networked and networked environments. 
 
Section 3 discusses software installation and configuration. 
 
Section 4 provides a detailed description on using Met Manager. 
 
Section 5 discuses maintenance and calibration operations. 
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Section 6 includes some pointers on troubleshooting, and a list of frequently asked 
questions. 
 
Appendix A is a list of acquired and derived parameters managed by the software. 
 
Appendix B is an overview on installing, configuring, and using the Met Mirror software. 
 
Appendix C provides an overview on installing and using the Met Database Utility 
(MetDBU) software. 
 
Appendix D provides command line options useful for starting Met Manager, Met 
Viewer and Met Mirror in particular ways. 
 
Appendix E presents an overview of the calibration process.  An endpoint-to-endpoint 
calibration is discussed, as well as pros and cons to consider when deciding where and 
how to make calibration adjustments. 
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2 OVERVIEW 

2.1 Minimum Requirements for Using the Software 
The Met Manager software is usually installed on a desktop or notebook personal 
computer (PC), or on a workstation.  Minimum and recommended requirements are listed 
below. 
 

• PC computer with a Pentium or compatible processor 
• Pentium II (or compatible) or higher processor recommended 
• Processor speed of 180 MHz (300 MHz or higher recommended) 
• Microsoft Windows® 95 / 98 / NT4.0 / 2000 / XP Operating System (98 or later 

recommended) 
• 32 MB RAM memory (64 MB or more recommended) 
• Hard disk space requirements: less than 10 MB for programs; database storage 

requirements vary depending on the number of data channels, frequency of data, 
and time period of data stored.  A minimum configuration may require 5 to 10 
MB of data storage, and a maximum configuration may require 100 or more MB. 

• Display resolution of 800 x 600 (1024 x 768 or higher recommended) 
• CD-ROM drive (for installation of the software only)  
• Standard floppy disk drive (for some installations only) 
• A printer is recommended but not required 
• A modem may be required for some applications   
• Standard Microsoft® network protocols are required when used in a network 

2.2 Overview of the Software Suite 

2.2.1 General 
The Met Manager™ suite of software includes Met Manager™, Met Viewer™, and Met 
Mirror™.  Met Manager and Met Mirror come together on one CD.  Met Viewer is 
purchased separately. 
 
Met Manager acquires data from the data logger of a weather station, processes and 
stores both acquired and derived data into a project database, and lets the user view, 
trend, indicate, and report the project data.  The project database can be located on a 
standalone desktop PC, on a workstation of a network, or directly on a network server. 
 
Met Manager can run by itself, or in conjunction with Met Viewer™ and/or Met 
Mirror™ software. 
 
Met Mirror is used to mirror a copy of the master project database to other locations 
within a network.  Its use is optional. 
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Met Viewer allows other workstations in a network setting to view, trend and report the 
project data.  Met Viewer gets its data directly from the original or a mirrored project 
database.    
 
This manual focuses on Met Manager and Met Mirror, but also provides an overview of 
the Met Viewer software. 

2.2.2 Met Manager Software 
Met Manager acquires sensory data from a data logger and derives many additional 
parameters (see Appendix A).  Data parameters, whether acquired or derived, are saved 
in a user-defined project database for viewing, trending, and reporting. 
 
Met Manager makes data available to the user in several formats: data tables, trend 
charts, indicator pages, wind roses, and reports.  Met Manager also logs communication 
and sensor faults that it detects. 
 
Some of the reports provided by Met Manager include data table reports, daily summary 
report, daily rainfall report, monthly parameter reports, monthly wind frequency report, 
and data recovery report. 
 
Additional features of Met Manager include user selection of measurement and display 
units, applying slope and offset calibration values to each sensor channel, and exporting 
of the database in comma-delimited ASCII, Paradox, and dBase file formats. 

2.2.3 Met Mirror Software 
Met Mirror software is used only in a networked environment and its use is optional.  
Met Mirror is used to mirror a copy of Met Manager’s project database to another 
computer on a peer-to-peer or file server network.  Typically this is done for the 
following reasons: 
 

• Met Manager can store its data on a local workstation, and in a way that is 
independent from other users on the network.  Other users may access the 
copy created and managed by Met Mirror, but cannot access the original 
project database. 
 

• Met Mirror is also useful for situations in which the network may temporarily 
go out of service.   In this situation, Met Manager continues to acquire and 
store data on its local workstation, and Met Mirror will update the mirrored 
copy on the network when the network server is back on line. 

 
The Met Mirror software is discussed in Appendix B. 

2.2.4 Met Viewer Software 
Met Viewer software is used only in a peer-to-peer or file server-based networked 
environment.  The operation of Met Viewer is very similar to Met Manager.  The primary 
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difference is that Met Manager gets its data from the data logger and stores that data and 
additional derived data into a project database.  Met Viewer does not get data from a data 
logger.  Met Viewer gets its data from the project database. 
 
A separate User’s Manual is available for Met Viewer with the purchase of Met Viewer 
software. 

2.2.5 Project Folder 
The weather database managed by Met Manager is stored in a “project” folder 
(directory).  The project folder is governed by the following general rules: 
 

• Met project folders are generated by Met Manager or mirrored by Met Mirror. 
 

• Met Manager, Met Mirror and Met Viewer can access a project folder through 
any valid Microsoft® operating system mechanism that supports read/write/create 
access permission for the connected system.  Connection mechanisms include, but 
are not limited to, a local folder, a local area network (LAN) shared folder, a 
remote access (RAS) connection to a shared folder, etc. 
 

• The Met Viewer program can access any valid project folder.  This folder can 
exist on a local path or a network path.  The network path can be through a LAN 
or remote access dial-up connection.  Met Viewer must have read/write/create 
access permission to the project folder. 

2.3 Scenarios for Using Met Manager, Met Viewer and Met Mirror 

2.3.1 General Overview 
It is relatively easy to acquire sensor-based data with Met Manager.  However, it is also 
important to be able to have easy access to the data once it is acquired.  In this section, 
several scenarios provide an overview on how data can be distributed and accessed. 

2.3.2 Scenario 1: Met Manager Only; Local PC (Non-network) 
In this scenario, Met Manager stores its weather data in a database in a project folder 
named “A Met Project” (it can be any name - you name it when you configure Met 
Manager) on the “C:” hard drive of a desktop computer, as shown in the figure below. 
 

 
 

Local PC (Not Networked) 
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This scenario is very common for the following cases: 
 

• With Met Manager, a PC computer has a direct link (hard wire, direct modem, 
or wireless) to a data logger of a weather station.  The project database is 
stored on the PC and is not shared with others in a network. 
 

• With Met Manager, a PC computer dials out to the weather station.  The data 
log is captured from the data logger and is stored on the PC in a project 
database.  The database is not shared with others in a network.   

 
Requirements include: 
 

• The Met Manager user must have read/write/create access permission to the 
project folder. 
 

• The Met Manager program must have read/write/create access permission to 
the Windows registry. 

2.3.3 Scenario 2: Met Manager and Met Viewer; Peer-to-Peer Network 
In this example, Met Manager stores its database in a project folder named “A Met 
Project” on the local workstation’s “C:” hard drive.  One or more users can then connect 
directly to the main Met Manager project folder (in this example, “c:\A Met Project”) 
with the Met Viewer software using standard Microsoft peer-to-peer networking 
protocols.  
 

 
 

Peer-to-Peer Network 
 

Requirements include: 
 

• The Met Manager user must have read/write/create access permission to the 
project folder located on its workstation. 
 

• The Met Manager program must have read/write/create access permission to 
the Windows registry on its workstation. 
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• Met Viewer peer-to-peer network users must have read/write/create access 
permission to the project folder located on Met Manager’s workstation. 
 

• The Met Viewer program must have read/write/create access permission to the 
Windows registry on its workstation. 

2.3.4 Scenario 3: Met Manager and Met Viewer; File Server Network 
The following example demonstrates a file server network with Met Manager and two 
Met Viewer users. Met Manager runs on a workstation and creates and maintains its 
project folder on the server (in this example, “\\server\share\Met\Site 2”).  One or more 
Met Viewer users (on other workstations) then connect directly to the main Met Manager 
project folder on the server (“\\server\share\Met\Site 2”).  
 

 
 

File Server Network 
 

Requirements include: 
 

• The Met Manager user must have read/write/create access permission to the 
project folder located on the network file server. 
 

• The Met Manager program must have read/write/create access permission to 
the Windows registry on its workstation. 
 

• Met Viewer network users must have read/write/create access permission to 
the project folder located on the network file server. 
 

• The Met Viewer program must have read/write/create access permission to the 
Windows registry on its workstation. 
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2.3.5 Scenario 4: Met Manager, Met Viewer and Met Mirror; File Server Network 
with Mirrored Database 

This scenario demonstrates a file server network with Met Manager, Met Mirror and two 
Met Viewer users.  Met Manager manages a master project folder located on its local 
workstation (in this example, “c:\A Met Project”).  Met Mirror creates and mirrors a copy 
of the master database of the project folder onto the server (in this example 
“\\server\share\Met\Site 2”). One or more Met Viewer users then connect directly to the 
mirrored project folder on the server (“\\server\share\Met\Site 2”). 
 

 
 

File Server Network - Mirrored Project Database 
 
Requirements include: 
 

• The Met Manager user must have read/write/create access permission to the 
master project folder located on its workstation. 
 

• The Met Manager program must have read/write/create access permission to 
the Windows registry on its workstation. 
 

• Met Mirror resides on the same workstation as Met Manager.  Met Mirror 
mirrors a copy of the master project database to the network file server. Thus 
the Met Mirror user must have read permission to the master project folder 
located on its workstation and read/write/create permission to the mirrored 
project folder located on the network file server. 
 

• The Met Mirror program must have read/write/create access permission to the 
Windows registry on its workstation. 
 

• Met Viewer network users connect directly to the mirrored project folder 
located on the network file server.  Thus, Met Viewer users must have 
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read/write/create access permission to the project folder located on the 
network file server. 
 

• The Met Viewer program must have read/write/create access permission to the 
Windows registry on its workstation. 
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3 INSTALLING AND CONFIGURING MET MANAGER 

3.1 Installing the Software 
 
IMPORTANT: Met Manager uses the Windows registry to retain information about how 
it was last shut down.  This information is then read from the registry on startup.  
Therefore, Met Manager must be installed in a way that it can have create/read/write 
access to the Windows registry.  Before installing the software, ensure that your 
Windows log-on profile is configured to allow Met Manager to have create/read/write 
access to the Windows registry.   
 
Refer to Section 2.3 for scenarios for using Met Manager, Met Viewer, and Met Mirror.  
Included are requirements for project folder read/write/create access permission 
depending on your application requirements. 

 
To install the software simply place the Met Manager installation CD in to the CD drive.  
The install program should automatically run.  Then follow the on-screen instructions. 
 
If the install program does not automatically run, then follow these steps (with the CD in 
the CD drive): 
 

1. Click on the "start" button (on Windows desktop), then select the "run" menu 
item. 

 
2. Type d:\install.exe (replace "d" with the drive designator of your CD drive) and 

press the OK button.  
 
IMPORTANT: After installing the software, be sure to review the README.TXT text 
file located on the installation CD.  This file includes additional documentation not 
included in this User’s Manual as well as a list of known issues with the software. 

3.2 Steps to Setting Up Met Manager 
After the Met Manager software is installed, it must be configured for use. Follow these 
steps: 
 

1. On your computer, check the Microsoft Windows’ computer date, time and 
time zone settings.  Correct them if necessary.   Ensure that the Windows-based 
daylight saving time adjustment setting is checked (enabled) if daylight saving 
time applies to your computer during any time of the year. 
 

2. Create a project folder to store data and configuration settings.  You have two 
options: 1) create a new project from scratch or 2)create a new project from an 
existing project.  See Section 3.3. 
 

   
Configuring Met Manager Page 3-1 Rev: 1.5 



Met Manager™ User’s Manual  Copyright © 2002 

3. Configure site settings such as latitude, longitude, elevation, and time zone.  
See Section 3.4. 
 

4. Configure the data source.  This defines where the sensory data comes from; for 
example, continuous direct-connection with the data logger in real time or by 
dial-up connection to the internal memory log of a data logger.  See Section 3.5. 
 

5. Assign parameters to the data source.  This defines the various sensor channels 
and ordering of data received from the data logger, and the base units, 
measurement height, decimal display digits, and slope and offset coefficients to 
convert the acquired measurement to base units.  See Section 3.6. 
 

6. Assign parameters to be stored in the database.  This defines both acquired 
sensor parameters and derived parameters to be stored in a database for later 
viewing, trending, reporting and exporting.  See Section 3.7. 
 

7. Define data tables and related time intervals to hold the database parameters.  
Tables include 1, 5, 10, 15, 20, 30-minute, and hourly time intervals.  See 
Section 3.8. 
 

8. Connect to the data source.  With this step, Met Manager can begin receiving 
data from the weather station.  See Section 3.9. 
 

9. After following the instructions in Section 3.9, verify that Met Manager is 
receiving data from the data source. View the data from the Instantaneous View 
(see Section 4.6) and the Data View (see Section 4.4).  If you have intermittent 
communication problems, review the “Current Data Source Events” tab of the 
Event Log.  See Section 4.5.   
 

10. Calibrate the weather station sensors and subsystems.  See Section 5.2 and 
Appendix E. 
 

11. Review the “Current Faults” tab of the Event Log to ensure that all measured 
values are within the minimum-to-maximum range defined for each data source 
parameter.  See Sections 4.5 and 3.6. 
 

12. Configure new trend charts and review existing ones (if any).  See Sections 4.8, 
4.9 and 4.10. 
 

13. Configure new indicator pages and review existing ones (if any).  See Sections 
4.11 and 4.12. 
 

14. Configure a new wind rose or review an existing one (if any).  See Sections 
4.13 and 4.14. 
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15. Configure the Data View and report options.  See Section 4.15. 
 

16. Configure display options when Met Manager is started.  See Section 4.16. 
 

 
IMPORTANT: Configure Met Manager to automatically startup when Windows starts 
up.  Place a shortcut of the Met Manager executable program (MetMgr.exe) in the 
Windows “Startup” folder.  This folder may be located under “Administrators”, “All 
Users”, “Default Users“, or may be applicable only to your particular log-on profile 
depending on your version of Microsoft Windows.  Check with your network or system 
administrator for the proper startup folder to contain the Met Manager shortcut. 
 
Command line options can be used to force Met Manager to open a particular project and 
data source when starting up in Windows.  Command line options are not required, but if 
you use them, you will want to assign them to the Met Manager shortcut in the Windows 
“Startup” folder.  See Appendix D.  
 

3.3 Creating a New Project  
Met Manager stores its data into a “project”.  A project is simply a folder name that you 
assign, and is a location for holding the data and configuration settings associated with 
the project.  To create a new project, select “New Project” from the File menu.  See the 
figure below. 
 

 
 
You have two options: 1) create a new project from scratch or 2) create a new project 
based on an existing project.  Each of these options is explained below. 
 

3.3.1 Creating a New Project from Scratch 
In the example below, a new project is created from scratch on drive C of the local 
workstation, and is named “Weather Data”.  
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(The above figure is an example only; your configuration may be different.) 
 

Be sure to include the drive designator to the project path/folder name.  In the above 
example, the drive designator is “C:\”; yours may be different.  You can also press the 
“browse” button to locate the path or folder that will contain your project folder. 
 
You must configure all elements of a new project that is created from scratch.  Follow 
these steps in the order given: 
 

1. Configure your site settings for the location of the weather station.  These settings 
include latitude, longitude, elevation and time zone.  See Section 3.4. 
 

2. Configure the data source; that is, define where the sensory data comes from and 
properties such as serial communications port or modem and phone number, baud 
rate and so forth. See Section 3.5. 
 

3. Assign parameters to the data source.  This defines the various sensor channels 
and ordering of data received from the data logger, and the base units, 
measurement height, decimal display digits, and slope and offset coefficients to 
convert the acquired measurement to base units. See Section 3.6. 
 

   
Configuring Met Manager Page 3-4 Rev: 1.5 



Met Manager™ User’s Manual  Copyright © 2002 

4. Assign parameters to be stored in the project database.  This defines both acquired 
sensor parameters and derived parameters to be stored in a database for later 
viewing, trending, reporting and exporting.  See Section 3.7. 
 
IMPORTANT: Be sure to review all wind speed and wind direction database 
parameter assignments for your particular application.  Wind speed database 
parameters include scalar wind speed and resultant wind speed.  Wind direction 
database parameters include scalar wind direction, resultant vector wind direction, 
and unit vector wind direction.  USEPA or other state or local governmental 
requirements may require specific parameters, or may require all, depending on 
your application.  When in doubt you may wish to record all of them.  That way, 
the data will be available should you later need it. 
 

5. Define data tables and related time intervals to hold the database parameters.  
Tables include 1, 5, 10, 15, 20, 30-minute, and hourly time intervals.  See Section 
3.8. 
 
IMPORTANT:  USEPA or other state or local governmental requirements may 
require that you record your data at specific intervals, usually 15-minutes and 
hourly.  However, you may wish to also record 1-minute data with a short wrap 
interval of 7, 14, or 30 days and 5-minute data with a wrap interval of 1 to 3 
months.  That way you can inspect the data at a higher frequency.  In order to 
minimize data storage and potential problems with larger data tables, we 
recommend that you limit your 1-minute data table to 1 month (30 days) of 
storage or less, your 5-minute data table to 6 months (185 days) or less, and your 
10-minute data table to 1 year (365 days) or less.  The 15-minute, 20-minute, 30-
minute, and hourly data tables can be kept indefinitely. 
 

6. Connect to the data source.  With this step, Met Manager can begin receiving data 
from the weather station.  See Section 3.9. 
 

After you have connected to the data source and followed the guidelines of Section 3.9, 
then complete these steps: 
 

1. Verify that Met Manager is receiving data from the data source. View the data 
from the Instantaneous View (see Section 4.6) and the Data View (see Section 
4.4).  If you have intermittent communication problems, review the “Current Data 
Source Events” tab of the Event Log.  See Section 4.5. 
 

2. Calibrate the weather station sensors and subsystems.  See Section 5.2 and 
Appendix E. 
 

3. Review the “Current Faults” tab of the Event Log.  If it is empty then all 
measured values are within the minimum-to-maximum range defined for each 
data source parameter.  See Sections 4.5 and 3.6. 
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4. Configure new trend charts.  See Sections 4.8, 4.9 and 4.10. 
 

5. Configure new indicator pages (views).  See Sections 4.11 and 4.12. 
 

6. Configure a wind rose.  See Sections 4.13 and 4.14. 
 

7. Configure the Data View and report options.  See Section 4.15. 
 

8. Configure display startup options.  See Section 4.16. 
 

9. Configure Met Manager to automatically startup when Windows starts up. 

3.3.2 Creating a New Project from an Existing Project 
A new project can be created from an existing project.  Met Manager simply copies over 
the existing project configuration settings to the new project folder.   This greatly 
simplifies setting up a new project. 
 
In the example below, a new project is created on drive C of the local workstation, and is 
named “Weather Data”.   This new project is created from an existing project named 
“seawall site” that is located on drive C in folder “projects”.  
 

 
 

(The above figure is an example only; your configuration may be different.) 
 

This method is useful for starting a new project to hold the weather data while keeping 
your existing site settings, data source parameter settings, database parameter settings, 
data table settings, trend charts, and indicator displays.  The new project gets the old 
configuration settings and begins a new database from those settings. 
 
This method is also useful for starting a new project with configuration settings supplied 
by the manufacturer of the weather station.  Check your weather station 
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documentation to see if you can create a new project based on an existing factory-
supplied configuration.  If available, the factory configuration will usually be supplied 
on a separate floppy disk or CD. This can save you time in getting your project 
configured and operating. 
 
Be sure to include the drive designator to the project path/folder names.  In the above 
example, the drive designator is “C:\”; yours may be different.  You can also press the 
“browse” button to locate the path or folder that you want to put your project folder in. 
 
You must configure some of the elements of a new project that is created from an existing 
project.  Configuration steps include: 
 

1. Check your site settings.  These will be zero if you created your project from a 
factory-supplied configuration.  See Section 3.4. 
 

2. Check your data source assignment and configure its properties as needed, 
especially the communication port or modem settings.  See Section 3.5. 
 

3. Check your sensor channel assignments to the data source.  Add or delete channel 
assignments as needed.  See Section 3.6. 
 

4. Check your measured and derived parameters to store in the PC’s database.  Add 
or delete database parameters as needed.  See Section 3.7. 
 
IMPORTANT: If you are creating a new project from a factory-supplied 
configuration, then be sure to review all wind speed and wind direction database 
parameter assignments for your particular application.  Wind speed database 
parameters include scalar wind speed (default) and resultant wind speed.  Wind 
direction database parameters include scalar wind direction (default), resultant 
vector wind direction, and unit vector wind direction.  The factory-supplied 
configuration may only include the default parameters.  However, only you (or 
your employer) can determine which parameters apply to your particular 
application.  USEPA or other state or local governmental requirements may 
require specific parameters, or may require all, depending on your application.  
When in doubt you may wish to record all of them.  That way, the data will be 
available should you later need it. 
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5. Check your data tables to hold the parameters in the project database; 1-minute 
table, 5-minute table, and so forth.  Make any needed changes to the configuration 
such as including or excluding tables from the database, or modifying the “wrap 
interval” of each table.  See Section 3.8.  
 
IMPORTANT:  USEPA or other state or local governmental requirements may 
require that you record your data at specific intervals, usually 15-minutes and 
hourly.  However, you may wish to also record 1-minute data with a short wrap 
interval of 7, 14, or 30 days and 5-minute data with a wrap interval of 1 to 3 
months.  That way you can inspect the data at a higher frequency.  In order to 
minimize data storage and potential problems with larger data tables, we 
recommend that you limit your 1-minute data table to 1 month (30 days) of 
storage or less, your 5-minute data table to 6 months (185 days) or less, and your 
10-minute data table to 1 year (365 days) or less.  The 15-minute, 20-minute, 30-
minute, and hourly data tables can be kept indefinitely. 
 

6. Connect to the data source to begin acquiring data.  See Section 3.9. 
 
After you have connected to the data source and followed the guidelines of Section 3.9, 
then complete these steps: 
 

1. Verify that Met Manager is receiving data from the data source. View the data 
from the Instantaneous View (see Section 4.6) and the Data View (see Section 
4.4).  If you have intermittent communication problems, review the “Current Data 
Source Events” tab of the Event Log.  See Section 4.5. 
 

2. For a new system, calibrate the weather station sensors and subsystems.  See 
Section 5.2 and Appendix E. 
 

3. Review the “Current Faults” tab of the Event Log.  If it is empty or there are no 
current faults, then all measured values are within the minimum-to-maximum 
range defined for each data source parameter.  See Sections 4.5 and 3.6. 
 

4. Modify existing trend charts and create new ones as appropriate.  See Sections 
4.8, 4.9 and 4.10.  You may have to acquire data for a while (from a few hours to 
a day or so) so that you can see how the trend chart handles the data. 
 

5. Modify existing indicator pages and create new ones as appropriate.  See Sections 
4.11 and 4.12. 
 

6. Modify the existing wind rose or create a new one as appropriate.  See Sections 
4.13 and 4.14.  As with trend charts, you may have to acquire data for a while so 
that you can see how the wind rose handles the data. 
 

7. Review and configure the Data View and report options.  See Section 4.15. 
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8. Review and configure display startup options.  See Section 4.16. 
 

9. Configure Met Manager to automatically startup when Windows starts up. 

3.4 Configuring the Site Settings 
Site settings are used to define the location of the weather station and time zone 
information.  To configure the site settings, select the Setup menu and then “Site 
Settings”: 
 

 
 
Next, define the latitude, longitude, and elevation at the location of your weather station, 
and the time zone: 
 

 
 

Latitude and longitude are a coordinate system used to locate points on the earth’s 
surface. Latitude is the angular distance, in degrees, minutes and seconds of a point north 
or south of the Equator.  Longitude is the angular distance, in degrees, minutes, and 
seconds of a point east or west of the Prime Meridian (Greenwich, England).  Longitudes 
are measured in half circles of 0 deg to 180 deg East and from 0 deg to 180 deg West of 
the Prime Meridian. 
 

   
Configuring Met Manager Page 3-9 Rev: 1.5 



Met Manager™ User’s Manual  Copyright © 2002 

All USA points are located with northern latitude and western longitude.  You may be 
able to get latitude and longitude for your location from the world wide web.  Simply 
search the web for the keywords “latitude” and “longitude”.  The web also has calculators 
for converting decimal degrees to the “degree, minute, second” format required by Met 
Manager. 
 
Enter the elevation of the location of the weather station in meters. 
 
The "Time zone offset" is normally zero, but can be set to +30 or -30 if your specific time 
zone is not listed but is 30 minutes from the closest time zone listed in the "Time zone" 
list box.  Usually the “Time zone offset” is not required since most worldwide times 
zones are listed. 
 
 
Note: The latitude, longitude, and time zone settings are used in calculations that require 
locating the orientation of the sun.  Elevation is useful for estimating barometric pressure.  
Be sure to define the elevation in meters.   
 
Latitude, longitude and elevation settings are required for calculating reference 
evapotranspiration.  Be sure to properly setup these parameters if you are using Met 
Manager to calculate reference evapotranspiration. 
 

3.5 Configuring the Data Source 

3.5.1 Overview of Data Sources 
Met Manager gets its raw sensor-based data from a data source.  A data source is simply 
an object such as a data logger or data file that is the source of sensory-based data. 
 
Met Manager commonly interfaces to the following types of data sources depending on 
the capabilities of your data logger: 
 

• “Direct Connect” data source.  This includes a data logger that is directly-
connected to the computer on which Met Manager resides, and that regularly 
transmits its data to Met Manager.  The direct connection can be by serial 
cable, short haul modem, other direct-connect modem, or wireless radio 
modem. 
 
Choose a “Direct Connect” data source when the PC computer is directly-
connected to the data logger of the weather station and you want to frequently 
(at least every few seconds or so) get data from the logger. 

 
• “Data Log Capture (Modem)” data source.  This includes a remote data logger 

that stores its data into an internal memory log and must be periodically 
captured by Met Manager.  Met Manager connects to the data logger with a 
dial modem or cellular phone. 
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Choose a “Data Log Capture (Modem)” data source when you wish for Met 
Manager to get data from the internal memory log of a remote data logger by 
telephone modem or cellular phone dialup.   
 

• “Data Log Capture (COM Port)” data source.  This includes a data logger that 
is directly-connected to a COM (serial) port of the computer on which Met 
Manager resides but that stores its data into an internal memory log and only 
periodically transmits its internal log to Met Manager on request of Met 
Manager.  The direct connection can be by serial cable, short haul modem, 
other direct-connect (i.e., non-dial) modem, or wireless radio modem. 
 
Choose a “Data Log Capture (COM Port)” data source when the PC is directly 
connected to a data logger by serial communications (COM) and you wish to 
capture data from the log memory of the data logger periodically, but rather 
infrequently.  For example, this option could be used to get data once a day, 
every few days, or on demand. 
 
This data source is also useful when your weather station is in a remote 
location with no telephone access.  You travel to the remote location with a 
notebook PC, connect up, and then with Met Manager you capture the data 
from the data logger to the notebook PC. 
 

• CSV or data log “File Import” data source.  Choose this data source to build 
the Met Manager database by importing a comma-delimited (CSV) file or a 
data log file that has already been saved to disk. 

 
Note: Different data logger applications support different types of data sources. Some of 
the data sources defined above may not be available to you, depending on the particular 
capabilities of your system.   

 
To configure your data source, first select the Setup menu, then “Data Sources”: 
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If no data sources have been assigned, then the following dialog will be displayed.   
 

 
 
Press the “New” tool button to pick and assign a data source for your particular 
application: 
 

 
 

 
Press the down arrow button to select the type of data source that you want to create: 
 

• Direct Connect 
• Data Log Capture (COM Port) 
• Data Log Capture (Modem) 
• Data Log File Import  
• CSV File Import 
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Note: The list above shows different types of data sources for different data logger 
applications.  Your list may be different and may not include all of the above types of 
data sources, depending on the capabilities of your system. 
 
After picking a data source from the list, a display similar to the following is shown, with 
the new data source then being added to the “Data Sources” display: 
 

 
 

(The above figure is an example only; your configuration may be different.) 
 

IMPORTANT: With your mouse, select the data source that you want to use and then 
press the “Set as Default” button to make that particular data source the active one.  A 
little check mark should appear above the data source, and the name will be assigned as 
the default in the “Default Data Source” field at the bottom of the dialog box. 
 
Note: Actual data source names may include a one or two word descriptor that identifies 
the data logger and precedes the names given above. 
 
CAUTION:  While the above figure shows that multiple data sources can be created for 
an application, you may activate only one data source for a particular project.  Therefore 
you should create only one data source for your particular application.  Remove unused 
data sources by deleting them (as explained below).   
 
To delete a data source, select its icon, then press the “Delete” button.  You can always 
recreate it later by pressing the “New” button should your application requirements 
change. 
 
To rename a data source, select the data source icon, then press the “Rename” button.  
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IMPORTANT: The name of the data source may be used by other services of the Met 
Manager Suite of software; for example for startup automation of Met Manager (see 
Appendix D).  Therefore, if you change the name of the data source, be sure to 
reconfigure any other services that refer to that data source with the new name. 
 
Once a data source has been created, you must further edit its properties.  Select the 
data source icon with the mouse, then press the “Properties” button (or double-click the 
icon).  The following sections discuss ways to configure the properties of different types 
of data sources. 

3.5.2 “Direct Connect” Data Source Properties 
To set the properties of the “Direct Connect” data source, select its icon with the mouse 
(or double click it), then press the “Properties” button.  Configure the communications 
COM port setting, baud rate, and sample rate.  The following example shows 
communications with the data logger through the PC COM1 port at a baud rate of 9600.  
A sample rate of 5 seconds means that Met Manager will receive data from the data 
logger every 5 seconds. 
 

 
 

(The above figure is an example only; your configuration may be different.) 
 
Note: The data logger must be programmed to transmit its data to Met Manager at the 
configured sample rate.  Programming the data logger is outside of the scope of the Met 
Manager software.  Refer to your weather station or data logger manuals or consult with 
your weather station or data logger vendor. 
 

3.5.3 “Data Log Capture (Modem)” Data Source Properties 
To set the properties of the “Data Log Capture (Modem)” data source, select its icon with 
the mouse (or double click it), then press the “Properties” button.  Configure the active 
modem device, phone number, sample rate, and number of channels in the data log: 
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(The above figure is an example only; your configuration may be different.) 
 
Note: Prior to setting up the “Data Log Capture (Modem)” data source, you must first 
install the computer’s modem in Microsoft Windows.  This is typically done with modem 
software supplied by the modem manufacturer, and is outside the scope of the Met 
Manager software.  If not installed beforehand, then the “modem device” field list may be 
blank. 
 
Be sure to obey the phone number dialing rules at your location.  Some places require a 
10-digit phone number for local calls.  Most places require a 1 before the 10-digit 
sequence for long distance calls.  Some internal telephone systems require dialing a 9 
followed by a short delay to get an outside line. To do this, enter 9 followed by a comma.  
Each comma creates a two second delay.  To make the delay longer, simply insert more 
commas.  For example, suppose you wish to dial a long-distance number to area code 
“123” and need to select 9 to get an outside line.  The entry format would be 9,1-123-
456-7890. 
 
IMPORTANT:  Set the sample rate to match the rate in which the data logger stores its 
data within its internal log memory.  For example, this may be once every 5 minutes 
(00:05:00), 15 minutes (00:15:00) or once per hour (1:00:00).  In the above example, a 
sample rate of 15 minutes means that the data logger will log a data record to its internal 
memory every 15 minutes.  
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Note: Some data logger configurations may not require the “Number of channels in data 
log” field above.   In that case the field will be missing from the dialog.  Other 
configurations may have a “clear” setting for user control over clearing the memory log 
of the data logger. 
 
Note: The data logger must be programmed to store data into its internal memory log and 
to transmit the log to Met Manager when requested by Met Manager.  Programming the 
data logger is outside of the scope of the Met Manager software.  Refer to your weather 
station or data logger manuals or consult with your vendor. 
 

3.5.4 “Data Log Capture (COM Port)” Data Source Properties 
To set the properties of the “Data Log Capture (COM Port)” data source, select its icon 
with the mouse (or double click it), then press the “Properties” button. Configure the 
serial communications port (COM1, COM2, etc.), baud rate, sample rate, and number of 
sensors in the data log.  This is similar to configuring the “Data Log Capture (Modem)” 
data source above except that you configure a serial communications port instead of a 
modem. 

3.5.5 CSV or Data Log “File Import” Data Source Properties 
To set the properties of a “File Import” type of data source, select its icon with the mouse 
(or double click it), then press the “Properties” button. 
 

 
 

(The above figure is an example only; your configuration may be different.) 
 
Configure the sample rate to match the time interval of the data within the imported file.  
The format is “hh:mm:ss” where “hh” is hours, “mm” is minutes, and “ss” is seconds.  
For example, if the data records are 15 minutes apart, then set the sample rate to 
“00:15:00”. 
 

3.6 Assigning Sensor Channels to the Data Source 
The purpose of assigning sensor channels to a data source (typically a data logger but 
sometimes an import data file) is to let Met Manager know the order and type of 
information coming from the data source.   You must have separate documentation on 
sensor channel assignments from your weather station supplier. 
 
The linkage between Met Manager and the data source is defined by the type and order of 
data within the output data stream of the data source: 

   
Configuring Met Manager Page 3-16 Rev: 1.5 



Met Manager™ User’s Manual  Copyright © 2002 

 

Data Source

Met Manager

Data Stream

 
 

Checksum (optional)

09/16/2002,07:30:00,4.23,326,21.3,29.92,0.00,78.1,11.53,23.4,653,1234

Example Data Stream

Solar Radiation
Enclosure Temperature

Battery Voltage

Relative Humidity

Rainfall

Barometric Pressure

Ambient Temperature

Wind Direction

Wind Speed

Time (Capture and File Data Sources Only)

Date (Capture and File Data Sources Only

 
 
The above figure is meant to show an example of a data stream to illustrate the importance of 
ordering within the stream.  Your configuration will probably be different.  Depending on your 
particular data logger model, continuous direct-connect data sources may not include the date and 
time parameters (if these parameters are assigned by Met Manager).  The checksum helps to 
identify communication errors but is optional with some data loggers.  Also, the above example 
shows a comma as a data delimiter; however, other data sources may use other delimiters.  
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CAUTION:  Unless you are setting up a brand new project, and you wish to add or 
remove one or more sensor channels or database parameters to (or from) the project, then 
follow the guideline below.   Read all of the steps below before making any changes.  
Then make the changes in the order given. 
 

Guideline for Adding or Deleting Data Source or Database Parameters 
 

1. Before adding or removing data source parameters (that represent sensors) or  
database parameters: 
 

a. Stop Met Manager (exit the program). 
b. If you have a peer-to-peer network configuration, then stop any Met 

Viewer users attached to the master project folder.  The master project 
folder is the one managed by Met Manager. 

c. Back up the master project folder (or copy the entire project folder to an 
archive location).  Be sure to first exit the Met Manager program (step a), 
so that Met Manager will not be adding new data to the project database 
while the backup (or copy) program is running.  The purpose of the 
backup (copy) is to both protect your master weather database should you 
make a mistake, as well as to archive your master database before making 
substantial changes to it.  Keep in mind that removing sensors from the 
data source will likely affect your derived database parameters. 
 

2. If you are using the optional Met Mirror software to mirror your local weather 
database to a network file server or other location, then: 
 

a. Stop Met Mirror and cause it to exit (see Appendix B). 
b. Create a new empty project folder on the network file server to retain the 

modified mirrored project database.  Use Windows File Explorer (or 
similar software) to create the new empty destination project folder on the 
network server. 
 

3. With Met Manager, make any needed data source parameter (sensor) and database 
parameter additions or deletions: 
 

a. Restart Met Manager.  
b. Close Met Manager’s connection to the data source, if it is currently 

active.  Choose the “Close Connection” item under the “Setup” menu. 
c. Make the data source parameter additions or deletions by following the 

instructions below these guidelines (remainder of Section 3.6 and below 
step 5). 

d. Make any needed database parameter additions or deletions as discussed 
in Section 3.7.  Met Manager will automatically restructure its database 
when you are finished (as signified by pressing the OK button on the 
Database Parameters Editor dialog).  Thus it’s best to make all database 
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parameter additions and deletions at one time before pressing the OK 
button. 

e. Reconnect Met Manager to the data source.  From the Setup menu, choose 
“Connect to …” and connect to the appropriate data source.  Met Manager 
should then begin acquiring data from the data source, and storing that 
data into the modified project database. 
 

4. If you are using the optional Met Mirror software, then: 
 

a. Point Met Mirror through Met Mirror’s definition settings to the new 
project folder pathname.  Simply change the name of the destination 
folder to the new path.  Save Met Mirror’s new definition settings. See 
Appendix B. 

b. Restart Met Mirror.  As appropriate, first modify any Met Mirror startup 
command line options (if used). 

c. Copy all Met Viewer user settings files from the original mirrored project 
location to the new location.  The file names end with the extension 
“.mvs”.  DO NOT COPY ANY ADDITIONAL FILES.  Use Microsoft 
Windows Explorer or equivalent software to make the copy.  This step 
ensures that all Met Viewer users can now access the new project database 
with their current view settings. 

 
5. If you have Met Viewer users, then: 

 
a. Have each Met Viewer user open the project at the new pathname 

location. 
b. Have each Met Viewer user adjust indicator views, wind roses, and trend 

charts to reflect the changes (additions and deletions) to the database. 
c. As appropriate, modify any Met Viewer startup command line options (if 

used). 
 
Data types (pressure, precipitation, temperature and so forth) are assigned to the various 
sensor channels of the active data source. To assign sensory data types to the data source, 
select “Data Source Parameters” from the Setup menu:    
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(The above figure is an example only; See Appendix A 
for a list of all supported Data Source Parameters.) 

 
Note: If the parameters in the top of the above figure are not displayed, then select “Close 
Connection” from the Setup menu to show them. 
 
As shown in the figure above, the example data source was configured with 9 sensor-
based channels (see the Data Source Parameter List in the figure).  Each channel was 
setup by selecting and dragging a data type from the top box to a channel number in the 
left-hand box.  The data type must match the sensor that is associated with that channel.  
Then, each channel’s assigned data type is converted to a data source parameter by 
selecting the channel name in the left-hand box and editing its properties in the right-hand 
box.  
 
For example (and as shown above), a “Temperature” data type was initially assigned to 
channel 3 by selecting the “Temperature” data type from the top box and dragging and 
dropping it onto channel 3.   Then that channel was converted from a data type to a data 
source parameter by setting its properties in the right-hand box: (1) renaming it to 
“Ambient Temperature” in the “Description” property, (2) setting its base units to °C, (3) 
setting its height (level) above the ground to 2 meters, (4) setting its slope and offset 
values to convert the value received from the data source to base units, and (4) setting its 
range of valid values (in base units). 
 
Similarly, the “Precipitation” data type was initially assigned to channel 5 and then 
converted to a data source parameter by renaming it to “Rain” in the “Description” field 
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and setting its other properties.  Also, “Pressure” was renamed “Barometric Pressure”, 
“Humidity” as “Relative Humidity”, and “Voltage” as “Battery Voltage”. 
 
The “EMPTY” data type allows you to remove a channel assignment, or to define a data 
value to ignore within the received data stream.  Just drag and drop the “EMPTY” 
parameter to a channel number.  Or, select the channel number that you wish to delete, 
and press the “delete” key on your keyboard. 
 
In the right-hand box, the “Base units” represents the units that Met Manager assigns to 
the parameter after applying the base unit conversion slope and offset values. These slope 
and offset values are typically used for converting a raw value (data source parameter) in 
voltage or counts to a value in the base units, or for converting a value received in one 
engineering unit to another.  If the received value is already in the desired base units, then 
the slope should be 1 and the offset 0 (as in the above figure).  Calibration slope and 
offset corrections are assigned elsewhere; see Section 5.2. 
 
The “Height (meters)” field is the measurement height of the sensor above the ground (or 
below ground for soil moisture sensors), in meters.  Met Manager uses this parameter as a 
label, for example to identify wind speed at two different heights on a tower or soil 
temperatures at different depths.  If you are not concerned about using height as a label, 
then you may leave this field blank.  
 
Note: The above height parameter is used only as a label and is not used in calculations. 
However, the calculation of some derived parameters may depend on the height of the 
sensor.  In that case, the derived parameter will have a separate height-related parameter 
for you to set up (see Section 3.7).  
 
The “User override status” field allows the user to override the channel’s “normal” status 
with “calibrate” or “invalid” status. This is useful in keeping questionable data out of the 
database by flagging the channel with “calibrate” or “invalid” status when the system is 
first started up.  Once initial data has been acquired and verified, then the “User override 
status” can be set to "none".  The normal status is “none” (i.e., no override of the status). 
 
The “Decimal display digits” field is the number of decimal places to display to the right 
of the decimal point when showing the parameter on the left-hand side of the 
Instantaneous View (see Section 4.6).   
 
The “Minimum” and “Maximum” fields are used for range checking of the parameter.  
When new data is received from the data source, the data parameter’s value is range-
checked in base units, and after applying calibration adjustments.  When Met Manager 
detects that a parameter’s value is out-of-range, then Met Manager logs the date/time, 
parameter, and fault value in a fault log and sets the status of the parameter to “invalid”.  
Refer to Section 4.5.  The parameter status returns to “valid” when back in range. 
 
To summarize, the above figure shows that 9 channels of data are received in the data 
stream from the example data source.   Each channel began as a data type (for example, 
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temperature or precipitation) and was then assigned some property values to convert it to 
a data source parameter.  Properties include a descriptive name (for example, ambient 
temperature or rainfall) and height.  By supplying additional information, you can assign 
base units, linear conversion slope and offset values for converting the received raw value 
into the base units, and so forth. 
 
Wind speed has some additional information related to calm winds: 
 

 
 

(The above figure is an example only; your configuration may be different.) 
 
The “calm wind threshold” is that value below which the wind should be considered 
calm.  The unit of the “calm wind threshold” is specified in the “Base units” field.   The 
value you should assign for the threshold usually depends on the manufacturer’s 
specifications of the wind speed and wind direction sensors, and is the highest of the two.   
For example, if the manufacturer-assigned calm threshold for the wind speed sensor is 
0.5 mph and for the wind direction sensor is 1.0 mph, then the “calm wind threshold” 
should be set to 1.0 mph. 
 
Met Manager will set wind speed readings less than the calm threshold to one of: 
 

• Use as is - The wind speed value will not be adjusted when it is below the calm 
wind threshold.  However, the wind direction value will be set to 0 to indicate 
calm winds. 

• Zero (0.0) - The wind speed value will be set to 0.0 when below the calm wind 
threshold.  The wind direction value will be set to 0 to indicate calm. 

• ½ Threshold - the wind speed value will be set to ½ the calm wind threshold 
value when below the calm wind threshold.  The wind direction value will be 
set to 0 to indicate calm. 

 
For example, in the above figure, wind speed values below 1.0 mph will be set to 0.0 
mph.  Wind speed and wind direction will be considered calm. 
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Note:  Some weather systems may consider both 0 and 360 degrees as a wind direction 
from the north.  To avoid ambiguity, Met Manager reports a non-calm wind direction in 
the range of 1 to 360 degrees, and sets a calm wind direction to 0 degrees.  Essentially, 
during calm winds there is no wind direction. 
 
Note: It is possible that the wind speed sensor’s output is reading below the calm wind 
threshold because the sensor has malfunctioned.  In this case, you probably do not want 
your wind direction values to be set to calm.  By simply flagging the wind speed sensor 
as “invalid”, the calm setting will be ignored for the wind direction sensor.  Flagging a 
channel to “invalid” is a maintenance function that is described in Section 5.1. 
 
Note: If you do not wish Met Manager to set the wind direction to calm based on the 
wind speed, then set the “Calm wind threshold” value to 0.0.  Calm wind will not be 
detected, and a measured calm wind speed of 0.0 will indicate calm. 
 

3.7 Assigning Parameters to Store in the Database 
The purpose of assigning parameters to store in the database is to be able to later view, 
trend, report, and export the data represented by the parameters.  These parameters 
include both acquired and derived parameters, and are referred to as “database 
parameters.”  
 
CAUTION: Please review the caution in Section 3.6 when adding or deleting database 
parameters.  Unless you are setting up a brand new project from scratch, then very 
carefully follow the guideline of Section 3.6 titled “Guideline for Adding or Deleting 
Data Source or Database Parameters”. 
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To assign parameters to the database, select “Database Parameters” from the Setup menu: 
 

 
 
 
Note: If the top part of the above display is not shown, then select “Close Connection” 
from the Setup menu to show it.  The top part of the display is not shown when Met 
Manager is acquired data. 
 
The “Acquired Parameters” above are those that you setup earlier as “data source 
parameters”.  One at a time, drag and drop the ones you want to store in Met Manager’s 
database to the “Database Parameter List” (left-hand box).  Usually you will want to store 
all of them, so drag and drop each one, one at a time.  
 
Next select the Derived - Standard, Wind, Agriculture, Energy or Other tab from the top 
window, and drag and drop parameters of interest. Refer to Appendix A for a list and 
brief explanation of each derived parameter. 
 
The “Derived - Standard” tab is shown below: 
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The “Wind” tab is shown below: 
 

 
 

The “Agriculture” tab is: 
 

 
 

The “Energy” tab is: 
 

 
 
The “Other” tab is shown below: 
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Note: Your version of Met Manager may include additional parameters not listed above.  
Refer to Appendix A for a list of the latest parameter data types and derived parameters 
reported by Met Manager.  
 
The figure below shows an example of parameters that have been assigned (dragged and 
dropped) to the Database Parameter List for storage into the Met Manager project 
database. 
 

 
 

(The above figure is an example only; your configuration may be different.) 
 

In the above example, peak wind speed was setup as the maximum wind speed, high 
temperature as the maximum temperature, low temperature as the minimum temperature, 
and low relative humidity as the minimum relative humidity.  The “maximum” and 
“minimum” derived parameters originated from the “Other” tab. 
 
Similar to the Data Source Parameters display of Section 3.6, the “decimal display digits” 
field represents the number of digits to the right of the decimal point for the parameter 
listed on the right-hand side of the Instantaneous View (see Section 4.6).   
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IMPORTANT: You must assign a name to the “column heading” field.  This assigned 
name becomes the name of the parameter for display, trending, and reporting purposes.  
Make it short but descriptive, in order to minimize the width of the column.  For 
example, a wind speed parameter might be named “WSPD” or “WS”, scalar wind 
direction as “WDIR” or “WD”, resultant vector wind direction as “vWDIR” or “VWD”, 
unit vector wind direction as “uvWDIR”, “uvWD”, or “UVWD”, ambient temperature as 
“TEMP” or “TE”, maximum (or high) ambient temperature as “maxTEMP”, “maxTE” or 
“MAX TE”, soil temperature as “Soil TEMP” or “SOIL TE”, relative humidity as 
“RHUM” or “RH” and so forth. 
 
If you fail to assign a name to the column heading, then you will see column headings 
without a name, and various parameter selections as “New Parameter.”  If this happens 
to you, go back and assign a column heading to fix the problem. 
 
Note: In a network setting, the users of the optional Met Viewer™ software will see the 
same column heading field names that you assign in Met Manager.  Also these 
assignments will be printed within some of the reports.  Make sure that the column 
heading names are short but descriptive and unambiguous to all personnel that will use 
the data. 
 
Since a derived parameter depends on one or more primary parameters, it is helpful (but 
not required) to assign the needed primary parameters to the database parameter list 
before they are needed by a derived parameter.  For example, the “dewpoint” derived 
parameter depends on ambient temperature and relative humidity.  Therefore, it is best to 
assign the ambient temperature and relative humidity parameters to the database 
parameter list before assigning the dewpoint parameter.  In all cases, avoid circular 
references. 
 
The order of assignment of the various acquired and derived parameters to the database 
parameter list defines the final order of the parameters within the database and the initial 
order of the column headings within the Data View (the Data View is discussed in 
Section 4.4.)   Although not required, consider assigning the most important parameters 
first (in your judgement), and group like parameters together.  In the above example, the 
wind speed and wind direction parameters were assigned first.  Also, the ambient 
temperature, high temperature and low temperature were grouped together so that their 
natural display order would be next to each other. 
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Note: All database parameters require one or more parameter reference assignments.  For 
example, the “Wind Speed” database parameter shown above requires a wind speed data 
source parameter type.  To change the assignment of this parameter reference, press the 
F6 key, or click on “Edit”.  If more than parameter reference of the same type is listed, 
then typically choose the one beginning with the channel number (for example “[1] Wind 
Speed”).  That one is the “data source” parameter and represents the channel’s “acquired” 
value after applying slope and offset values.   However, in some cases it may be 
appropriate to select a derived parameter as the input argument, if the database parameter 
depends on it.   
 
Note: In some cases when configuring a derived database parameter, the display units are 
not known until the parameter’s argument has been assigned.  For example, if you want 
to derive a “maximum” type database parameter, drag and drop the “maximum” 
parameter from the “Other” tab to the database list, rename it, then choose its argument 
(which can be any parameter), and finally select the display unit of choice. 
 
Note: Notice the circle with an “x” on the “Sigma-Theta, Std Dev Wind Direction (2m)” 
parameter above.  This indicates that an improper parameter reference assignment, or no 
assignment, had been made to that database parameter.  Edit the “Parameter References” 
list to fix the problem.  In this particular example, no parameter reference had yet been 
assigned.  Assignment of the “[2] Wind Direction” reference parameter fixed the 
problem. 
 
Note:  Met Manager assigns to each database parameter a “Database tag” as shown in the 
figure above.  This tag is the name of the field within each date/time stamped record of 
each table of the database that contains the value of the parameter. 
 
To delete a parameter from the Database Parameter List, select it with your mouse and 
then press the “delete” key on your keyboard.   Met Manager displays the following 
message to make sure that you intended to delete the parameter: 
 

   
Configuring Met Manager Page 3-28 Rev: 1.5 



Met Manager™ User’s Manual  Copyright © 2002 

 
 

To confirm deletion, type YES in the requested field and then press the “Delete” button. 
 

3.8 Defining the Data Tables of the Database 
Now that you have decided which measured and derived parameters to save in a 
database, it’s time to decide which data tables to include in the database.  Each data table 
represents a different frequency of data.  From the Setup menu, select “Data Tables”.  A 
figure similar to the following is then shown: 
 

 
 

(The above figure is an example only; your configuration may be different.) 
 
Select the various data tables to be included in Met Manager’s project folder.  For each 
table chosen, also select an option: 
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• Keep data indefinitely.  In this mode, the data is retained in the selected data 

table indefinitely. 
 

• Delete data older than.  In this mode, only the last specified number of days 
are retained in the selected data table.  For example, if “30” days is specified 
for the 1 minute table, then at midnight, data older than 30 days will be 
deleted from the 1 minute data table.  This is referred to as “wrapping” the 
data table. 

 
Note: Normally, if the data is used for EPA or other regulatory purposes, it is best to 
retain the 15-minute and hourly data indefinitely.   However, we recommend that you 
limit the 1-minute data table to 30 days (or less).  Depending on the number of 
parameters being stored in the data table, a typical data record may be 200 to 300 bytes in 
size.   For a 1-minute data table at 1,440 records per day, this represents a growth of the 
1-minute data table at about 281K to 422K per day.  A typical 30-day 1-minute data table 
would thus be 8.5 MB to 12.5 MB in size.  Similarly, a 5-minute data table should be 
limited to 185 days (about 6 months), and a 10-minute data table should be limited to 365 
days (a year). 
 
IMPORTANT: When data is “deleted” in the database, it is marked as deleted and can 
no longer be viewed.  However it is not entirely removed.  To remove the data entirely, 
you must “pack” the database.  This is done from the Setup menu, and Pack Database 
selection, and is explained in Section 5.4.  If some of the tables are “wrapped”, then you 
should pack the database on a regular schedule as explained in Section 5.4. 
 
 
Note: Usually for a new project, the data tables are not created by Met Manager until the 
moment the data is first acquired from the data source.  This gives you the opportunity to 
get the data source parameters and database parameters configured properly, and without 
restructuring of the database (since it doesn’t yet exist.) Also, you can later check or 
uncheck tables to begin or stop adding data to them. 
 
Technical Note: The project database is in Paradox 4 format, level 7. Met Manager 
connects to these files through the Borland Database Engine (BDE) which is 
automatically installed on your computer during installation of the software.  The 
database is indexed. 
 

   
Configuring Met Manager Page 3-30 Rev: 1.5 



Met Manager™ User’s Manual  Copyright © 2002 

CAUTION: Do not connect directly to the database with another database manager or 
with a spreadsheet program such as Quattro Pro.  Unpredictable results may occur 
including complete loss of the data.  If you wish to experiment, do so with a mirrored 
copy that no other software is using.  If a problem occurs, you may have to delete the 
mirrored copy, and restart the mirror software to recreate it, but at least you won’t have 
damaged your master database.  See Appendix B for operation of Met Mirror software 
that allows mirroring of the project database. 
 
CAUTION: Do not create a copy of the database with a copy program (such as 
Microsoft Windows Explorer) while data is being logged to the database.  During the 
copy process, new data may be added to the database by Met Manager (or Met Mirror).  
The copy process can interfere with adding this data by causing index tables to get out of 
synchronization.  The correct procedure is to stop Met Manager (and Met Mirror if 
running), and then perform the copy.  Alternatively, although quite a bit slower, let Met 
Mirror perform the copy. 

3.9 Connecting to the Data Source (Begin Acquiring Data) 
If you have followed the above steps, then your system is nearly configured.  Now you 
can connect to a data source and begin collecting data.  From the Setup menu, you have 
two options to connect to a data source: 
 

1. Select “Connect to”.  A figure similar to the following is then displayed (but 
usually with only one data source item in the list): 
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Note: The above figure shows an example of various data sources that can be 
created from the Setup menu, “Data Sources” submenu.  However, not all of the 
above data sources are available to all data logger configurations (and the actual 
data sources may have different names than shown above).  If your list is blank, 
then you need to first create the data source from the “Data Sources” submenu.  
And we recommend that you create only one data source per project. 

 
2. Or, if you had previous set a data source as “default” (with a little check mark 

above it; see Section 3.5), then simply select “Connect to data source name” 
where “data source name” is the name of the default data source. 

 
If you wish a full-time direct connection to the data source (for example, to your local 
weather station’s data logger) then select the “Direct Connect” data source (or similar 
name).  All of the following conditions must be met: 
 

• You have a direct connection to the data logger (by serial cable, direct-
connect modems, or wireless radio modems). 
 

• Your data logger is programmed to transmit out a data stream at a regular and 
repetitive interval and in a way that Met Manager understands.  This interval 
is usually every second or every five seconds depending on your data logger 
capability. 
 

• You have tested the link between the data logger and the computer that Met 
Manager resides on, and have confirmed independently of Met Manager (i.e., 
with Met Manager shut down) that data is being repetitively transmitted from 
the data logger to the computer.  You may have to use vendor-supplied 
software to perform the test, or the Windows Hyperlink program. 
 

• You have properly created and configured a “direct-connect” data source 
(from the “Data Sources” submenu) with a communications port, baud rate, 
and sample rate that matches the configuration of the data logger. 

 
You can choose a “Data Log Capture (COM Port)” data source if all of the following 
conditions are met: 
 

• You have a direct connection to the data logger (by serial cable, direct-
connect modems, or wireless radio modems). 
 

• Your data logger has been programmed to store data in its internal log for a 
period of time (for example, every minute, 5 minutes, or 15 minutes), and Met 
Manager is aware of how to retrieve data from the log of your particular data 
logger. 
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• You want Met Manager to periodically capture (i.e., retrieve) the log on your 
request (i.e., not automatic). 
 

• You have tested the link between the data logger and the computer that Met 
Manager resides on, and have confirmed that data can be transmitted from the 
internal memory log of the data logger to the computer.  You may have to use 
vendor-supplied software to perform the test, or the Windows Hyperlink 
program. 
 

• You have properly created and configured a “Data Log Capture (COM Port)” 
data source (from the “Data Sources” submenu) with a communications port, 
baud rate, and sample rate that matches the configuration of the data logger.  
In this case the sample rate is the rate at which the data logger logs a data 
record into its internal memory (for example, once each minute, 5 minutes, or 
15 minutes). 

 
You can choose a “Data Log Capture (Modem)” data source if all of the following 
conditions are met: 
 

• Your data logger is located remotely from Met Manager and you do not have 
a direct connection to the data logger, but do have telephone modem or 
cellular modem access to the data logger. 
 

• Your data logger has been programmed to store data in its internal log for a 
period of time, and Met Manager is aware of how to capture (i.e., retrieve) 
data from the log of your particular data logger. 
 

• You want Met Manager to periodically retrieve the log on your request. 
 

• You have installed the appropriate dial-out modem on the computer that Met 
Manager resides on.  You have also installed the appropriate modem hardware 
at the data logger. 
 

• You have tested the dial-out link and have confirmed that a log file can be 
received by the computer that hosts Met Manager. You may have to use 
vendor-supplied software to perform the test, or the Windows Hyperlink 
program. 
 

• You have properly created and configured a “Data Log Capture (Modem)” 
data source (from the “Data Sources” submenu) with a modem device, phone 
number, and sample rate.  In this case, the sample rate is the rate at which the 
data logger logs a data record into its internal memory (for example, once 
each 1 minute, 5 minutes, or 15 minutes). 
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You can choose a CSV or Data Log “File Import” data source if all of the following 
conditions are met: 
 

• You do not have a direct or dial connection to the data logger, but you do have 
the data in a compatible file format.   
 

• You have properly created and configured a CSV or data log “File Import” 
type of data source (from the “Data Sources” submenu).  You have set the 
sample rate property of the File Import data source to match the time interval 
of the data file. 
 
CAUTION: Do not mix and match data sources in a project.  A project 
should be configured with one and only one data source.  Otherwise you run 
the potential of contaminating your project database because there is not 
necessarily a unique mapping between each data source’s parameters and the 
database’s parameters.  (It may be possible to setup a common mapping 
between the data sources, but you will have to experiment.  Experiment with a 
project database that is not important to you.) 

 
 
Select the appropriate data source, and press the “Connect” button to activate the 
connection. 
 
Note: You may get an error message if the “Connect” button is pressed and you do not 
have a valid connection. 
 
 

   
Configuring Met Manager Page 3-34 Rev: 1.5 



Met Manager™ User’s Manual  Copyright © 2002 

4 USING MET MANAGER 

4.1 Connecting to a Project 
The first step to acquiring data from a weather station is to assign a place to store the data 
and project settings.  This place is called a “project” and is simply a folder (directory) on 
a desktop or notebook computer, workstation, or network server. 
 
A new project is created from the File menu with selection of “New Project”: 
 

 
 
You have two options: (1) create a new project from scratch, or (2) create a new project 
from an existing project.  Follow the steps in Section 3.3. 
 
If a project already exists, then the project can be opened from the File menu with 
selection of “Open Project.”  This results in a dialog box (not shown) that allows you to 
browse and find an existing project folder.  
 
Note: Met Manager checks to ensure that the project you selected is actually a real Met 
Manager project.  If it doesn’t find certain files within the project folder, the following 
error message is given: 
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4.2 Configuring the Project 
After a project has been created, the project must be configured.  The steps are: 
 

1. Configure site settings such as latitude, longitude, elevation, and time zone.  
See Section 3.4. 
 

2. Configure the data source.  This defines where the sensory data comes from; for 
example, continuous direct-connection with the data logger in real time or by 
dial-up connection to the internal memory log of a data logger.  See Section 3.5. 
 

3. Assign parameters to the data source.  This defines the various sensor channels 
and ordering of data received from the data logger, and the units, measurement 
height, decimal display digits, and coefficients (slope and offset) for converting 
to base units.  See Section 3.6. 
 

4. Assign parameters to be stored in the database.  This defines both acquired 
sensor parameters and derived parameters to be stored in a database for later 
viewing, trending, reporting and exporting.  See Section 3.7. 
 

5. Define data tables and related time intervals to hold the database parameters.  
Tables include 1, 5, 10, 15, 20, 30-minute, and hourly time intervals.  See 
Section 3.8. 
 

6. Connect to the data source.  With this step, Met Manager can begin receiving 
data from the weather station.  See Section 3.9. 
 

7. After following the instructions in Section 3.9, verify that Met Manager is 
receiving data from the data source. View the data from the Instantaneous View 
(see Section 4.6) and the Data View (see Section 4.4).  If you have intermittent 
communication problems, review the “Current Data Source Events” tab of the 
Event Log.  See Section 4.5. 
 

8. Calibrate the weather station sensors and subsystems.  See Section 5.2 and 
Appendix E. 
 

9. Review the “Current Faults” tab of the Event Log to ensure that all measured 
values are within the minimum-to-maximum range defined for each data source 
parameter.  See Sections 4.5 and 3.6. 
 

10. Configure new trend charts and review existing ones (if any).  See Sections 4.8, 
4.9 and 4.10. 
 

11. Configure new indicator pages (views) and review existing ones (if any).  See 
Sections 4.11 and 4.12. 
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12. Configure a new wind rose or review an existing one (if any).  See Sections 
4.13 and 4.14. 
 

13. Configure the Data View and report options.  See Section 4.15. 
 

14. Configure display options when Met Manager is started.  See Section 4.16. 
 

15. Configure Met Manager to automatically startup when Windows starts up.  
Place a shortcut of the Met Manager executable program (MetMgr.exe) in the 
Windows “Startup” folder.  This folder may be located under “Administrators”, 
“All Users”, “Default Users“, or may be applicable only to your particular log-
on profile depending on your version of Microsoft Windows.  Check with your 
network or system administrator for the proper startup folder to contain the Met 
Manager shortcut. 
 
Command line options are not required but are useful for forcing Met Manager 
to open a particular project and data source when starting up in Windows.  If 
you use a command line option, you will want to assign it to the Met Manager 
shortcut in the Windows “Startup” folder.  See Appendix D.  

 

4.3 View Menu 
The following figure shows the View menu: 
 

 
 
The View menu allows you to: 
 

• View the data tables (referred to as the Data View).  See Section 4.4. 
• View event logs (Event Log View).  See Section 4.5. 
• View instantaneous data (Instantaneous View).  See Section 4.6 
• Create and view trend charts (Trend Chart View).  See Sections 4.8, 4.9 and 

4.10. 
• Create and view indicator pages (Indicator View).  See Sections 4.11 and 4.12. 
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• Create and view a wind rose (Wind Rose View).  See Sections 4.13 and 4.14. 
• Set view and report options.  See Section 4.15. 
• Set display options when starting Met Manager (startup options).  See Section 

4.16. 

4.4 Viewing Data Tables 
To view the data tables, select “Data Tables” from the View menu.  Below is an example 
of the data table view (or simply Data View). 
 

 
 

(The above figure is an example only; your configuration may be different.) 
 
Each data table that you enabled when setting up the software (in Section 3.8) shows up 
on a separate tab on the Data View.  Select the tab with your mouse to view the data. 
 
To review the past data history, press the Page Up key, or drag the thumb bar located on 
the right of the display up or down with your mouse.   You can also pan the view to see 
channels of data that may be located to the right of the display view.  Drag the bottom 
horizontal thumb bar to the left or right to pan the view. 
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The “Auto Update” button (located in the upper left corner) is used to keep the display 
from being refreshed when new data arrives.  Press this button to “freeze” the view.  
Press it again to unfreeze it.  The operation of the button is: 
 

• When highlighted (depressed), the display will update (refresh) with the 
arrival of new data.  This is the normal setting. 
 

• When not highlighted (not depressed), the display will not be affected by the 
arrival of new data.  

 
When the Data View has been positioned so that the most current record is not 
highlighted, then a timer is started to keep new incoming data from refreshing the view.  
Within 15 minutes of no keyboard or mouse activity (that changes the highlighted 
record), the timer times out, and the view is refreshed (if the Auto Update button was 
highlighted prior to changing the Data View).  
 
To go to the first or last record in the data table, or to force an auto-update, right-click 
with your mouse somewhere on the Data View.  The following options are then 
displayed: 
 

 
 
 
Note:  Met Manager presents its data stamped with local standard time.  During daylight 
savings time, the time stamp may be less than your local computer time by one hour. 
 

4.5 Viewing Event Logs 
Met Manager tracks communication faults, sensor faults, and system events.  To view the 
event logs, select “Event Logs” from the View menu.  Below is an example of the Event 
Log View: 
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When there are events in the “Current Data Source Events” or “Current Faults” logs, 
select the event and then press the “Acknowledge Event” button to tell Met Manager that 
you are aware of the event.  Met Manager will retain the event in the respective “All Data 
Source Events” or “All Faults” log, but will remove the event from the “Current …” log. 
Or you can press the “Acknowledge All Events” button to acknowledge all events within 
a “Current …” event log. 
 
System events are always retained in the “System Events” log. 
 
Refer to the following table for a list of various event codes: 
 

 
Type of Event Log 

Event 
Code 

 
Description of Event 

Data Source Events 1001 Communications timeout 
 1002 [count] Incorrect packet format. 

“Count” is the number of occurrences.  If count = 1 
then reported at date and time of occurrence.  If 
count > 1 then reported at the end of the hour of 
occurrence. 

Faults 2001 Value of parameter back within min/max limits 
 2002 Reserved 
 2003 Reserved 
 2004 Min limit fault value (V) limit (L) unit 

Where “V” = value that triggered fault, “L” = imposed 
minimum limit, “unit” = reported unit 

 2005 Max limit fault value (V) limit (L) unit 
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Where “V” = value that triggered fault, “L” = imposed 
maximum limit, “unit” = reported unit 

System Events 3001 Project opened 
 3002 Project closed 
 3003 Logging started 
 3004 Logging stopped 
 3005 Parameter set to VALID (or invalid or calibration 

status) 
 3006 Data source parameter setup changed 
 3007 Database parameter setup changed 
 3008 Data table setup changed 
 3009 Pack SUCCESSFUL for table TBL 1, TBL 2, etc. 

(or unsuccessful status is reported) 
 3010 Data table restructure status (one of): 

• Restructuring table TBL 1, TBL 2, etc. 
• No fields to remove 
• Adding fields DB1, DB2, etc. 
• Restructure successful for table TBL 1, etc. 

 

4.6 Viewing Instantaneous Data 
The Instantaneous View is useful when Met Manager is directly-connected to a weather 
station and gets data from the data logger of the weather station on a frequent basis.  
Below is an example of the Instantaneous View: 
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(The above figure is an example only; your configuration may be different.) 
 
In the above figure, the channels on the left side of the display represent the acquired 
“data source” parameters that were received from the data source (e.g., data logger), and 
after both base unit conversion and calibration adjustments have been applied.  See 
Section 3.6.  These values are in base units. 
 
The channels on the right side of the display represent the “database” parameters that 
were configured in the Database Parameter List, and that are to be stored in the data 
tables.  See Section 3.7.   These values also include calibration adjustments. 
 
Once you have connected to a data source (e.g., a data logger), Met Manager can begin 
receiving data.  If the data source is of the kind “direct-connect”, and your data logger is 
working and properly connected to the same computer that is running Met Manager, then 
Met Manager should begin receiving the data.  In that case, the Instantaneous View will 
update at the sample rate specified in the properties of the data source, and the “Missing” 
status will change to “Valid”, “Invalid”, or “Calibrate” depending on the prior 
configuration of the channel.  See Sections 3.6 and 5.1. 
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Note:  If necessary, consult other information supplied with the weather station or data 
logger to independently confirm that the weather station is properly connected to the 
computer.  With Met Manager not running (that is, shut down), use instructions separate 
from this User’s Manual to confirm that data is flowing between the data logger and the 
computer.   For example, with some data loggers, and in conjunction with manufacturer-
supplied instructions, you can use Microsoft’s “Hyperlink” program to connect to the 
data logger and view the data on your computer.  Or there may be a special diagnostic or 
test program supplied with your weather station hardware.  In summary, you cannot 
expect Met Manager to receive the data from the data logger if the data is not arriving at 
your computer, or if there is a cabling or communication problem of some kind. 
 

4.7 Maintenance and Calibration  

4.7.1 Setting the Status of a Channel 
To activate special maintenance functions such as setting a data source parameter to 
invalid or calibration status, see Section 5.1.  
 
Note:  If a data source parameter is set to invalid or calibration status, then derived 
database parameters that depend on that parameter will also be set to invalid or 
calibration status.  
 

4.7.2 Calibrating a Channel 
To set the calibration coefficients (slope and offset) of a data source parameter (channel), 
see Section 5.2. 

4.7.3 Activating a Debug Log 
For troubleshooting, you may want to capture and inspect the raw data coming from your 
data logger.  You can setup a text file to hold the raw data if your data logger has a 
continuous connection to the computer.  See Section 5.3 for activating a debug log file. 

4.7.4 Packing the Database 
The database managed by Met Manager must be periodically packed to permanently 
remove records that have been deleted.  This affects those data tables that have been 
setup with a “wrap” interval.  See Section 5.4 for a recommended pack schedule and 
more information. 

4.7.5 Restructuring the Database 
The database managed by Met Manager must be restructured when additions or deletions 
are made to the database parameters.  Met Manager normally handles this restructure on 
its own when additions or deletions are made.  However, see Section 5.5 on guidelines to 
follow if the normal restructure operation did not complete for some reason. 
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4.8 Creating Trend Charts 

4.8.1 Creating a New Trend Chart 
You can easily setup single or dual-axis and single or dual trend charts to review your 
weather data.  Each trend chart can have multiple traces. 
 
To create a new trend chart, select “Trend Charts”, then “New Trend” from the View 
menu: 

 
 

A new blank trend chart is shown below. 
 

 
 

Let’s setup a trend chart titled “Wind Direction” based on 15-minute scalar wind 
direction.    
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IMPORTANT: You must have a “scalar wind direction” database parameter already 
configured in order to create a “wind direction” trend chart by using the information in 
this section.  If you don’t have a “scalar wind direction” database parameter but have 
setup a resultant vector or unit vector wind direction parameter, then use that instead in 
order to follow along with the example.  It’s also best if some wind direction data has 
already been acquired. 
 

Press the “Edit Trend Settings” tool button  located on the tool bar.  The “Edit Trend 
Settings” dialog is then shown: 
 

 
 

Give the trend chart a name in the “Name” field and a title in the “Title” field.  The name 
you provide is the name that appears in the Trend Chart list of the View menu, as well as 
Met Manager’s “Window” menu.  Overtype the default name “New Trend” with “Wind 
Direction”.  The “Title” is the information that you want to appear at the top of the trend 
chart.  Set it also to “Wind Direction” if that’s the title you want on the chart.  Then 
check the appropriate boxes to filter certain types of data from the trend chart: 
 

• Check “Show valid data” to display valid data on the chart.  This box is 
checked for normal operation. 
 

• Check “Show partial data” to display partial data on the chart.  Partial data 
occurs when some valid samples were acquired over the time interval, but less 
than three-quarters of the expected data.  For example, if the data sample rate 
is 5 seconds and the data reporting interval is 15 minutes, then valid data will 
be flagged as “partial” if fewer than 135 samples are acquired over the 

   
Using Met Manager Page 4-11 Rev: 1.5 



Met Manager™ User’s Manual  Copyright © 2002 

interval (a full 15-minute interval would have 180 five-second samples).  This 
box is checked for normal operation. 
 

• Similarly, check the remaining boxes to display other types of data.  Checking 
these boxes is useful when diagnosing problems.  These boxes are normally 
unchecked. 

 
The following dialog shows the new settings: 
 

 
 
Note:  Met Manager tags a channel’s data, and any parameters derived from that channel, 
according to the channel’s accumulated valid, invalid, calibration, missing, or partial 
status, based on the following rules: 
 

• If more than three-fourths of the acquired samples are valid, then the channel 
is tagged as “valid”.  Samples that are detected by Met Manager as being 
invalid (i.e., out-of-range), in maintenance mode, undergoing calibration, or 
are missing are not included in the valid set. 
 

• If at least one valid sample is acquired during the reporting interval, but fewer 
than three-fourths, then the channel’s result is tagged as “partial (p)” 
 

• If the samples acquired during the reporting interval are invalid then the 
channel’s result for the reporting interval is tagged as “invalid (x)”.  Samples 
can be invalid because of out-of-range detection, or because the user put the 
channel into “invalid” maintenance mode. 
 

• If the samples acquired during the reporting interval are in calibration mode, 
then the channel’s result for the reporting interval is tagged as “calibration 
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(c).” 
 

• If all samples acquired during the reporting interval are missing, then the 
channel’s result for the reporting interval is tagged as “missing (m)” 

4.8.2 Example of a 0-360 Scalar Wind Direction Trend Chart 
Now let’s set up the left vertical axis (Y axis) to show the wind direction parameter’s 
values.  Select the “Axis Settings” tab near the top of the dialog.  Check the “Show Y 
axis” box, then set the “Title” of the axis to “Degree”.  For the axis type, select “Normal” 
to set up a normal single trend chart.  In the “Data type” list box, select the type of the 
parameter, in this case a “wind direction” type.  For “Units”, select “deg”.  We want the 
vertical axis scale to be fixed in the range of 0 to 360 degrees, so uncheck the “Use 
automatic scaling” box.  Set the minimum wind direction value to 0 and the maximum to 
360.  Specify “Major steps” of 8 to give 8 major graduations of 45 degrees each across 
the 360 degree range.  Specify “Minor steps” of 3 to divide each major graduation into 3 
subintervals of 15 degrees each.  
 

 
 

Several traces can be added to a trend chart.  Let’s begin by adding a “scalar wind 
direction” trace to the wind direction trend chart.  Select the “Data Traces” tab near the 
top of the dialog: 
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Press the “Add” button to add a new trace to the trend chart.  Name the trace title “Scalar 
Wind Direction”.  Assign it to the left axis.  Pick a trace type of “line” and select a trace 
color of red. Finally, select the actual parameter to be assigned to the trace.  Within the 
project there are multiple parameters of the “wind direction” type.  We are interested in 
trending the scalar wind direction, so that’s the one to select: 
 

 
 

(The above figure is an example only; your configuration may be different.) 
 
Now it’s time to select the data interval.  From the “Data Traces” tab, click on the “Data 
interval” list box to see a list of the data tables that were previously setup in Met 
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Manager.  In the example below, Met Manager was configured to maintain 1 minute, 15 
minute, and hourly data tables (in Section 3.8) in the project database.  For our example, 
we want to trend 15-minute data, so we will assign the 15-minute data interval: 
 

 
 
 
Note: In the “Data Traces” tab, you can uncheck the box to the left of the trace title.  This 
will disable the trace.  (It’s checked by default when a new trace is added.) This is useful 
when you have several traces assigned to a trend chart, but you want to disable one for 
some reason. You can always check it later to re-enable it. 
 
 
Click the OK button to accept the settings.  Our example wind direction trend chart is 
displayed, based on a 0 to 360 degree range: 
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(The above figure is an example only; your configuration may be different.) 
 

 
Note: Data cannot be trended until it has been acquired.  
 

4.8.3 Example of a 0-540 Scalar Wind Direction Trend Chart 
The above example shows the wind direction trace jumping back and forth between 0 and 
360 degrees.  This happens on 0-360 wind systems when the wind direction is from the 
north.  To avoid this, let’s change the scale to a 0 to 540 degree range and select a special 
trace function to map the 0 to 360 degree wind direction to a 0 to 540 degree range. 
 
First, select the “Scalar Wind Direction” trace on the “Data Traces” tab, and press the 
“Edit” button.  This brings up the “Edit Trace Settings” dialog: 
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Press the “Edit Trace Function” button, and pick the “Wind direction in 0-540 deg range” 
trace function from the list box: 
 

 
 
Next, change the axis range on the “Axis Settings” tab to match the special trace function 
of 0 to 540 degrees.  Also specify “Major steps” of 12 and “Minor steps” of 3 to give 12 
major graduations of 45 degrees each across the range and 3 subintervals of 15 degrees 
each for each major graduation: 
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Press the “OK” button to show the wind direction now mapped to a 0 to 540 degree 
range: 
 

 
 

(The above figure is an example only; your configuration may be different.) 
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Note:  By convention, a calm wind direction is set to 0 degrees and a north wind direction 
is set to 360 degrees.  During calm winds, the wind direction trace will go to zero (unless 
you have calm wind detection disabled). 
 

4.8.4 Adding Standard Deviation of Wind Direction to the Trend Chart 
 
IMPORTANT: You must have a “Sigma-Theta standard deviation” database parameter 
already configured in order to create a “Sigma-Theta” trace by using the information in 
this section.  It’s also best if some standard deviation data has already been acquired. 
 
Now let’s add a second trace to the trend chart.  Since the Y-axis is of the “degree” type 
(i.e., wind direction), then additional traces assigned to that axis must also be of the same 
type.  Let’s add the standard deviation of wind direction, commonly known as “Sigma-
Theta”.  From the “Data Traces” tab, press the “Add” button, name the trace “Sigma 
Theta” and assign it to the “Left Y axis”.  Specify the “Trace Type” as a line.  Set the 
trace color to black: 
  

 
 
The resulting trend chart shows the standard deviation of the wind direction as a “sigma 
theta” trace along the bottom of the chart: 
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(The above figure is an example only; your configuration may be different.) 
 
Let’s center the Sigma Theta trace about the wind direction trace.  Select the “Sigma 
Theta” trace on the “Data Traces” tab.  Then press the “Edit” button to change its 
properties to a “Trace Type” of “Error Bar”, “Parameter (Value/Avg/Mean)” to “Scalar 
Wind Direction”, and “Parameter (Std Dev/Error)” to the “Sigma Theta, standard 
deviation” database parameter.  Be sure to press the “Edit Trace Function” button and set 
the trace function to “Wind direction in 0 - 540 deg range”: 
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This will center the Sigma Theta trace on the Scalar Wind Direction trace as an “error 
bar”, and as illustrated below: 
 

 
 

(The above figure is an example only; your configuration may be different.) 
 

4.8.5 Setting up a Dual Trend Chart with Wind Speed and Wind Direction 
 
IMPORTANT: You must have “wind speed” and “peak wind speed” database 
parameters already configured in order to create a trend chart by using information in this 
section.  It’s also best if some wind speed and peak wind speed data have already been 
acquired. 
 
Dual trend charts can be created with one trend chart using one axis (either left or right) 
and the other trend chart using the other axis.  In this case, each trend chart can use only 
one axis.  Building on the previous example, let’s create an “upper” trend chart that 
displays scalar wind direction and standard deviation of wind direction (as Sigma-Theta) 
on its left axis.  Let’s also create a “lower” trend chart that displays wind speed and peak 
wind speed on its right axis.  The two charts together form a composite “upper/lower” 
trend chart display. 
 
Begin by editing the Wind Direction trend chart that was previously setup. On its “Chart” 
tab, rename the chart and its title to “Wind Direction and Wind Speed” because it will 
become a composite chart: 
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Let’s use a left Y axis on the upper chart and a new right Y axis on the lower chart.  Since 
the Wind Direction chart already uses the left Y axis, let’s reassign the left axis display 
from “normal” to “upper”:  
 

 
 
Next let’s setup the new right Y axis on the lower chart.  On the “Axis Settings” tab, 
select the right axis, check the “Show Y axis” box, provide a title of “mph” for the axis, 
select “lower” as the display type, set the “Data type” to “Wind Speed”, units of “mph”, 
turn off automatic scaling, set the “Minimum” to 0, “Maximum to 25, “Major steps” to 5 
and “Minor steps” to 5:  
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From the “Data Traces” tab, add a new wind speed trace and assign it to the right axis.  
Set the trace type as a line with the color black.  Set the “Parameter (Value/Avg/Mean)” 
list box to “Wind Speed”, as this is the database parameter to assign to the trace. 
 

 
 
Next from the “Data Traces” tab, add a peak wind speed trace and also assign it to the 
right axis.  Set the trace type as a line with the color red.  Set the “Parameter 
(Value/Avg/Mean)” list box to “Peak Wind Speed”: 
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The final result is shown below: 
 

 
 

(The above figure is an example only; your configuration may be different.) 
 
Note: If you have a single trend chart with dual axes, and one axis is setup to use 
automatic scaling (on the “Axis Setting” tab)”, then be sure to set the other axis to also 
use automatic scaling.  That way the software can optimize axis readability with a 
common grid overlay. 
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4.8.6 Trace Functions 
In the previous examples, the 0-540 wind direction and Sigma-Theta traces required the 
use of a special trace function to map the 0-360 degree values to a range of 0-540 
degrees.  All trace functions are explained below: 
 

1. Accumulate (reset on limit).  Used to accumulate a parameter’s values until a 
limit is reached, and then the trace is reset to zero.  The reset value is specified 
as a number.  For example, this trace function can be used to accumulate the 
rain parameter until 1.0 inch has accumulated, then the trace is reset to zero.  
 

2. Accumulate (reset on time difference). Used to accumulate a parameter’s 
values until a cyclical time lapse has occurred relative to midnight.  The reset 
value is specified in the format of hours and minutes (hh:mm).  For example, 
this trace function can be use to accumulate the rain parameter cyclically 
every 8 hours (8:00) beginning at midnight.  Every eight hours the trace will 
reset to zero. 
 

3. Accumulate (reset on inactivity time).  Used to accumulate a parameter’s 
values until the parameter value is unchanged for a specified period of time.  
This period is called the “inactivity time.”   The inactivity time has a format of 
hours and minutes (hh:mm).  For example, this function can be used to mark 
rain events when no rain has occurred for a specified time.  
 

4. Wind direction in 0 - 540 deg range.  Used to map a 0 to 360 degree wind 
direction parameter to a 0 to 540 degree range.  This is useful for trending a 
polar parameter (i.e., wind direction) on a rectangular chart and in which you 
do not want the trace to “paint” when the wind direction is from the north.  No 
argument is required. 
 

5. Minimum (reset on time difference). Used to trace a parameter’s minimum 
value over a cyclical time period relative to midnight.  For example, you can 
use this function to track the minimum ambient temperature every 6 hours. 
 

6. Minimum (reset on absolute time). Used to trace a parameter’s minimum 
value until an absolute reset time has been reached.  For example, you can use 
this trace function to track the minimum ambient temperature until 12:00 noon 
(standard time) every day. 
 

7. Maximum (reset on time difference). Used to trace a parameter’s maximum 
value over a cyclical time period relative to midnight.  For example, you can 
use this trace function to track the maximum ambient temperature every 8 
hours and the maximum daily peak wind speed every 24 hours. 
 

8. Maximum (reset on absolute time). Used to trace a parameter’s maximum 
value until an absolute reset time has been reached.  For example, you can use 
this trace function to track the maximum ambient temperature until 5:00 pm 
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(17:00 standard time) every day and the maximum daily peak wind speed until 
midnight (24:00 standard time). 

 
Note: Only one trace function of a given type can be assigned to the same parameter on 
the same axis.  For example, you cannot assign more than one “accumulate (reset on time 
difference)” trace function to a rain parameter that is setup to use the left axis.  However, 
you can make one assignment to the left axis, and another to the right axis. 
 
IMPORTANT: Some of the arguments to the trace function allow you to set the time 
with a format of hh:mm (hours:minutes).  When setting the “mm” part, do not assign a 
time value that has higher resolution than the data table interval that drives the trace.  For 
example, with a trace setup to use the hourly data table, the “mm” value should always be 
“00”.   Data from the hourly table cannot be resolved to less than an hour.  Similarly, 
suppose you have setup a data trace based on the 15-minute data table.  The “mm” value 
should always be in increments of 15 minutes (i.e., “00”, “15”, “30”, or “45”). 
 

4.9 Viewing Trend Charts 

4.9.1 Opening a Trend Chart 
Once trend charts have been created, they can be opened from the View menu and “Trend 
Charts” selection.  Once opened, they can also be selected from the “Window” menu (see 
Section 4.18). 

4.9.2 Automatically Opening a Trend Chart at Startup 
You can define which trend charts you want to automatically open when the software 
starts up.  See Section 4.16. 

4.9.3 The Trend Chart Tool Bar 
The following tool bar rests above the trend chart: 
 

  
 

 
The “update trend” tool is used to refresh or freeze the display.  When 
in the depressed position, the trend chart will refresh when new data 
arrives.  When in the out position, the trend chart is frozen and will 
not be updated with the arrival of new data.  The operation of this 
tool is similar to the “Auto Update” button of the Data View. 

 
The “zoom” tool is used to define and expand a rectangular area of 
the trend chart.  Position the mouse in the upper left hand corner of an 
imaginary rectangular area of the trend chart.  With the left mouse 
button pressed, drag the mouse to the lower right corner of the 
imaginary rectangle and release the mouse button.  The rectangular 
area will expand to fill the chart.   To reverse the action, press the 
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“zoom” tool again. 

 
Click the “zoom in date axis” tool to zoom in on the date and time.  
For example, if the date/time axis grid is in increments of 2 hours, 
then upon pressing the tool, the date/time axis grid will change to 
increments of 1 hour. 

 
Click the “zoom out date axis” tool to zoom out on the date and time.  
For example, if the date/time axis grid is in increments of 1 hour, then 
upon pressing the tool, the date/time axis grid will change to 
increments of 2 hours. 

 
Click the “day snap” tool to snap the trend chart to a time frame of 1 
day. 

 
Click the “month snap” tool to snap the trend chart to a time frame of 
1 month.  This is only effective for trend charts that can hold a month 
of data without being scrolled.  These trend charts have data intervals 
of 15 minutes, 20 minutes, 30 minutes or hourly.  Trend charts based 
on 1-minute, 5-minute, and 10-minute intervals do not normally show 
a month of data at a time. 

 
This is a “Data Navigation Toolbar”.  Click on the first of these 
buttons to go to the start of the database (start of trace). Click on the 
last button to go to the end of the database (end of trace).  Click on 
the left pointer to scroll the chart to the left.  Click on the right pointer 
to scroll the chart to the right.  You can also scroll the chart by 
moving the scroll bar located below the trend chart. 

 
This “edit trend settings” tool button provides access to creating and 
editing a trend chart. 
 

 
Use the “print trend graph” tool to print the trend chart to the printer.  
Note: Before using this button, make sure that the printer has been 
properly setup.  Go to the File menu and “Print Setup” option to 
review the printer settings. Configuring your printer or installing its 
printer driver is outside the scope of this manual. 

 
Click on the “copy trend graph image” tool to copy an image of the 
trend chart to Microsoft Window’s clipboard.  Once in the clipboard, 
you can paste the image to a word processor or other program. 

4.9.4 Deleting a Trend Chart 
To delete a trend chart, go to the View menu, select “Trend Chart” and then “Delete 
Trend”.  Select a trend chart to delete and then press the “Delete” button: 
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4.10 Additional Examples of Trend Charts 

4.10.1 Rainfall 
 
IMPORTANT: You must have a rain database parameter already configured in order to 
create a rainfall trend chart by using the information in this section.  It’s also best if some 
rain data has already been acquired. 
 
Begin by creating a new “Rain” trend chart with both left and right axes, and based on a 
15-minute data interval.  Configure the left axis as a “precipitation” data type and with a 
range of 0 to 0.2 inches with 10 major steps (for increments of 0.02 inches). Create a red 
“Rainfall” trace by assigning a “rain” database parameter to the left axis and using a 
“bar” trace type. Set the left axis to a “normal” display type. No special data trace 
function is required.   
 
Next, configure the right axis as a “precipitation” data type and with a range of 0 to 2 
inches and 10 major steps (for increments of 0.2 inches).  Create a “Daily Rainfall” trace 
by assigning the same “rain” database parameter to the right axis but this time using an 
light blue “area” trace type.  Set the right axis to a “normal” display type. Setup a trace 
function of “accumulate (reset on time difference)” to totalize (cumulate) the 15-minute 
rainfall values from midnight.  The reset time is “24:00” which causes the cumulative 
trace to reset to zero every 24 hours from midnight.   
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Note: When both the left and right axes are assigned to a “normal” display type, then the 
resulting trend chart is a single chart with both a left and a right axis.  Recall that 
assigning the left axis to the “upper” display type and the right axis to a “lower” display 
type (or vice-versa) results in a composite “upper/lower” chart view with both upper and 
lower trend charts. 
 
On the “Data Traces” tab, use the large up and down arrow buttons to reverse the order of 
the “Rainfall” trace and the “Daily Rainfall” trace as shown: 
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Now the Rainfall trace will be drawn last so that it won’t be masked by the “area”-type 
Daily Rainfall trace.  The resulting “Rain” trend chart is shown below: 
 

 
 

(The above figure is an example only; your configuration may be different.) 
 

4.10.2 Ambient Temperature and Relative Humidity 
 
IMPORTANT: You must have several temperature-type database parameters already 
configured in order to create a trend chart by using the information in this section.  It’s 
also best if the required data has already been acquired.  For a complete configuration to 
follow along with this example, the following database parameters are needed: dew point 
temperature, wet bulb temperature, heat index temperature, wind chill temperature, 
ambient temperature, and relative humidity.  If you don’t have one of the parameters, just 
ignore setting it up in the instructions below. 
 
Begin by creating a new “Ambient Temperature and Relative Humidity” trend chart with 
both left and right axes, and based on a 15-minute data interval.  Configure the left axis 
as a “temperature” data type and with a range of 20 to 120 °F and 10 major steps (for 
increments of 10 °F).  
 
Create and assign several temperature-type traces to the left axis of the trend chart (assign 
a different color to each trace): 
 

1. A “Dewpoint” trace by assigning a “dewpoint” database parameter to the left 
axis and using a “line” trace type.  No special trace function is required.  
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2. A “Wetbulb” trace by assigning a “wetbulb temperature” database parameter 
to the left axis and using a “line” trace type.  No special trace function is 
required.  
 

3. A “Heat Index” trace by assigning a “heat index” database parameter to the 
left axis and using a “line” trace type.  No special trace function is required.  
 

4. A “Wind Chill index” trace by assigning a “wind chill temperature” database 
parameter to the left axis and using a “line” trace type.  No special trace 
function is required.  
 

5. An “Ambient Temperature” trace by assigning an “ambient temperature” 
database parameter to the left axis and using a “line” trace type.  No special 
trace function is required.  
 

Next, configure the right axis as a “relative humidity” data type and with a range of 20 to 
120% in steps of 10 (for increments of 10%).  Create a “Relative Humidity” trace by 
assigning the “relative humidity” database parameter to the right axis and using a “line” 
trace type.  No special trace function is required.   
 
Note: While relative humidity should never be greater than 100%, we chose to scale it to 
the same as the temperature scale to make it easy to “read” the temperature traces from 
either axis.  
 
The final trend chart is shown below.  By looking at the trend chart you can easily see 
that a cool front occurred.  Because the relative humidity climbed to 100%, it is also 
likely that rainfall occurred during the same time period. 
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(The above figure is an example only; your configuration may be different.) 
 
 
Note: When setting up both a left and right axis for a single “normal” trend chart, it is 
important to set the scaling and major steps (graduations) so that the grid lines overlay 
between traces that use the left axis and traces that use the right axis.  In the example 
above, we have chosen the same step sizes for both axes. 
 
You may wish to disable a trace from appearing on the trend chart.  Simply uncheck the 
box to the left of the data trace name.  For example, it may be useful to disable the “Heat 
Index” trace in the winter time and the “Wind Chill” trace in the summer time: 
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4.10.3 Solar Radiation 
 
IMPORTANT: You must have solar radiation and solar energy database parameters 
already configured in order to create a trend chart by using the information in this section.  
It’s also best if the required data has already been acquired.  
 
Begin by creating a new “Solar Radiation” trend chart with both left and right axes, and 
based on a 1-minute data interval.  Configure the left axis as a “solar radiation” data type 
and with a range of 0 to 1000 watts per square meter (W/m2) with 20 major steps (for  
increments of 50 W/m2). Use a yellow “area” trace type.  No special trace function is 
needed for the solar radiation parameter.  
 
Next, configure the right axis as a “solar energy” data type and with a range of 0 to 50 
MJ/m2 and 10 major steps (for increments of 5 MJ/m2).  Create a daily “solar energy” 
trace by assigning the solar energy parameter to the right axis and with a green “line” 
trace type.  Setup a trace function of “accumulate (reset on time difference)” to totalize 
(cumulate) the 1-minute solar energy values from midnight.  The reset time is “24:00” 
which causes the cumulative trace to reset to zero every 24 hours from midnight.  
 
The figure below shows the resulting “Solar Radiation” trend chart on a sunny day.  
Notice the “dips” in the solar radiation trace.  These dips were caused by a telephone pole 
and its overhead wires momentarily casting a shadow on the solar radiation sensor.  (It is 
best to install a solar radiation sensor where it will never receive a shadow; however, it’s 
not always possible.) 
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(The above figure is an example only; your configuration may be different.) 
 

4.11 Creating Indicator Views 

4.11.1 Getting Started 
You can easily create one or more Indicator Views for displaying weather data.   In this 
section we will show you how.  For instructional purposes, we have setup Met Manager 
with a “direct-connection” data source, an “instantaneous” sample rate of 5 seconds, and 
the following database parameters: 
 

• Wind speed 
• Scalar wind direction 
• Ambient temperature 
• Relative humidity 
• Barometric pressure 
• Rain 
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To create a new Indicator View, select “Indicator Pages”, then “New Indicator Page” 
from the View menu: 
 

 
 
The following dialog is presented to allow you to name the new indicator page.  Overtype 
the default name of “New Indicator Page” with the name that you want to give to the 
indicator page; for example, “Current Weather” or “Primary Indicators”. 
 

 
 
After naming the page and clicking the OK button, the following blank Indicator View is 
then displayed: 
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Press the “Design Mode” tool button  to go into design mode for creating a new 
Indicator View.  The design canvas is overlaid with a dotted grid and the remainder of the 
tool bar becomes active: 
 

 

4.11.2 Description of the Tool Bar 
The following tool bar rests above the Indicator View: 
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“Design mode” tool.  Used to enable the creation and design of an indicator page. 
 

 
“Digital display” tool.  Select and drop the tool onto the canvas to add a digital 
indicator to the page. 

 
“Vertical bar graph” tool. Select and drop the tool onto the canvas to add a 
vertical bar graph indicator to the page. 

 
“120° meter” tool. Select and drop the tool onto the canvas to add a 120° meter 
indicator to the page. 

 
“180° meter” tool. Select and drop the tool onto the canvas to add a 180° meter 
indicator to the page. 

 
“270° meter” tool. Select and drop the tool onto the canvas to add a 270° meter 
indicator to the page. 

 
“Wind direction label” tool. Select and drop the tool onto the canvas to add a 
wind direction sector indicator to the page. 

 
“Wind direction indicator” tool. Select and drop the tool onto the canvas to add a 
wind direction indicator to the page. 

 
“Delete indicator” tool.  Used to delete an indicator from the page.  Select an 
existing indicator by clicking on it and then press the tool button. 

 
“Edit indicator” tool. Used to edit an existing indicator.  Select an existing 
indicator by clicking on it and then press the tool button. 

 
“Bring to front” tool.  Used to bring an indicator to the front when two indicators 
overlap each other.  Select the indicator by clicking on it and then press the tool 
button. 

 
“Send to back” tool. Used to place an indicator in the background when two 
indicators overlap each other.  Select the indicator by clicking on it and then press 
the tool button. 

 “Snap” tool.  Used to snap an indicator to the background grid.  Press the tool to 
highlight it. Then either select, drag and move an existing indicator, or place a 
new indicator on the page.  The indicator will align with the background grid.  
This is useful for aligning indicators next to each other. 

 

4.11.3 Creating a Wind Direction Indicator 
Let’s create a wind direction indicator that updates with instantaneous data. To add a new 
wind direction indicator to the Indicator View, select and drop the “wind direction 
indicator” tool onto the design canvas. 
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Select the indicator with your mouse and right click on it (or press the “Edit Indicator” 
tool).  This pops up a menu to allow you to edit the indicator’s properties:  
 

 
 

Select the “Edit Properties” menu item.  The “Edit Indicator Properties” dialog is then 
displayed.  Set the parameter name to “Scalar Wind Direction” (or other wind direction 
parameter that your system may be configured with) and with units of “degrees”.  Select 
an interval of “instantaneous”: 
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Next, select the “Frame” tab and label the indicator as “Current Wind Direction” on two 
lines: 
 

 
 
Select the “Scale” tab to review the properties of the indicator’s scale and arrow pointer: 
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The “Bar/arrow Color” represents the color of the pointer when the indicator is showing 
“valid” or “partially valid” data.  The “Invalid Color” represents the color of the pointer 
for indicating invalid, missing or calibration data.  The “Scale Color” is the color of the 
major and minor tick-marks on the scale.  The “Background Color” is the color of the 
scale background. 
 
Now that we have assigned a wind direction parameter to the indicator and given the 
indicator a name (label), let’s review our prior assignment of the indicator’s unit by right-
clicking on the indicator:  
 

 
 
We can also review our prior assignment of the indicator’s update interval, or select a 
new interval: 
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Finally, select the indicator with your mouse and drag it onto the upper left of the design 
canvas.  You can size the indicator by grabbing the sides or a corner with the left mouse 
button and dragging. 
 
Now let’s add a digital indicator to the view, to show the current wind direction in 
degrees.  Select and drop a “digital indicator” tool onto the design canvas, and right-click 
on it to show the pop-up menu: 
 

 
 
In the same manner as for the wind direction indicator, select “Edit Properties” and then 
set the “Parameter” properties to scalar wind direction, units of degrees, and interval of 
“instantaneous”.  Select the “Frame” tab and turn off (uncheck) the bevel around the 
digital indicator frame so that the digital indicator frame will merge with the background 
of the wind direction indicator.  This will allow us to overlay the digital indicator onto the 
center of the wind direction indicator:    
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You can define the width and numeric precision of the digital value from the “Digital 
Display” tab by setting the “Value format” field: 
 

 
 

The “##0” part of the field defines the number of display character positions to the left of 
the decimal point.  For example, for one position, set that part of the field to “0”.  For two 
positions, set it to “#0”, three positions to “##0”, and so forth.  The “.0” part of the field 
defines the number of display characters to the right of the decimal point.  For no 
characters to the right of the decimal point, remove the “.0”.  For one character, set it to 
“.0”, for two characters set it to “.00”, and so on.  For the wind direction digital indicator, 
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let’s set the “Value format” to “##0” for a maximum of 3 characters and without any 
decimal places. 
 
Now let’s place the digital indicator onto the wind direction indicator.  Select the digital 
indicator with your left mouse button and drag and drop the digital indicator into the 
middle of the wind direction indicator: 
 

 
 

If needed, resize the digital indicator by grabbing a corner with the left mouse button and 
then dragging inward (smaller) or outward (larger). 
 
Note: If for some reason the digital indicator goes behind the wind direction indicator 
when you drop it on to the wind direction indicator, then select the wind direction 
indicator with your mouse and click the “send to back” tool button.  This will force the 
wind direction indicator behind the digital indicator. 
 
Next, let’s add a wind direction sector indicator to display the wind direction as a sector.  
Select and drop the wind direction sector tool onto the design canvas, and then right-click 
on it: 
 

 
 
Set the sector indicator’s “Parameter” properties to “scalar wind direction”, degree units 
and instantaneous data interval.  Similar to the digital indicator, drag the sector indicator 
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to the middle of the wind direction indicator and just below the digital indicator.  The 
overall wind direction indicator is now complete: 
 

 
 

4.11.4 Creating a Wind Speed Indicator 
Let’s add a wind speed indicator to the Indicator View.  Select and drop one of the meter 
tools onto the design canvas.  We’ll use the 120° meter indicator.  Select it, right-click on 
it, and edit its properties.  Set the “Parameter” tab to “wind speed”, units of “mph”, and 
interval of “instantaneous.”  Normally the indicator is named on the “Frame” tab; 
however, we will not name this indicator as we will later place a digital indicator below it 
and we will name that one instead. On the “Scale” tab, set the minimum and maximum 
range.  We’ll use the range values of 0 to 50: 
 

 
 

   
Using Met Manager Page 4-44 Rev: 1.5 



Met Manager™ User’s Manual  Copyright © 2002 

The “Value format” field defines the width and precision of the numeric labels on the 
meter.  For a wider field width, specify more “#” characters at the start.  For additional 
decimal places, add a decimal point and a zero for each additional decimal place desired.  
For example, for a 6 character value with 2 digits to the right of the decimal point, 
specify the “Value format” field as “##0.00”. 
 
Adjust the “Major steps” and “Minor steps” to your preference.  The “Major steps” 
define the number of intervals or major graduations over the range, in this case 5 intervals 
over the range of 0 to 50 mph.  The “Minor steps” define the number of subintervals 
between the steps; in this case, 5 subintervals for each step (2 mph per subinterval). 
 
The completed wind speed indicator is shown below: 
 

 
 
Add a digital wind speed indicator.  Select and drop a digital indicator tool onto the 
canvas.  Set its parameter, units, and interval properties to the same as the wind speed 
meter indicator.  Name it “Current Wind Speed”: 
 

 

4.11.5 Positioning the Wind Direction and Wind Speed Indicators  
Position the wind speed meter indicator next to the wind direction indicator.  Position and 
resize the wind speed digital indicator below the wind speed meter indicator as shown in 
the figure below: 
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(The above figure is an example only; your configuration may look different.) 
 
Position controls include the mouse for selecting and moving the indicator (dragging), 
and the following keys: 
 

• Left, right, up, down arrow keys to move the indicator in the respective 
direction. 
 

• Control-left, control-right, control-up, and control-down arrow keys for 
smaller incremental movements.  For example, a “control-left arrow key” 
combination is made by pressing the control key (“Ctrl” on most keyboards) 
and then simultaneously pressing the left arrow key. 
 

Size controls include the mouse and some keys.  With the left button of the mouse, select 
the indicator, then drag the side or corner of the indicator to resize it.  With the keyboard, 
press the shift-left, shift-right, shift-up, and shift-down arrow keys to “grow” or shrink 
the indicator in the respective direction. 

4.11.6 Creating Ambient Temperature Indicators 
Now let’s add three ambient temperature indicators: 
 

• A current temperature vertical bar graph 
• A minimum daily temperature vertical bar graph 
• A maximum daily temperature vertical bar graph 

 
For speed in creating the temperature indicators, select and drop three vertical bar graphs 
onto the design canvas.  For the first “Current Temperature” indicator, set its “Parameter” 
properties to an “Ambient Temperature” parameter, °F units, “instantaneous” interval, 
and no special function.  From the “Frame” tab, name the indicator “Current 
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Temperature”.  From the “Digital Display” tab, set the “Value format” of the digital 
display indicator to “##0.0” for a “Value format” field width of 5 with one decimal place.  
From the “Scale” tab, set the scale range for the meter scale from 0 to 100, and with zero 
decimal places in a “Value format” field width of 3 (##0).  Set the “Major steps” to 10 
with 5 subinterval “Minor steps”.  The “Bar width” is the width of the vertical inner 
scale.  To make it skinny (and look like a thermometer), set it to a value of 3 or 4.  To 
fatten it up, set it to a higher value; for example, 16.  This example uses 4. 
 

  
 

 
 
Similar to the wind direction and meter indicators, the “Bar/arrow Color” represents the 
color of the pointer when the vertical bar graph indicator (in this case temperature) is 
showing “valid” or “partially valid” data.  The “Invalid Color” represents the color of the 
pointer for indicating invalid, missing or calibration data.  The “Scale Color” is the color 
of the major and minor tick-marks on the scale.  The “Background Color” is the color of 
the scale background (bar part).  Experiment with these properties to achieve varying 
visual effects. 
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For the second “Minimum Daily Temperature” indicator, set it up the same as the 
“Current Temperature” indicator but with the following changes: 
 

• On the “Parameter” tab, set the interval to “1 minute”.  Apply a “Function” of 
“Minimum” with an auto-reset interval of 24 hours (24:00).  This will track the 
minimum ambient temperature for 24 hours from midnight, and with an update 
once per minute: 
 

 
 

• On the “Frame” tab, name the indicator “Minimum Daily Temperature”. 
 

• On the “Scale” tab, set the bar color to blue (to imply cold). 
 

For the third “Maximum Daily Temperature” indicator, set it up the same as the 
“Minimum Daily Temperature” indicator but with the following changes: 
 

• On the “Parameter” tab, apply a “Function” of “Maximum” with an auto-reset 
interval of 24 hours (24:00) relative to midnight: 
 

• On the “Frame” tab, name the indicator “Maximum Daily Temperature”. 
 

• On the “Scale” tab, set the bar color to red (to imply hot).  Note that red may also 
be used to indicate “invalid” (as well as missing or calibration).  This dual-mode 
use of red is alright because the digital value will also turn red when the 
indicator’s value is invalid.  

 
In general, the following special functions (located on the “Parameter” tab) are available 
to most indicators: 
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• None - Use the parameter value without applying any special function. 
 

• Average - Average the parameter value.  Most parameters are already averaged 
when sent to the indicator; however, you may wish for the indicator to receive 
data based on one interval and re-average the data based on another interval.  For 
example, to receive 1-minute values of ambient temperature and re-average them 
over a 5 minute interval, select the “Average” function with a reset interval of 5 
minutes (0:05): 

 
 

 
 

• Totalize  - Accumulate the parameter value over a time period relative to 
midnight.  This is useful for summing rainfall data.  For example, to accumulate 
rain over a 24-hour period (relative to midnight), setup the rain indicator’s 
properties as shown below.  In the example below, the indicator’s update rate is 
once per minute because a new rain parameter value is sent to the indicator based 
on the selected “1-minute” interval.  Select the “Automatic reset based on time” 
field to auto-reset the indicator’s value to zero when the reset interval has expired. 
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• Minimum - Indicate the minimum value of a parameter over a time interval 
relative to midnight.  For example, if an ambient temperature indicator is set with 
an interval of “instantaneous”, function of “minimum”, and auto-reset time of 
“8:00”, then the indicator will update the minimum ambient temperature of the 
first 8-hour time period (from midnight), will automatically reset, will show the 
minimum temperature for the next 8-hour period and so forth.  The update rate 
will be the same as the instantaneous sample rate of the data received from the 
data logger. 

 
• Maximum - Indicate the maximum value of a parameter over a time interval, in 

the same fashion as the “minimum” function. 
 
Note: In the above cases, if “Manual reset” was selected instead of the “Automatic reset 
based on time”, then the indicator would continue to apply the designated function until 
reset by the user.  This manual reset is accomplished by right-clicking on the indicator 
and then selecting the “reset” item from the pop-up menu. 
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Position the ambient temperature indicators below the wind direction indicator: 
 

 
 

(The above figure is an example only; your configuration may look different.) 
 

4.11.7 Creating Rain Indicators 
Now let’s add two rain indicators; (1) a vertical bar graph to show the daily total rainfall 
and (2) a digital indicator to accumulate the rainfall until you manually reset it.  Both 
indicators will be set to update once each minute. 
 

   
Using Met Manager Page 4-51 Rev: 1.5 



Met Manager™ User’s Manual  Copyright © 2002 

Select and drop a vertical bar graph indicator onto the canvas.  Set its “Parameter” 
properties to “Rain”, “inch” unit, “1 minute” interval, “totalize” function, and 
automatically reset every 24 hours (24:00).  On the “Frame” tab, name the indicator 
“Daily Rainfall”.  On the “Digital Display” tab set the number of decimal digits to two in 
a field width of 5 by setting the “value format” to “#0.00”.  On the “Scale” tab, set the 
range of the indicator from 0 to 2 inches with a “Value format” of “#0.0” and adjust the 
“Major steps” to 4 and the “Minor steps” to 5.  This allows the indicator to show up to 2 
inches of rainfall per day with 4 major graduations and 5 minor graduations for a minor 
increment of 0.1 inch: 
 

 
 
For higher resolution, set the maximum value lower (say 1 inch) and adjust the major and 
minor steps as needed. 
 
Note: The indicator above will show up to 2 inches of rainfall per day before exceeding 
the upper limit.  However, the digital portion of the indicator will continue to show the 
total amount of rainfall for the day. 
 
Select and drop a digital indicator onto the canvas.  Set its “Parameter” properties to 
“Rain”, “inch” unit, “1 minute” interval, “totalize” function, and “manual reset” function.  
On the “Frame” tab, name the indicator “Cumulative Rainfall”.  On the “Digital Display” 
tab set the number of decimal digits to two by setting the “value format” to “#0.00”: 
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The digital indicator will accumulate rain until manually reset.  To manually reset it, right 
click on it and select the “reset” option. 
 
Note:  Currently when started, Met Manager clears all its indicators and starts the rain 
accumulation from zero.  This is also true for minimum, maximum, average, and other 
types of indicators. 
 
Drag the “Daily Rainfall” bar graph indicator next to the “Maximum Daily Temperature” 
indicator.  Drag the “Cumulative Rainfall” digital indicator below the “Daily Rainfall” 
bar graph indicator.  Adjust the size as needed to fill the space.   
 
Finally, add two more vertical bar graph indicators; one for relative humidity and the 
other for barometric pressure. Name the first one “Rel Humidity (15-Minute)”.  Set this 
indicator to a “Relative Humidity” parameter, units of “%”, function of “None”, and 
interval of 15 minutes.  Set the “Value format” on the “Digital Display” tab to show a 
field width of 3 without any decimal places (##0).  On the “Scale” tab, set the bar scale 
range from 0 to 100.  Set the “Major steps” to 10 and “Minor steps” to 5.  Place the 
indicator next to the rain indicator: 
 
Similarly, set up a barometric pressure indicator. Name the indicator “Baro Pressure (15-
Minute)”. Set the parameter to “Barometric Pressure”, units of “inHg”, function of 
“None”, and interval of 15 minutes.  Set the “Value format” on the “Digital Display” tab 
to two decimal places with a field width of 5 (#0.00).  Similarly, on the “Scale” tab, set 
the scale’s “Value format” to two decimal places with a field width of 5 (#0.00).  Set the 
bar scale range from 29.50 to 30.50. Set the “Major steps” to 5 and “Minor steps” to 4.  
Place the indicator next to the relative humidity indicator.   
 
Note: Adjust the range on your barometric pressure indicator to reflect the normal 
barometric pressure variation in your area. 
 

4.11.8 The Final “Current Weather” Indicator View 
When finished adding or editing the indicators, press the “design mode” tool to 
take the Indicator View out of design mode.  The following figure shows the new 
Indicator View: 
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(The above figure is an example only; your configuration may look different.) 
 

4.12 Using Indicator Views 

4.12.1 Opening an Indicator View 
To open an Indicator View, select “Indicator Pages” from the View menu.  Then select an 
Indicator View to display, in this case the one named “Current Weather”. 
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Note: You can display an Indicator View that has already been opened by selecting it 
from Met Manager’s Window menu.  See Section 4.18. 
 

4.12.2 Automatically Opening an Indicator View at Startup 
To automatically open an Indicator View when Met Manager starts up, set the Indicator 
View’s check box in the “View” menu, “Startup” submenu dialog: 
 

 
 

(The above figure is an example only; your configuration may be different.) 
 

Also see Section 4.16 for configuring various startup options. 

4.12.3 Renaming an Indicator View 
An Indicator View can be renamed in two ways: 
 

1. If an Indicator View is the active window then select the “View” menu, “Indicator 
Pages” submenu, and “Rename Indicator Page” item.  The following dialog is 
then displayed to allow you to rename the Indicator View: 
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(The above figure is an example only; your configuration may be different.) 
 

2. If an Indicator View is not the active window then select the “View” menu, 
“Indicator Pages” submenu, and “Rename Indicator Page” item.  The following 
dialog is then displayed to allow you to rename the Indicator View: 

 

 
 

(The above figure is an example only; your configuration may be different.) 

4.12.4 Deleting an Indicator View 
To delete an Indicator View, select “Indicator Pages” from the “View” menu.  Then 
select the “Delete Indicator Page” item.  The following dialog is displayed: 
 

 
 

(The above figure is an example only; your configuration may be different.) 
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Select the indicator page you wish to delete and press the “Delete” button. 
 
Alternatively, delete all indicators from the Indicator View.  Select each indicator one at a 
time and press the delete key; then close the view.  This deletes the view. 
 

4.13 Creating a Wind Rose 

4.13.1 Getting Started 
With Met Manager you can easily create a Wind Rose as explained in this section.  For 
instructional purposes, we have setup Met Manager with a “direct-connection” data 
source, an “instantaneous” sample rate of 5 seconds, and the following parameters: 
 

• Wind speed 
• Scalar wind direction 

4.13.2 Description of the Tool Bar 
The following tool bar rests above the Wind Rose View: 
 

  
 

 
The “update display” tool is used to refresh or freeze the display.  When in the 
depressed position, the wind rose will refresh when new data arrives.  When in 
the out position, the wind rose is frozen and will not be updated with the arrival of 
new data.  The operation of this tool is similar to the “Auto Update” button of the 
Data View. 

 
Click the “day snap” tool to snap the wind rose to a time frame of 1 day. 

 
Click the “month snap” tool to snap the wind rose to a time frame of 1 month. 

 
Click the “edit” tool button to edit the properties of a wind rose. 

 
Use the “print” tool to print the wind rose to the printer.  Note: Before using this 
button, make sure that the printer has been properly setup.  Go to the File menu 
and “Print Setup” option to review the printer settings. Configuring your printer 
or installing its printer driver is outside the scope of Met Manager. 

 
Click on the “copy image” tool to copy an image of the wind rose to Microsoft 
Window’s clipboard.  Once in the clipboard, you can paste the image to a word 
processor or other program. 
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The “Data Navigator” tool bar button adjusts the data set being sent to the wind rose: 
 

  
 

 
Go to the beginning of the database 

 
For monthly wind roses, set the wind rose to the previous month. 
For weekly wind roses, set the wind rose to the previous week. 
For daily wind roses, set the wind rose to the previous day. 
For other wind roses, set the wind rose to the previous interval specified in the 
“data range” property 

 
For monthly wind roses, set the wind rose to the previous day. 
For weekly wind roses, set the wind rose to the previous day. 
For daily or other wind roses, set the wind rose to the previous hour 

 
Snap the wind rose to the beginning of the interval specified in the “data range 
property” of the wind rose.  For example, if the data range is one month, then 
pressing this button will snap the wind rose to the first day of the month. 

 
For monthly wind roses, set the wind rose to the next day. 
For weekly wind roses, set the wind rose to the next day. 
For daily or other wind roses, set the wind rose to the next hour 

 
For monthly wind roses, set the wind rose to the next month. 
For weekly wind roses, set the wind rose to the next week. 
For daily wind roses, set the wind rose to the next day. 
For other wind roses, set the wind rose to the next interval specified in the “data 
range” property 

 
Go to the end of the database 

4.13.3 Creating a Wind Rose 
To create a wind rose, select “Wind Rose” from the View menu. The first time you do 
this in a new project, the “Edit Wind Rose Graph Settings” dialog below will 
automatically appear since Met Manager knows that the wind speed and wind direction 

parameters need to be assigned.  Otherwise press the “Edit”  tool button.  The dialog 
is shown below: 
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(The above figure is an example only; your configuration may be different.) 
 
Select a data interval for the wind rose.  For wind roses, this interval is normally the 
hourly interval.  Assign the wind speed and wind direction parameters.  In this example, 
these parameters are wind speed and scalar wind direction. 
 
Pick a data range from the “Data range” list box.  Choices are 1, 3, 6, 8, and 12 hours, 1 
day, monthly and custom.  “Custom” allows you to generate a wind rose over a date and 
time range that you define: 
 

 
 
The above start and end date/time ranges define one day beginning at 12 am (time 00:00) 
on 7/2/2002 and ending at midnight on 7/2/2002.  To generate a wind rose for the first 
hour of the day, specify: 
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Check the “Use automatic scaling” box to have Met Manager automatically adjust the 
grid size, or uncheck this box and specify a graph maximum in percent.  For example, a 
setting of 50% will scale the wind rose graph radius to show a maximum of 50% of the 
winds along any given radius.  Set the “Major steps” to be the number of major 
graduations along the radius. 
 
You can click on the “Rose Color Selection” fields to change the color of the various sub-
ranges of the wind speed.  Also, you can name the wind rose in the “Chart title” box. 
 
An example of a wind rose is shown below: 
 

 
 

(The above figure is an example only; your configuration may be different.) 
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4.13.4 Editing a Wind Rose 
To edit a wind rose, open it (e.g., from the View menu), then click the “Edit” tool button 

.  Edit the properties as needed. 

4.14 Viewing Wind Roses 

4.14.1 Opening a Wind Rose View 
To view a Wind Rose, select “Wind Rose” from the View menu to open it: 
 

 
 
Note: You can display a Wind Rose that has already been opened by selecting it from 
Met Manager’s Window menu.  See Section 4.18. 
 

4.14.2 Automatically Opening a Wind Rose View at Startup 
To automatically open a Wind Rose View that you’ve created, set its check box in the 
View menu, “Startup” dialog.  Also see Section 4.16 for configuring various startup 
options. 
 

 
 

(The above figure is an example only; your configuration may be different.) 
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4.15 Configuring Data Table View and Report Options 

4.15.1 Configuring the Options 
To configure Data View and report options, select “Options” from the View menu. The 
following dialog will be presented: 
 

 
 

(The above figure is an example only; your configuration may be different.) 

4.15.2 Configuring the Data View Columns 
You can decide which database parameters will be visible on the Data View and their 
column order.  From the above figure, check the parameter if you want it to be in the 
Data View.  To reposition a parameter’s column order on the display, select the 
parameter with your mouse and then use the up and down arrows to move the parameter 
in the list. 
 
You can also set the units, number of display digits, and column width for each 
parameter.  These settings only affect the Data View. 

4.15.3 Configuring the Report Columns 
Similar to the Data View, you can decide which database parameters will be visible in the 
“data table listing” type of reports and their column order.  These reports include the Data 
Table Report and the Daily Summary Report. 
 
Select the “Report Columns” tab.  Then check the parameter if you want it to show up in 
the listing.  To reposition a parameter’s column order within the listing, select the 
parameter with your mouse and then use the up and down arrows to reorder the 
parameter. 
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(The above figure is an example only; your configuration may be different.) 
 

 
Note: The report listing is printed in “landscape” orientation to maximize the number of 
columns that can be fit in the report. However, Met Manager currently allows formatting 
of only one report (of the “data table listing” type).  Thus, you must decide which are the 
most important parameters for listing in the report.  Uncheck the least important 
parameters. 
 

4.15.4 Configuring the Report Header 
To configure a header that will show up on all reports, select the “Report Headings” tab.  
Then define entries for each heading line:  
 

 
 

(The above figure is an example only; your configuration may be different.) 
 

Each line of the heading is centered within the header area of the reports. 
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4.15.5 Setting up an Auto Report 
If you have a printer connected to the computer, you can set up Met Manager to 
automatically generate a Daily Summary Report.  Select the “Auto-Report” tab. 
 

 
 
Check the “Enable Daily Summary Auto-Report” box to enable an auto report.  
 
Some facilities may want to generate a Daily Summary Report on a schedule that does 
not end at midnight.  You can do this by specifying the last hour of the report in the “Last 
hour ending at” field. 
 
You can also specify the local time that the report is to print.   

4.16 Configuring Startup Options 
Many views may be defined for a Met Manager project including the Data View, Event 
Log View, Instantaneous View, multiple Trend Chart Views, multiple Indicator Views, 
and a Wind Rose View.  To avoid having to manually open these views when Met 
Manager first starts, you can configure some startup options.  Select “Startup” from the 
View menu to show the following dialog: 
 

 
 

(The above figure is an example only; your configuration may be different.) 
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Check the various views that you want Met Manager to automatically load when the 
program is first started.  You can also select a view (from the list) with your mouse and 
then use the up and down arrow keys to reorder it.  This ordering affects the order that the 
views are opened as well as the order of the list of views located in the Windows menu 
(see Section 4.18).  In the above example, the last view in the list titled “Wind and 
Temperature” will be the view on top following startup. 
 

4.17 Generating Reports 

4.17.1 Getting Started 
To generate reports, select the “Reports” menu: 
 

 
 
Then select individual reports from the menu: 
 

1. Data Tables Report.  Generates a columnar listing of a subset of one of the 
available data tables. 
 

2. Daily Summary Report.  Generates a daily summary listing for a specified 
date of the hourly data table. 
 

3. Daily Rainfall Report.  Generates a multi-column report of rainfall for every 
day in the chosen date range. 
 

4. Monthly Parameter Report.  Generates a monthly diurnal variation report for a 
chosen database parameter and for a chosen month. 
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5. Monthly Wind Frequency Report.  Generates a monthly wind frequency 
report. 
 

6. Monthly Data Recovery Report.  Calculates the monthly percent of data 
recovery for all database parameters. 
 

7. Chill Hour Report.   Generates a multi-column report of daily chill hours and 
accumulated chill hours for every day in the chosen date range. 
 

8. Chill Unit Report.  Generates a multi-column report of daily chill units and 
accumulated chill units for every day in the chosen date range. 
 

9. Growing Degrees Report. Generates a multi-column report of daily growing 
degree days or hours (user-specified) and accumulated degree days (or hours) 
for every day in the chosen date range. 
 

10. Evapotranspiration Report.  Generates a multi-column report of daily 
reference or crop evapotranspiration (user-specified) and accumulated 
evapotranspiration for every day in the chosen date range. 
 

11. Heating Degrees Report.  Generates a multi-column report of daily heating 
degree days and accumulated heating degree days for every day in the chosen 
date range. 
 

12. Cooling Degrees Report.  Generates a multi-column report of daily cooling 
degree days and accumulated cooling degree days for every day in the chosen 
date range. 

 
Each of the reports is explained in the following sections. 

4.17.2 Description of the Tool Bar 
The following tool bar rests above the report when being previewed: 
 

  
 

 
Show entire page 

 
Zoom to page width 

 
Zoom in the report 

 
Zoom out the report 

 
Go to first page of the report 

 
Go to previous page of the report 

 
Go to next page of the report 
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Go to last page of the report 

 
Print the report view to the printer.  Note: Before using this button, make sure that 
the printer has been properly setup.  Go to the File menu and “Print Setup” option 
to review the printer settings.  Configuring your printer or installing its printer 
driver is outside the scope of Met Manager.  

 Close the report view 
 

4.17.3 Data Tables Report 
To run the Data Tables Report, select it from the “Reports” menu.  Then pick the data 
table of interest and define the start and end date and time range: 
 

 
 
The above date range specifies one day beginning on January 5, 2002. 
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An example of a Data Table Report is shown below: 
 

 
 

4.17.4 Daily Summary Report 
To run the Daily Summary Report, select it from the “Reports” menu.  Then define the 
end date and time.  
 

 
 
The “end time” allows a 24-hourly daily report that is not midnight-to-midnight.  Some 
industrial facilities use this feature. 
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An example of a Daily Summary Report is shown below: 
 

 
 
 
Technical Note: The above report is generated from the hourly data table.  That’s why 
you do not specify a particular data interval.  
 

4.17.5 Daily Rainfall Report 
To run the Daily Rainfall Report, select it from the “Reports” menu.  Then pick the rain 
parameter (in case you have more than one) and define the start and end dates: 
 

 
 

   
Using Met Manager Page 4-69 Rev: 1.5 



Met Manager™ User’s Manual  Copyright © 2002 

An example of an abbreviated Daily Rainfall Report is shown below: 
 

 
 

 
Technical Note: The above report is generated from the hourly data table.  

 

4.17.6 Monthly Parameter Report 
To run a Monthly Parameter Report, select it from the “Reports” menu.  Then pick the 
database parameter of interest and the month and year: 
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An example of a Monthly Parameter Report for rain is shown below: 
 

 
 

 
Technical Note: The above report is generated from the hourly data table.  The m’s 
denote missing data. 

 

4.17.7 Monthly Wind Frequency Report 
To run a Monthly Wind Frequency Report, select it from the “Reports” menu.  Then pick 
the wind speed and wind direction database parameters of interest and the month and 
year.  The example below uses wind speed and scalar wind direction database 
parameters: 
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Technical Note: The above report is generated from the hourly data table.  

 

4.17.8 Monthly Data Recovery Report 
To run a Monthly Data Recovery Report, select it from the “Reports” menu.  Then define 
the month and year of interest: 
 

 
 

An example of a Monthly Data Recovery Report is shown below:  
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Technical Note: The above report is generated from the hourly data table.  
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4.17.9 Chill Hour Report 
To run a Chill Hour Summary Report, select it from the “Reports” menu.  Then select a 
chill hour database parameter from the drop-down list, and define the date range of 
interest.  Units of “CH” stand for “Chill Hours.” 
 

 
 

An example Chill Hour Summary Report is shown below: 
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4.17.10 Chill Unit Report 
To run a Chill Unit Summary Report, select it from the “Reports” menu.  Then select a 
chill unit database parameter from the drop-down box, and define the date range of 
interest.  Units of “CU” stand for “Chill Units.” 
 

 
 

An example Chill Unit Summary Report is shown below: 
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4.17.11 Growing Degrees Report 
To run a Growing Degrees Report (day or hour), select it from the “Reports” menu.  Then 
select a growing degree day or growing degree hour database parameter from the drop-
down list, select the units, and define the date range of interest.  Units include DD°C 
(degree days in °C), DD°F (degree days in °F), DH°C (degree hours in °C), and DH°F 
(degree hours in °F). 
 

 
 

An example Growing Degrees Summary Report (in units of DD°F) is shown below: 
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4.17.12 Evapotranspiration Report 
To run a reference or crop Evapotranspiration Report, select it from the “Reports” menu.  
Then select a crop or reference evapotranspiration database parameter from the drop-
down list.  Select units of inch or mm, and define the date range of interest.  
 

 
 

An example Evapotranspiration Summary Report is shown below: 
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4.17.13 Heating Degrees Report 
To run a Heating Degrees Report, select it from the “Reports” menu.  Then select a 
heating degree day database parameter from the drop-down list, select the units, and 
define the date range of interest.  Units include DD°C (degree days in °C), DD°F (degree 
days in °F), DH°C (degree hours in °C), and DH°F (degree hours in °F).  Be sure to 
specify DD°F or DD°C for common heating degree day units. 
 

 
 

An example Heating Degrees Summary Report (in units of DD°F) is shown below: 
 

 
 

   
Using Met Manager Page 4-78 Rev: 1.5 



Met Manager™ User’s Manual  Copyright © 2002 

4.17.14 Cooling Degrees Report 
To run a Cooling Degrees Report, select it from the “Reports” menu.  Then select a 
cooling degree day database parameter from the drop-down list, select the units, and 
define the date range of interest.  Units include DD°C (degree days in °C), DD°F (degree 
days in °F), DH°C (degree hours in °C), and DH°F (degree hours in °F).  Be sure to 
specify DD°F or DD°C for common cooling degree day units. 
 

 
 

An example Cooling Degrees Summary Report (in units of DD°F) is shown below: 
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4.18 Window Menu 
The Window menu shows various views that have been opened: 
 

 
 
From this menu, you can cascade or tile the various views, and can easily choose an 
opened view to display. 

4.19 Help Menu 
The Help menu currently includes the following choices: 
 

 
 
Select “Review Software License Agreement” to review and print the agreement: 
 

 
 
Select “About” from the Help menu to review the version of the software and the 
software Licensor’s name and contact information. 
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4.20 Exporting Data 
Subsets of the project data tables can be exported for offline analysis or other use.   
Export file types include text-based comma-separated variable (CSV), Paradox, and 
dBase. 
 
To export data, select “Export” from the File menu.  The following export dialog is then 
presented: 

 
 
Select the data interval of interest from the “Data interval” list box.  Met Manager will 
export its data from the corresponding data table.  Then select the start and end dates and 
times. 
 
If you are generating a CSV file, then check the “Export parameter status tags to csv file” 
box to export the data values with status tags that represent valid (0), partially valid (1), 
invalid (2), calibration (3), or missing (4) status.  This option applies only to CSV files 
since parameter status tags are always exported to Paradox and dBase file types.  Recall 
that “partially valid” means that at least one sample was acquired for the data interval, but 
fewer than three-quarters of the possible number of samples (as defined by the sample 
data rate).   
 
Click on the “Browse” button to locate a place on your computer to save the export file: 
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You can also select a type of data file to export from the “Save as type” list box.  File 
types include CSV, Paradox, and dBase.  The default file type is “CSV File” format. 
 
Upon successful export, a message similar to the one below is displayed. 

 

 
 

In the example below, an exported CSV file was imported into a Microsoft Excel 
spreadsheet. The first line of the header identifies whether or not the exported file 
includes the parameter status tags.  The second line identifies each exported parameter’s 
database tag (DB1, DB2, etc.).  The third line is the “column name” of the database 
parameter.  The fourth line is the measurement height (level) of the parameter above (or 
below) the ground in meters.  The fifth line is the exported units.  These units are the 
standard default ones used in the project database, and are assigned by Met Manager.  
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(The above figure is an example only; your configuration may be different.) 
 
Recall that the status tags have the following meanings: 
 
 0 = valid (at least three-fourths of the samples were acquired)  
 1 = partially valid (at least one, but fewer than three-fourths of the samples were  
  acquired) 
 2 = invalid 
 3 = calibration 
 4 = missing (no samples acquired) 
 
 
Note: The “date” field is exported with a format of “m/d/yyyy h:mm”.  The individual 
parameter fields are exported in scientific notation.   
 
Note: In the example above, and from within the Excel spreadsheet, the header cells were 
centered and the individual parameter “value” cells were centered and formatted as 
“numbers” with a fixed format of 2 decimal places. 
 
Below is an example of data that was exported without status tags: 
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(The above figure is an example only; your configuration may be different.) 
 

 
CAUTION:  Be sure to review the exported data and remove any questionable data 
before using it in an analysis. 
 

4.21 Setting up a Printer 
To setup the printer (or to review its settings), select “Print Setup” from the File menu.  
Then make printer configuration changes as needed.  
 
Note: Met Manager uses a standard Windows printer interface dialog.  Configuration of 
your printer is outside the scope of the Met Manager program.  If you are having 
difficulty printing with your printer, contact the printer manufacturer or your printer 
supplier.  You may need to update your printer driver. 
 

4.22 Exiting the Program 
To shut down Met Manager, select “Exit” from the File menu or press the “close 
program” button in the upper right of Met Manager’s display window.  If Met Manager is 
connected to a data source, then the following message is displayed: 
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Press the Yes button if you wish to exit.  Otherwise press the No button. 
 
Note: If Met Manager was connected to a data source when shut down, then Met 
Manager will automatically open its last active project folder and data source when 
restarted (unless a command line option directs Met Manager to do something else).  
Refer to Appendix D on optional program startup command line options.  
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5 MAINTENANCE AND CALIBRATION 

5.1 Setting the Status of a Channel 
To activate special maintenance functions, select the View menu, then the Instantaneous 
View submenu.  Then press the “Maintenance Mode” button from the Instantaneous 
View: 
 

 
 
To set a Data Source Channel to invalid or calibrate status (or to return it to valid status), 
select the channel of interest (in the left-hand column) with your mouse.  Then press the 
“Invalid” or “Calibrate” button.  That channel, and all parameters derived from that 
channel will be tagged with the new status.  This is important to filter bad or questionable 
data or channels undergoing a calibration, to keep that data out of the “valid” data set. 
 
Note:  When Met Manager detects that a sensor’s value is out-of-range, then Met 
Manager automatically flags the data as invalid until the sensor is back in range.  The 
range of valid values is configured with the Data Source Parameters editor from the Setup 
menu.  See Section 3.6. 
 

5.2 Calibration 

5.2.1 Overview of the Calibration Process 
With Met Manager you can set the calibration coefficients of each weather sensor in the 
following ways: 
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1. Two-point Method.  For each of two points, enter the “as found” measurement 
of a sensor channel in base units and the corresponding measurement of the 
calibration standard in the same base units.  Met Manager then calculates a 
new calibration slope and offset for the channel.  (The “as found” 
measurement readings must be taken from Met Manager’s display in “base 
units”) 
 

2. Corrective Slope and Offset Method.  Enter in “corrective” slope and offset 
values that you calculated outside of Met Manager.  These slope and offset 
values correct “as found” measurements in base units to values of the 
calibration standard in the same base units.   Met Manager then calculates a 
new calibration slope and offset for the channel. 
 

3. Recovery Method.  Enter in a calibration slope and offset from a prior 
calibration report.  This allows you to recover the calibration of the channel if 
you have to replace your hard disk, or if you relocate the Met Manager 
software to another computer. 

 
Methods 1 and 2 above are discussed in Section 5.2.2.  Method 3 is discussed in Section 
5.2.3.  For an overview of the calibration process, see Appendix E.   

5.2.2 Calibrating Sensor-based Channels 
To calibrate one or more sensor-based channels, follow these steps: 
 

1. Locate and review any manufacturer-supplied instructions for calibrating the 
sensors of interest.  Use appropriate calibration standards and ensure that the 
environment will not negatively impact the calibration.  For example, do not 
calibrate a rain gage while it is raining.  
 
Note:  This User’s Manual does not provide instructions for applying a 
calibration standard; only for creating the calibration coefficients when the 
sensor is appropriately stimulated with, or compared to a calibration standard. 
 

2. Go to the Instantaneous Data view located on the View menu (see Section 
5.1). 
 

3. Press the “Maintenance Mode” button from the Instantaneous View. 
 

4. With your mouse, select a Data Source Channel that you wish to calibrate.  
This channel is located in the left column of the Instantaneous View.   Press 
the “Calibrate” button to flag the channel as being in calibration mode.  This 
keeps calibration data out of the “valid” data set. 
 

5. Repeat step 4 for each channel that you will be calibrating.  When you finish 
with this step, each channel to be calibrated should have a status of 
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“Calibrate”. 
 

6. With your mouse, select the first sensor to be calibrated from the left hand 
column of the Instantaneous View. Then press the “Calculate Calibration 
Coefficients” button to show the “Calibration Calculator”: 
 

 
 

(The above figure is an example only; your configuration may be different.) 
 

You have two methods to choose from: Two-point Method (step 7), or 
Correction Slope and Offset Method (step 8). 
 

7. Two-point Method: 
 
a. For the first calibration point (see the figure above), enter the “As found” 

value response from the sensor (as shown on the Instantaneous View). 
 
[Only if you have a direct-connection ( i.e., real-time) to the data logger 

may you instead press the  button.  Met Manager will then fill the value 
in for you.] 
 
CAUTION: The “as found” value you enter MUST be that value that Met 
Manager converted to base units after receiving it from the data logger (or 
other data source).  Failure to follow this rule will result in a faulty 
calibration.  You can view the “as found” value on the left-hand side of 
the Instantaneous View next to the “Base Unit” column.  Alternatively, use 
the View menu, Options item to set a column of the Data View to Base 
Units.  Then view the appropriate time-averaged (or totalized) “as found” 
value within the Data View.   
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b. Next enter the value of the calibration standard in the “Calibration 
standard” field and in base units as shown near the top of the Calibration 
Calculator display.  This value MUST be taken over the same time period 
as the “as found” reading. 
 
 
CAUTION:  Be sure to enter the value of the calibration standard in the 
“Calibration standard” field and in base units as shown near the top of the 
Calibration Calculator display.  Make sure that the value of the calibration 
standard is obtained over the same time period as the “as found” reading. 
Failure to follow these rules will result in a faulty calibration. 
 
 

c. Repeat steps 7(a) and 7(b) for the second calibration point. 
 

d. Press the “Apply” button to activate the new calibration for the channel.  
You will then get a confirmation message similar to the following: 
 

         
 
        (The above figure is an example only for illustration purposes.)  
 
Press “Yes” to confirm the values you entered; otherwise press “No”. 
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CAUTION: If the values are not correct, then press “No”.  You might 
think that you can press “Yes”, and then if incorrect, just go back and re-
enter the values for the two points.  However, doing so will create an 
invalid calibration because the new slope and offset values that were 
created (when you pressed “Yes”) will now affect the new “as found” 
values of the two points.  Instead you will have to (a) repeat the entire 
two-point calibration for the channel all over again, or (b) enter in the 
recovery slope and offset from the prior calibration (see Section 5.2.3) 
and then re-enter the two-point “as found” and “calibration standard” 
values.  
 
 

e. Remove the calibration standard and restore the sensor to its normal 
operating state. 
 

f. To select another channel to calibrate with the Two-point Method, press 
the back or forward arrow in the upper right corner of the Calibration 
Calculator.  Then repeat step 7 in its entirety.  
 

8. Correction Slope and Offset Method: 
 
To use the “Correction Slope and Offset Method”, select the “Correction 
Slope and Offset” tab near the top of the Calibration Calculator.  A figure 
similar to the following will then be displayed: 
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a. Enter “correction” slope and offset values that you obtained somehow off-
line.  These values convert “as found” readings (in base units) to match the 
calibration standard (also in base units) by the following relationship: 
 
       Calibration Standard Value = (“As found value” x Slope) + Offset 
 
For the first calibration point (see the figure above), enter the “As found” 
value response from the sensor (as shown on the Instantaneous View). 
 
CAUTION: The values you enter MUST obey the above equation and 
must have been derived from “as found” and calibration standard 
measurements, both in base units, where the base units are identified near 
the top of the Calibration Calculator.  Failure to follow this rule will 
result in a faulty calibration. 

b. Press the “Apply” button to activate the new calibration for the channel.  
You will then get a confirmation message similar to the following: 
 

                 
 
      (The above figure is an example only for illustration purposes.)  
 
Press “Yes” to confirm the values you entered; otherwise press “No”. 
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CAUTION: If the values are not correct, then press “No”.  You might 
think that you can press “Yes”, and then if incorrect, just go back and re-
enter the “correction” slope and offset values.  However, doing so will 
create an invalid calibration because the new composite “calibration” 
slope and offset values that were created (when you pressed “Yes”) will 
now affect the new “correction” values since these values are based on “as 
found” measurements.  Remember that the slope and offset values you 
entered on the “Correction Slope and Offset” tab are “corrective” values; 
not composite calibration values.  Instead you will have to (a) repeat the 
entire calibration for the channel all over again, or (b) on the “Recovery” 
tab, enter in the recovery slope and offset from the prior calibration (see 
Section 5.2.3) and then on the “Correction Slope and Offset” tab, re-enter 
the “correction” slope and offset values. 
 

c. Remove the calibration standard and restore the sensor to its normal 
operating state. 
 

d. To select another channel to calibrate with the Correction Slope and Offset 
Method, press the back or forward arrow in the upper right corner of the 
Calibration Calculator.  Then repeat step 8 in its entirety.  
 

9. Restore Channel to Normal Operating Mode: 
 
If you have a direct connection (real-time) to the data logger, then review 
current data values reported by Met Manager for the channel just calibrated.  
Ensure that the reported values are representative of the sensor measurements 
and reflect the new calibration coefficients.  For example, let’s suppose that 
you just calibrated the ambient temperature sensor at two points, and in 
degrees Fahrenheit.  You know that the outside temperature is about 70 to 75 
°F, yet the sensor, following calibration, is reporting 157 °F.  Something is 
wrong.  During calibration, you may have entered the standard values in °C 
instead of °F.  Or perhaps the sensor was not properly restored to its normal 
operating state. 
 
If you periodically capture the data from the data logger, wait until the logger 
has logged some data in its internal memory.  Then instruct Met Manager to 
capture the data in the usual way.  Review the captured data to ensure that the 
reported values are representative of the sensor measurements and reflect the 
new calibration coefficients.  If not, then your calibration may have been in 
error. 
 

10. Once you are sure that the calibration was completed successfully, take the 
sensor channel out of calibration mode.  With the sensor channel selected, 
click on the “Calibrate” button so that it is no longer depressed.  The status of 
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the sensor should return to “valid.”  Verify that it does. 
 

11. Repeat steps 9 and 10 for each channel that you calibrated. 
 

12. Generate a Calibration Summary Report: 
 
To review and print a Calibration Summary Report, select “Calibration 
Report” from the Setup menu: 
 

                  
 
An example Calibration Summary Report is shown below: 
 

 
 
               (The above figure is an example only for illustration purposes.)  
 
This report documents the new calibration slope and offset coefficients and 
date of calibration.  Also, if you ever have to recover the coefficients because 
of a computer failure, you will need this report.  Otherwise you may have to 
repeat the calibration. 
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5.2.3 Recovering Calibration Coefficients 
You may need to recover Met Manager’s calibration coefficients because of a computer 
hardware failure or other reason.  To do so, first locate a hardcopy printout of the 
Calibration Summary Report for the prior calibration.  Second, review the Data Source 
Parameters from the “Setup” menu to ensure that the base unit conversion slope and 
offsets values are correct and that the “base unit” is the same as printed on the prior 
calibration report.  Third, go to the Calibration Calculator by pressing the “Maintenance” 
button on the Instantaneous Data View (of the “View” menu).  Finally, enter the 
calibration slope and offset values from the prior Calibration Summary Report into the 
“Recovery Method” tab of the Calibration Calculator: 
 

 
 
After you enter the values, press the “Apply” button.  A confirmation screen similar to 
the following will then appear: 
 

 
 

(The above figure is an example only for illustration purposes.)  
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If the values are correct then press “Yes”.  Otherwise press “No” and re-enter the values.  
 

5.3 Activating a Debug Log 
Sometimes it is useful to capture the raw data records that are being received by Met 
Manager from a direct-connect type of data logger.  To capture the received data to a text 
file, follow these steps: 
 

1. Connect to the direct-connect data source.  An active connection must be 
made prior to turning on the debug log.  Thus the data source must be of the 
type “direct connect”. 
 

2. Select “Debug Log” from the Setup menu to turn it on: 
 

 
 

3. Specify the path and name of the log file that will hold the raw data. You can 
specify any filename you wish. The default name is “datacomm.log” and is 
located on the project path. For example: 

 

 
 

(The above figure is an example only; your configuration may be different.) 
 

If you do not wish to use the default project path name (c:\weather data” in 
this example), then you will have to create the path folder (and subfolders if 
any) with Microsoft Windows File Explorer (or similar software) prior to 
enabling the debug log function.  You can also specify a file name other than 
“datacomm.log” and Met Manager will create it. 
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The debug log is a date/time stamped text file that contains records received by Met 
Manager from the data source.  These records are the raw data from the data source and 
do not reflect Met Manager’s application of calibration coefficients or unit conversions.   
To see if the log is enabled, go to the Setup menu.  If a check mark is in front of the 
“Debug Log” submenu selection, then it is enabled.  To disable the log simply select the 
“Debug Log” menu item again.  Closing the connection will also disable the debug log. 
 

 
 

You can review the contents of the debug file with a text editor program such as 
Microsoft’s Notepad.  However, if the file is large, then you may have to use a word 
processor or other program to review it. 
 
CAUTION:  The size of the debug log text file can grow very large and very fast 
depending on the frequency of raw data received from the data source.  For example, if 
data is received by Met Manager every second, then a new data line is added to the 
“debug log” file every second.  Be sure to turn off (disable) the “debug log” feature if 
you no longer need it. 
 
Note: If you close down and then restart Met Manager, you will need to re-enable the 
debug log capability as its active state is not maintained by Met Manager. 
 

5.4 Packing the Project Database 
The project database must be periodically packed so that deleted records are permanently 
removed from the database.  For instance, if a 1-minute table is "wrapped" at seven (7) 
days, the records deleted from the table by the wrap function still remain in the database 
file even though they are not visible to the application.  Even when a wrap is used, the 
wrap function does not reduce the actual size of the file.  To reduce the file size and 
permanently remove the deleted records, the database must be periodically packed. 
 
Below is a recommended pack schedule; use the minimum pack schedule (maximum 
frequency) that applies to your particular data table configuration. 
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Data Table Interval 

(with “Delete data older 
than” option set) 

 
Pack Schedule 

1 Minute Data Table Every 1 month 
5 Minute Data Table Every 3 months 
10 Minute Data Table Every 6 months 
15 Minute Data Table Every 6 months 
20 Minute Data Table Every 6 months 
30 Minute Data Table Every 6 months 

Hourly Data Table Once a year 
 
 

Note: You do not have to pack data tables that are setup with the “Keep data indefinitely” 
option (since these data tables are not wrapped).  See Section 3.8. 
 

Note: When a pack is performed, all the data tables within the project database are 
packed.  That’s why the pack schedule should be the minimum period (maximum 
frequency) of the data tables assigned to the project. 
 
IMPORTANT:  Before packing, insure that there are no active connections (other than 
Met Manager) to the database.  This includes connections by Met Viewer, Met Mirror, or 
any other import/export/reporting software that is attached to the database. 
 
For Met Manager, close the data source connection by selecting “Close connection” from 
the Setup menu. See the figure below. This then enables (ungrays) the “Pack Database” 
menu item. For all other programs that may have a connection to the database, stop and 
close them to remove their connection to the project database. 
 
To pack the database and permanently remove any deleted data records, select the “Pack 
Database” menu item from the Setup menu: 
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The following dialog is then displayed: 
 

 
 
 
Press “Yes” to begin the pack operation or “No” to not continue. 
 
Note: The pack operation can take awhile, in some cases 20 to 30 minutes (or longer) 
depending on the number and size of the data tables. 
 
The pack operation can fail for the following reasons: 
 

• There is still an active connection to the project database (i.e., a Met Viewer or 
Met Mirror may still be running).  The database cannot be packed when an active 
database connection exists. 
 

• A file error occurs.  If a file error occurs while attempting to pack the database, 
the pack operation will fail.   

 
IMPORTANT: To pack a mirrored database, use the Met Database Utility.  See 
Appendix C.  Following the pack operation, restart Met Mirror. 
 

5.5 Restructuring the Project Database 
The project database must be restructured when changes are made to the database 
parameters.  If the database parameters are changed, for example adding or removing 
acquired or derived parameters, the database must be modified to reflect the added or 
removed fields. 
 
IMPORTANT:   Restructuring is normally performed automatically by Met Manager 
when the database parameters are changed.  Use the Restructure Database menu option 
only if the normal restructure operation did not complete for some reason. 
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IMPORTANT:  Before restructuring, insure that there are no active connections (other 
than Met Manager) to the database.  This includes connections by Met Viewer, Met 
Mirror, or any other import/export/reporting software. 
 
For Met Manager, close the data source connection by selecting “Close connection” from 
the Setup menu. This then enables (ungrays) the “Restructure Database” menu item. For 
all other programs that may have a connection to the database, stop and close them to 
remove their connection to the project database. 
 
CAUTION: Before restructuring, be sure that you have a good backup copy of the 
database. 
 
To restructure the database, select the “Restructure Database” menu item from the Setup 
menu: 
 

 
 
The following dialog is then displayed: 
 

 
 
Press “Yes” to begin the restructure operation or “No” to not continue. 
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Note: The restructure operation can take awhile, in some cases 20 to 30 minutes (or 
longer) depending on the number and size of the data tables. 
 
The restructure operation can fail for the following reasons: 
 

• There is still an active connection to the project database (i.e., a Met Viewer or 
Met Mirror may still be running).  The database cannot be restructured when an 
active database connection exists. 
 

• A file error occurs.  If a file error occurs while attempting to restructure the 
database, the restructure will fail.  This could cause loss of data.   (That’s why its 
important to backup the project database before adding or removing parameters.) 

 
IMPORTANT: To restructure a mirrored database, use the Met Database Utility.  See 
Appendix C.  Following the restructure operation, restart Met Mirror. 
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6 TROUBLESHOOTING 

6.1 Technical Requirements Related to Microsoft Windows 
Met Manager uses the Microsoft Windows registry to retain information about how it 
was last shut down (last open project, last active data source, and activity status of the 
data source).  Thus, Met Manager must be installed with read/write/create permission to 
the registry.   
 
Met Manager stores its acquired and derived data in a project database.  Thus the 
Microsoft Windows log-on profile (if any) that executes Met Manager must have 
read/write/create permission to the project database. 
 
Met Manager must be closed (shut down) when changing to a new user.  For proper 
operation of Met Manager, do not use the fast switching capabilities of the Windows 
2000 and XP operating systems. 

6.2 Standard Time and Daylight Saving Time 
When Met Manager is directly and continuously connected to the data logger, Met 
Manager acquires the sensory data from the data logger and assigns the Met Manager-
hosted computer-based date/time stamp to the data.  Met Manager reads Microsoft 
Windows’ settings to determine if daylight saving time is active, and if so, ensures that 
the time tag is assigned to the database parameters in local “standard” time.   Therefore it 
is important that the date, time, daylight saving time flag, and time zone be properly set 
and maintained in Windows on the Met Manager-hosted computer.  During daylight 
saving time, the local standard time assigned to the data stream should be exactly one 
hour before the local daylight saving time reported by Windows.  When daylight saving 
time is not active, then the time assigned to the data stream should be the same time as 
local time (i.e., local time equals standard time).  
 
When Met Manager captures data from the internal log of the data logger (perhaps by 
dial or cellular modem), then the data logger assigns its own date and time to the 
individual records of the data log.   Thus, the data logger time must be set to local 
standard time.  During daylight saving time, the data logger time will therefore be exactly 
one hour before local daylight time.  When daylight saving time is not active, then the 
data logger’s standard time should be the same as local time. 
 
Met Manager records each data record within the project database in local standard time.  
Currently Met Manager also displays and reports all its data in local standard time.   
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IMPORTANT: Windows handles daylight saving time differently on Windows 
95/98/ME computers than on NT/2000/XP computers.  On Win NT/2000/XP computers, 
when daylight saving time is currently in effect and the “Adjust for daylight saving time” 
flag on the clock settings is manually disabled (unchecked), then Windows automatically 
sets your PC clock time back an hour to truly put your computer back in standard time.    
However, on Win 95/98/ME computers, Windows does not change the clock time.  The 
time has to be manually set back an hour.  It is important to know these distinctions in 
order to ensure that synchronization of a data logger’s time to the PC clock time is done 
in local standard time.  Always capture some data from the data logger after its clock 
time has been changed (or synchronized to the PC clock) to ensure that the data logger’s 
time base is set to local standard time. 
 
In summary, the PC computer’s date, time, time zone, and daylight saving time setting 
must be properly set and maintained in local time.  When Met Manager is directly and 
continuously connected to the data logger, Met Manager uses this information to derive 
“standard” time to be assigned to the individual records of the database.  Met Manager 
also uses this information for time stamping events within its event logs, and for tagging 
the date and time of reports. 
 
When the data logger is used to log its data into internal memory for later capture by Met 
Manager, the data logger’s date and time must be properly set and maintained in local 
“standard” time. Each record of the data log is time stamped in standard time.   
 
Following these rules will ensure a high level of data continuity within Met Manager’s 
database. 

6.3 Networking 
The project database created and managed by Met Manager (or Met Mirror) allows 
multiple, simultaneous users.  The Paradox database manager tracks the project database 
users with the use of three Paradox files: PDOXUSRS.NET, PDOXUSERS.LCK, and 
PARADOX.LCK.  If Met Viewer, Met Manager, or Met Mirror loose their connection to 
the project database because of a power loss or other network glitch, or someone aborts 
Met Manager or Met Viewer instead of properly shutting them down, then the lock 
(.LCK) files may not be properly updated.  Met Manager or Met Viewer will report a 
message “Directory is controlled by other .NET file.” This can result in the database 
being perpetually marked for exclusive access to only one program.  The solution is to 
close (shutdown) all active Met Manager, Met Mirror, and Met Viewer programs that 
have access to the affected project database, and then delete the two “.LCK” files from 
the project (or mirrored project) database.  CAUTION: It is a recipe for disaster if you 
delete the lock files while an application is updating the database tables. 
 
Paradox allows 300 users to be attached to one PDOXUSRS.NET file.  The Borland 
Database Engine (BDE) allows 48 users.  However, because of the way that Met Viewer 
interacts with the database, there is usually only one or two users assigned to a given 
BDE on a workstation.   
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6.4 Frequently Asked Questions 

6.4.1 Definitions 
1. What is a “project”?  Met Manager stores its database and related files within a folder 

on the computer’s hard disk or on a network file server.  The project is simply the 
name of the folder.  The name is assigned when Met Manager creates a new project 
(File menu, New Project).  

 
2. What is a “project database”?  This is a combination of files that make up the data 

tables and index files maintained by Met Manager. 
 
3. What is a data table?  A data table consists of five files that contain information 

related to a particular data interval.  These files contain the date and time stamp, 
database parameters, and indexing information associated with that data interval 
within the overall project database.  (A database usually contains several data tables; 
each related to a different data interval.) 

 
4. Why do you call the data logger a “data source”?  Depending on capabilities 

supported by the vendor of your weather station, Met Manager is capable of acquiring 
data from more than one source:  data logger, data logger file image, and comma-
separated variable (CSV) file.  That’s why the more generic term “data source” is 
used instead of “data logger”. 

 
5. Why do you call a data logger’s output channel a “data source parameter”?  Perhaps 

we could have called it a “data logger parameter”, but then if the data came from an 
import file we would have had to call it a “data file parameter”.  A more generic 
description is “data source parameter” which describes the source of the data, whether 
a data logger, data file, or other source. 

 
6. What is the difference between a “data source” parameter and a “database” 

parameter?  A “data source” parameter is one that comes from the source of the data, 
typically a data logger.  A “database” parameter is one that the user wants to be stored 
within the project database.  A database parameter may be an acquired data source 
parameter or a derived parameter. 

6.4.2 Data Logger 
7. How do I assign a new sensor to my data logger?  Review manuals or other 

documentation that came with your weather station or data logger to determine how 
best to connect the new sensor to the data logger and to define the location of the new 
data associated with that sensor within the output data stream of the data logger. 
 

8. I have been acquiring data from the data logger at a 5-second data rate but want to 
change it to a 1-second rate.  What is required? 
 

a. Review vendor-supplied documentation or contact your weather station vendor 
to make sure that your data logger is capable of supporting the higher data 
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output rate. 
 

b. Verify that your sensors do not limit the output rate to its present 5-second limit.  
For example, some wind speed sensors provide only one or two pulses per 
revolution of the cup.  To be able to resolve low wind speeds, the data logger 
must count these pulses over a time period longer than one second. 
 

c. If steps a and b are limiting, then you cannot increase the data rate.  If not 
limiting, then proceed to step d. 
 

d. Program the data logger with a faster output rate.  Consult your data logger 
documentation or contact the vendor of your weather station. 
 

e. Within Met Manager, change the “sample rate” property of the data source to 
match the data logger output data rate (go to the Setup menu, Data Sources, then 
select the appropriate data source and press the “Properties” button.)  
IMPORTANT:  These rates must match. 

6.4.3 Data Source 
9. How do I assign my data logger to Met Manager?  You must create a “data source” 

within Met Manager.  The data source corresponds to not only your data logger, but 
how Met Manager will be using your data logger.  For example, Met Manager may be 
directly connected to the data logger and may continuously get data from the data 
logger.  In that case, specify a “Direct Connect” data source.  Or Met Manager may 
be directly-connected but will only periodically capture data from the logger. Specify 
a “Data Log Capture (COM Port)” data source.  Or Met Manager may capture data 
from the logger by dial-out modem connection.  Specify a “Data Log Capture 
(Modem)” data source.  Go to the Setup menu, then Data Sources.  If the data source 
is not already created, then press the New button and select the appropriate data 
source from the list.  Then press the Properties button to review and edit the data 
source’s configuration settings. 

 
10. Why can I have only one data source active in my project even though I have created 

more than one? The data source parameters define the order and makeup (data types) 
of the data stream that flows between the data source and Met Manager.  Currently 
Met Manager allows only one unique mapping of the data source parameters to the 
database parameters; thus only one data source can be active.  

 
11. Why is the data source list blank when I try to connect to the data source from the 

Setup menu?  You have not yet created a “data source”.  Go to the Setup menu, then 
Data Sources, and press the New button.  Select a data source from the list to create a 
new one.  Then select the icon for that source and press the Properties button to 
configure its settings. 

 
12. I renamed my data source.  Why does Met Manager no longer begin logging the data 

at startup?  Apparently you are using command line options (see Appendix D) when 
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starting up Met Manager to force Met Manager to open a project and activate a data 
source.  If you renamed the data source, then you must use the new name in the 
command line option; otherwise Met Manager cannot find the new source when 
starting up. 

6.4.4 Project 
13. How can other personnel have access to the project database?  Met Viewer™ is a 

software product that is very similar to Met Manager.   Met Viewer allows other 
network users to have access to the project database.  In a peer-to-peer or file server 
network, Met Viewer attaches to the project database maintained by Met Manager, or 
to a replicated database maintained by Met Mirror.  With Met Viewer, you can recall, 
view, graph, indicate, report, and export the data in a variety of ways, and in the same 
way as Met Manager.  The Met Viewer software product is purchased separately from 
Met Manager.  Met Viewer licenses are available for 1, 5, 10, 20, 50 and unlimited 
number of users (at one physical site location). 

 
14. Can I create a new project from an existing project?  Yes, see Section 3.3.  The 

existing project configuration settings are copied over to the new project but the 
database is not copied. 
 

15. I want to duplicate the project database.  How do I do it?  There are at least three 
ways as explained below, depending on your reason for duplicating the project 
database; (a) use Met Mirror to create a duplicate copy, (b) create a copy with 
Windows File Explorer, or (c) use backup software to duplicate the project database. 
 

a. If you want to create an on-going copy that stays in sync with the master 
database, then setup and activate Met Mirror.  See Appendix B. 
 

b. If you just want to create a static copy, then first stop Met Manager.    Met 
Manager must be stopped so that new data will not be written to the file while 
the copy process is occurring.  (Otherwise the database index files can get out of 
synchronization with the rest of the database.) Second, use Windows File 
Explorer to make a copy of the project folder.  Finally, restart Met Manager. 
 

c. Use backup software to backup the project folder on a regular basis. 

6.4.5 Site Settings 
16. Met Manager is installed on a Windows NT workstation.  Why is the “time zone” list 

box blank when I click on it?  Check with your network administration to ensure that 
proper user profile permissions have been installed to allow the Met Manager 
program to access certain Windows information. 

6.4.6 Data Tables 
17. I have been acquiring 15-minute and hourly data for some time within my project 

database.  Can I add a new 5-minute data table?  Yes, go to the Setup menu, then 
Data Tables.  Simply check (enable) the 5-minute data table and specify the wrap 
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interval.  See Section 3.8.  Wait a few minutes for Met Manager to create the first 5-
minute database record.  Then close the Data View and reopen it.  You should now 
see a new “5-minute” tab on the Data View display. 

 
18. I have decided that I no longer need a data table.  How do stop adding data to it?  Go 

to the Setup menu, then Data Tables.  Uncheck the data table that you no longer want.  
Met Manager will then stop adding data to that data table.   

 
19. I have decided that I no longer need a data table, and I want to get rid of it entirely.  

How do I remove it from the project database?  First, uncheck (disable) the data table 
you no longer want from the Data Tables dialog (Setup menu, then Data Tables).  
Second, stop Met Manager (and Met Mirror if active).  Third, make a backup copy of 
the project folder to protect against accidental file deletions (and in case you later 
decide you really need the data).  Fourth, with Windows File Explorer, locate the 
“project” folder.  Within that folder will be several files with names beginning with 
DATTBL (or dattbl).  Each file name ends with the data table interval and a file 
extension. For example, a 1-minute data table has the following five files associated 
with it: dattbl1.db, dattbl1.px, dattbl1.val, dattbl1.xg0, and dattbl1.yg0.  Other data 
tables (intervals) have similar file names.  Delete all five files for the particular type 
of data interval (data table) of interest from the project folder.  Finally, restart Met 
Manager.  Review the Data View and verify that the tab is no longer shown for the 
data table (data interval) you just deleted. 

6.4.7 Data Source Parameters and Database Parameters 
20. Why should I backup my project folder before adding or deleting data source or 

database parameters?  Adding or deleting data source or database parameters can 
cause a major reconfiguration of the database and configuration settings files within 
Met Manager.  Deleting a database parameter will remove it from the database.  
Backing up allows you to restore your data if something goes wrong.  That backup 
will also prove invaluable when you later realize that you need to run a historical 
report on a parameter that you deleted.  Thus it is important to not only periodically 
backup the database but to backup the entire project folder.  (Backing up the project 
folder also backs up the database.) 
 

21. I have just installed my new weather station.  I have created a new project from an 
existing project using a project template from the installation CD.  But I want to 
remove some of the data source parameters and database parameters and add others.  
How do I accomplish this?  First, make sure that the connection to the active data 
source is closed (Setup menu, Close connection). Next carefully review the guideline 
in Section 3.6 for adding or deleting data source and database parameters.  Then 
remove data source and database parameters you no longer want by selecting them 
one-at-a-time from their respective lists (see Sections 3.6 and 3.7), and pressing the 
“delete” key.  You may also need to rearrange the data source parameters to match 
their order within the received data stream.  Next, add any new data source 
parameters and finally add any new database parameters.  Realize that deleting data 
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source and database parameters may require reconfiguration of trend charts, the Data 
View columns, report columns, wind rose, and indicators. 

 
22. I want to add a new data source parameter because I added a new sensor to my data 

logger.  But why is it that when I go to the Setup menu, Data Source Parameters 
Editor dialog, I don’t see any data types?  You must close the connection to the data 
source (Setup menu, Close connection). 

 
23. I have added a new sensor to my data logger.  How do I make Met Manager aware of 

a new sensor?  First, close the connection to the active data source (Setup menu, 
Close connection).  Next carefully review the guideline in Section 3.6 for adding or 
deleting data source and database parameters.  Add a new data source parameter 
(Setup menu, Data Source Parameters) by dragging and dropping a data type 
corresponding to that sensor to a channel number of the Data Source Parameter List.  
The channel number identifies the ordering of the data value within the output stream 
of the data logger (which is also the input stream to Met Manager).  Edit the 
properties of the new data source parameter.  Then create a new database parameter 
by dragging and dropping the newly created parameter from the “Acquired 
Parameters” tab of the Database Parameters Editor (Setup menu, Database 
Parameters) to the Database Parameters List (see Section 3.7).  Edit the properties of 
the new database parameter including defining a representative (and unambiguous) 
column heading name.  You may also wish to create additional derived database 
parameters (e.g., minimums, maximums, etc.) that depend on the new data source 
parameter. 

 
24. How do I add a new database parameter to Met Manager?  We assume that you have 

not added a new sensor, and thus do not need to add a new data source parameter.  
(Otherwise see the next question below).  You just need to add a new database 
parameter.  First, close the connection to the active data source (Setup menu, Close 
connection).  Next carefully review the guideline in Section 3.6 for adding or deleting 
data source and database parameters.  Then create a new database parameter by 
dragging and dropping a parameter from one of the tabs of the Database Parameters 
Editor (Setup menu, Database Parameters) to the Database Parameters List (see 
Section 3.7).  Edit the properties of the new database parameter including defining a 
representative (and unambiguous) column heading name. 

 
25. How do I remove a sensor from Met Manager?  First, make sure that the connection 

to the active data source is closed (Setup menu, Close connection). Next carefully 
review the guideline in Section 3.6 for adding or deleting data source and database 
parameters.  Then remove the data source parameter associated with the sensor (see 
Sections 3.6) by selecting the data source parameter (in the Data Source Parameter 
List of the Data Source Parameter Editor dialog), and pressing the “delete” key.  You 
may also need to rearrange the data source parameters to match their order within the 
received data stream.  Finally, delete any dependent database parameters (see Section 
3.7) associated with the deleted data source parameter and reconfigure or remove 
trend charts and indicators. 
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26. How do I remove (delete) a database parameter from the project database?  First, 

make sure that the connection to the active data source is closed (Setup menu, Close 
connection). Next carefully review the guideline in Section 3.6 for adding or deleting 
data source and database parameters.  Then remove the database parameter (see 
Sections 3.7) by selecting it from the Database Parameter List of the Database 
Parameter Editor dialog), and pressing the “delete” key.  Finally, delete or 
reconfigure any dependent database parameters associated with the deleted database 
parameter and reconfigure or remove trend charts and indicators. 

 
27. Why do I have a red “x” on one of my database parameters in the Database 

Parameters editor?  One or more of the “Parameter Reference” properties of the 
database parameter is not defined or is improperly assigned.   This can happen 
accidentally (user error) when setting up a new database parameter, or may happen 
with a data source parameter is removed, and the database parameter depends on that 
data source parameter. 

6.4.8 Data View 
28. How do columns of the Data View (also report listings) get named?  The column 

names come from the “Column heading” property of the database parameter.  See 
Section 3.7 for configuring this property. 

 
29. I see a parameter shown as “New Parameter” in the View menu, Options, then Data 

Columns tab (also Report Columns tab).  What is causing this? The “Column 
heading” name of the database parameter is blank.  See Section 3.7 for configuring 
this property. 

 
30. Why are some of the columns in the Data View missing their names? The “Column 

heading” names of the affected database parameters have not been defined.  See 
Section 3.7. 

 
31. I occasionally get “p” characters following data columns in the Data View.  What is 

causing this?  The “p” denotes that the data is “partially valid”.  This occurs when at 
least one, but less than three-fourths of the samples were acquired for a data interval.  
This may be due to a power outage in which samples were not acquired from the data 
source, or to a communication problem of some kind.  You may wish to go to the 
View menu, then Event Logs, to review any detected communication faults.  

6.4.9 Trend Charts 
32. I have a dual-axis trend chart.  Why do the grid lines not overlay each other?  If you 

wish to auto-scale the chart, then review the “Use automatic scaling” property of both 
the left and right axis.  Make sure that it’s checked (enabled) for both axes.  If you 
wish to use a fixed scale, then make sure that the number of major steps (intervals) is 
the same for both axes.  Also see Section 4.8. 
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33. Why isn’t a trace on my trend chart showing up?  Review the “Data Traces” tab of 
the chart’s trend settings.  Ensure that the trace’s check box is enabled (checked). 

 
34. I have a dual-axis trend chart.  Why is the right axis and all of its assigned traces 

missing?  Review the “Axis Settings” tab of the chart’s trend settings.  Select the 
“Right y axis” property and make sure that the “Show Y axis” box is checked.  This 
will re-enable that axis and all of its assigned traces. 

6.4.10 Indicators 
35. Why are indicators reset when I startup Met Manager? Currently Met Manager does 

not refresh its indicators from the project database at startup.  This will be taken care 
of in a future upgrade. 

 
36. Why are indicators showing red and do not seem to be updating? Met Manager has 

lost communications with the data source (typically a data logger).  Check the 
physical connection between the data logger and the serial communications port of 
the computer that is running Met Manager.  If necessary, close the connection if it is 
active (Setup menu, then Close connection).  Then run the Windows Hyperterminal 
program and see if you can reestablish a connection outside of Met Manager.  Follow 
vendor-supplied instructions. 

6.4.11 Wind Rose 
37. I have a monthly wind rose, but it is shifted off a few days and does not begin at the 

start of the month.  Can I get a monthly wind rose that starts the first hour of the 
month and ends the last hour of the month?  Yes, on the Wind Rose display, press the 
center “Auto-snap” data navigator button on the tool bar.  This will snap the month to 
its beginning.  (This technique also works for daily wind roses). 
 

38. I have three wind direction database parameters; scalar wind direction, resultant 
vector wind direction, and unit vector wind direction.  Which one should I use with 
my wind rose and wind frequency report?  Since the wind rose and wind frequency 
report are based on the frequency content of the wind speed by the direction from 
which the wind blows, it is best to use scalar wind speed (normally just called wind 
speed) and scalar wind direction.  Unlike resultant vector wind direction, the scalar 
wind direction measurement is independent of scalar wind speed.  

6.4.12 Reports 
39. How do I change the units on the daily rainfall report from inch to millimeter (mm)? 

Go to the View Menu, then Options.  Select the “Report Columns” tab.  Then select 
the rainfall parameter and change its units to “mm”. 
 

40. Why are some of the columns in the Daily Summary Report missing their names? 
The “Column heading” names of the affected database parameters have not been 
defined.  See Section 3.7. 
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41. Why are negative temperature values not displaying on the Monthly Parameter 
Report?  Each value field of the report can only print a certain number of digits.  Go 
to the View Menu, then Options.  Select the “Report Columns” tab.  Then decrease 
the number of digits shown to the right of the decimal place (Display Digits). 

6.4.13 Wind Speed and Wind Direction Parameters 
42. Why is the wind direction trace going to 0 degrees?  Met Manager has detected that 

the wind is calm based on measurement of wind speed below the calm threshold.  
This property is defined in the wind speed data source parameter’s properties.   When 
calm wind is detected, Met Manager sets the wind direction to 0 degrees. 

 
43. Isn’t 0 degrees the same thing as 360 degrees as far as wind direction is concerned?  

In some systems there may be no distinction; however, Met Manager uses 0 degrees 
to denote a calm wind direction (i.e., there is no wind direction) and 360 degrees to 
denote that the wind is from the “north”. 

 
44. The wind speed sensor has failed and is reading below the calm threshold setting.  

This is also causing wind direction to read calm.  How can I disable the wind speed 
sensor until I get it repaired, and in the meantime retain the wind direction reading?  
Set the status of the wind speed sensor to “invalid”.  Go to the View menu, 
Instantaneous Data, and press the Maintenance button.  Then select the wind speed 
data source channel from the left column followed by pressing the Invalid button.  
Met Manager will now ignore the wind speed reading.  No calm winds will be 
detected until the wind speed sensor is repaired and return to normal “valid” mode. 

 
45. Wind direction goes to 0 degrees when the wind speed is calm.  This may be fine for 

some applications but I want to retain the wind direction reading all the time, even 
during calm winds.  Can I do this?  Go to the Setup menu, Data Source parameters.  
Set the “calm threshold” property of the wind speed data source parameter to zero 
(0.0).  Since the wind speed can never be less than the threshold of 0.0, a calm will 
never be detected.  (But a calm is indicated in the data for each wind speed of 0.0.) 
This decouples the wind direction data source parameter (and dependent database 
parameters) from the wind speed data source parameter. 
 

46. There are multiple types of wind speed and wind direction parameters within the 
Database Parameter Editor’s “Wind” tab.  Which ones should I use?  Horizontal wind 
speed database parameters include scalar wind speed and resultant wind speed.  
Horizontal wind direction database parameters include scalar wind direction, resultant 
vector wind direction, and unit vector wind direction.  Additional related parameters 
include the standard deviation of wind speed and Sigma-Theta which is the standard 
deviation of wind direction.  USEPA or other state or local governmental 
requirements may require specific parameters depending on your application.  For 
atmospheric modeling and industrial uses, it is recommended that you log all the 
horizontal wind parameters to the database.  That way, the data will be available 
should it be needed later.  For general agriculture purposes, it is recommended that 

   
Troubleshooting Page 6-10 Rev: 1.5 



Met Manager™ User’s Manual  Copyright © 2002 

you retain scalar wind speed, standard deviation of wind speed, scalar wind direction, 
and Sigma-Theta. 

 
47. I can’t find “peak wind speed” in the “Wind” tab of the Database Parameter Editor.  

How do I set it up?  Peak wind speed is actually “maximum” wind speed.  Drag and 
drop a “Maximum” database parameter type (go to Setup menu, then Database 
Parameters; select the “Other” tab of the Database Parameters Editor) to the Database 
Parameter List.  Then edit the properties of this new “Maximum” database parameter.  
Rename it to “Peak Wind Speed”. Assign it a “Column heading” name of “Peak WS” 
(or some other unambiguous descriptor).  Set its units and display decimal digits to 
your preference.  Assign to its “Parameter References” property the corresponding 
channel-based “wind speed” database parameter. 

6.4.14 Communications 
48. How can I tell if I have intermittent communication problems with my continuously-

connected data logger?  You will receive “p” (partially valid) or “m” (missing) codes 
following the data columns in the Data View.  Also go to the View menu, then Event 
Logs to review any detected communication faults. 

6.4.15 Miscellaneous 
49. How are “base units” different from other engineering units?  Base units are just an 

initial set of engineering units.   When the data source parameter arrives in the data 
stream already in engineering units, then the base unit is usually set to be the same as 
the implied engineering unit of the arriving data channel by setting the conversion 
slope and offset properties to 1 and 0 respectively.  However, when the data source 
parameter arrives as a digital voltage or count value, then the conversion slope and 
offset values are used to convert the digital voltage or count into an initial engineering 
unit; that unit being called the “base unit”. 

 
50. I see an “x” following one or more columns of data on the Data View.  It appears that 

Met Manager is somehow invalidating my data.  What is happening? 
 

a. On each new input of sensor data into Met Manager (via a data source parameter 
obtained from the data stream), Met Manager compares the data (in base units) 
to an acceptance range.  If within the range, the data is valid. If outside the 
range, Met Manager invalidates the data and any database parameters derived 
from that data.  Either the sensor has malfunctioned, the range is too narrow or 
incorrect, or there is some other cause.  You may wish to review the data source 
parameter’s properties (Setup Menu, Data Source Parameters). 
 

b. Go to the Instantaneous View (View menu, Instantaneous data) and press the 
Maintenance button.  Then select the channel and verify that the channel has not 
been placed into an “invalid” state.  If so, then take it out of the “invalid” state 
(see Section 5.1).  If it continues to show as invalid then the received data source 
value (in base units) is not within the acceptance range defined for the data 
source parameter (see Section 3.6). 
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51. Met Manager has a direct and continuous connection to the weather station.  

However, Met Manager seems to start slower and won’t generate one of my data 
tables.  What’s wrong?  It is very likely that a power outage occurred or that someone 
shut off the computer without properly shutting down Met Manager.  If Met Manager 
happened to be writing data to its database when this occurred, then one or more of 
the data tables of the database likely got corrupted.  You will have to restore the files 
of the affected data table from a mirrored or backup copy (if you are lucky enough to 
have set one up), or delete them if you have no mirrored copy or backup: 
 

a. Run Met Manager.  Go to the Instantaneous View and ensure that you are 
properly acquiring data from the data logger.  If not, then correct the 
communication problem before you continue. 
 

b. With good communications established with the data logger, go to the Data 
View.  Determine which data table is not updating.  This will be the corrupted 
one.  (There may be more than one; if so, this procedure applies to each). 
 

c. STOP MET MANAGER AND ALL APPLICATIONS THAT MAY BE 
ACCESSING THE PROJECT DATABASE.  This includes Met Mirror and any 
Met Viewer users. 
 

d. With Windows File Explorer, make a backup copy of the entire project folder.  
This step protects against deletions that you could accidentally make in the steps 
below. 
 

e. If you have a mirrored or backup copy of the database, then with Windows File 
Explorer, go to the mirrored (or backed-up) project folder.  Within that folder 
will be several files with names beginning with DATTBL (or dattbl).  Each file 
name ends with the data table interval and a file extension. For example, a 1-
minute data table has the following five files associated with it: dattbl1.db, 
dattbl1.px, dattbl1.val, dattbl1.xg0, and dattbl1.yg0.  Other data intervals have 
similar file names.  Copy all five files for the particular type of data interval 
(data table) of interest from the mirrored project folder to the project folder that 
is maintained by Met Manager.  Go to step g (skip step f). 
 

f. If you do not have a mirrored or backup copy of the database, then you have to 
delete the files associated with the corrupted data table.  With Windows File 
Explorer, go to the project folder.  Within that folder will be several files with 
names beginning with DATTBL (or dattbl).  Each file name ends with the data 
table interval and a file extension. For example, a 1-minute data table has the 
following five files associated with it: dattbl1.db, dattbl1.px, dattbl1.val, 
dattbl1.xg0, and dattbl1.yg0.  Other data intervals have similar file names.  
Delete all five files for the particular type of data interval (data table) of interest 
from the project folder. 
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g. Restart Met Manager and verify that new data can now be added to the data 
table.  Then if applicable, restart Met Mirror and Met Viewer. 

 
52. From the above question, I had to delete a data table from the project folder to correct 

a corrupted database.  What can I do to minimize this type of problem from occurring 
again?  First, install an uninterruptible backup power supply on your computer.  This 
protects your computer against short power outages.  Second, make a daily backup of 
your project database.  That way you can at least restore most of your data.  You can 
also use Met Mirror to make a mirrored copy of the project database.  If properly 
installed, the mirrored copy will be more up-to-date than a daily backup. 
 

53. I just packed the database with Met Manager.  Why didn’t the size of one of the data 
tables change?  Packing has no effect on data tables that are not wrapped.  These data 
tables have their “Keep data indefinitely” property enabled.   Also, the pack will not 
work if some other software such as Met Mirror or Met Viewer is attached to the 
project database.  Met Manager cannot pack the database if other applications are 
using it.  Be sure to shut them down first.  
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APPENDIX A 
DATA SOURCE AND DATABASE PARAMETERS 

 

I. List of Data Source and Derived Database Parameters 
 
Data source parameters represent data values that come from the data stream between 
the data logger (or other source of data such as a file) and Met Manager, and that have 
been converted to base units.  
 
Data source parameters are based on data types.  Data types are meant to be general; for 
example, a “temperature” data type might be ambient temperature, soil temperature, 
indoor temperature or some other type of temperature.  The data type becomes an 
“acquired” data source parameter when the user defines the properties of that data type, 
such as giving the data type a specific name (e.g., ambient temperature). 
 

Table 1 
Data Source Parameters 

 
Data Source Parameters  Units 
  Evaporation or ET in, mm 
  Humidity (relative) % 
  Leaf Wetness 0-100 (unitless) 
  Moisture (soil, etc.) % 
  Precipitation (rain, snow, etc.) in, mm 
  Pressure (barometric, etc.) inHg, mmHg, hPa, kPa, atm, mb, bar, cbar 
  Solar Energy  J/m2, KJ/m2, MJ/m2, W-hr/m2, Langley 
  Solar Radiation (global, net, or direct) W/m2 
  Temperature (all types) °C, °F 
  User-defined Average user-supplied unit 
  Voltage volt, mV 
  Wind Direction (horizontal and vertical) deg, sector (horizontal winds only) 
  Wind Speed (horizontal and vertical) mph, knots, m/s 

 
 
Database parameters are those acquired and derived parameters that the user has 
assigned to be stored within Met Manager’s database. 
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Table 2 
Database Parameters 

 
Derived - Standard Parameters Units 
  Dewpoint °C, °F 
  Heat Index °C, °F 
  Relative Humidity % 
  Solar Energy J/m2, KJ/m2, MJ/m2, W-hr/m2, Langley 
  Wet Bulb Temperature °C, °F 
  Wind Chill Temperature (After Nov 1, 2001) °C, °F 
  Wind Chill Temperature (Traditional) °C, °F 
  
Wind Derived Parameters  
  Resultant Vector Wind Direction (horizontal) deg, sector 
  Resultant Wind Speed (horizontal) mph, knots, m/s 
  Scalar Vertical Wind Direction deg 
  Scalar Vertical Wind Speed mph, knots, m/s 
  Scalar Wind Direction (horizontal) deg, sector 
  Scalar Wind Speed (horizontal) mph, knots, m/s 
  Sigma-Phi (std dev of Vertical Wind Direction) deg 
  Sigma-Theta (std dev of horizontal Wind Dir.) deg 
  Standard deviation of Vertical Wind Speed  mph, knots, m/s 
  Standard Deviation of Wind Speed (horizontal) mph, knots, m/s 
  Unit Vector Wind Direction (horizontal) deg, sector 
  
Agriculture Derived Parameters Units 
   Chill Hour (Standard Base Method) CH (number of chill hours) 
   Chill Hour (Base with Lower Cutoff) CH (number of chill hours) 
   Chill Hour (Base with Lower Cutoff and 
       Ceiling Negation) 

CH (number of chill hours) 

   Chill Unit (32°F to 45°F) CU (number of chill units) 
   Chill Unit (45°F and Under) CU (number of chill units) 
   Chill Unit (Utah Model) CU (number of chill units) 
   Chill Unit (Utah-Pomology Model) CU (number of chill units) 
   Growing Degree Day (Integration) DD°C, DD°F (degree days in °C or °F) 
   Growing Degree Hour (Integration) DH°C, DH°F (degree hours in °C or °F) 
   Crop ET (Integration) in, mm (implied in or mm per time period) 
   Ref. ETos, Short, Standardized ASCE 
      Penman-Monteith (Integration) 

in, mm (implied in or mm per time period) 

   Ref. ETrs, Tall, Standardized ASCE 
      Penman-Monteith (Integration) 

in, mm (implied in or mm per time period) 

  
Energy Derived Parameters  
   Cooling Degree Days (Integration) DD°C, DD°F (degree days in °C or °F) 
   Heating Degree Days (Integration) DD°C, DD°F (degree days in °C or °F) 
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Other Derived Parameters  
   Change (from successive time intervals) Unit is same as primary parameter 
   Difference (over same time interval) Unit is same as primary parameters 
   Maximum Unit is same as primary parameter 
   Minimum Unit is same as primary parameter 
   Rate  User-supplied unit 
   Standard Deviation Unit is same as primary parameter 

 
 
II. Explanation of Data Source and Derived Database Parameters 
 
A. Data Source Parameters 
 
Data source parameters include: 
 

1. Evaporation or ET - Evaporation or evapotranspiration (ET) data type 
2. Humidity - Humidity data type; usually relative humidity 
3. Leaf Wetness - Leaf wetness data type typically scaled from 0 to 100. 
4. Moisture - Moisture data type; for example soil moisture. 
5. Precipitation - The generic type includes rain, snow, ice, etc., but usually 

expressed as “rain” or “rainfall.” 
6. Pressure - Pressure data type; for example barometric pressure. 
7. Solar Energy - Solar energy data type expressed in units of J/m2, KJ/m2, MJ/m2, 

W-hr/m2, or Langley.  A unit of MJ/m2 is commonly used. 
8. Solar Radiation - Solar radiation data type expressed in radiation flux units of 

W/m2. 
9. Temperature - Temperature data type; for example, ambient temperature, 

indoor temperature, soil temperature, and so forth. 
10. User-defined Average - A data type that represents an average value and in 

which the name and units are assigned by the user. 
11. Voltage - A voltage data type; for example, data logger battery voltage. 
12. Wind Direction - A wind direction data type. 
13. Wind Speed - A wind speed data type. 

 
B. “Derived - Standard” Database Parameters 
 
“Standard” derived database parameters include: 
 

1. Dewpoint - The calculation of this parameter requires ambient temperature 
(same as dry bulb temperature) and relative humidity.  
 

2. Heat index - The calculation of this parameter requires ambient temperature 
and relative humidity.  The heat index equals ambient temperature when the 
ambient temperature is below 70 °F. 
 

   
Acquired and Derived Parameters A-3 Rev: 1.5 



Met Manager™ User’s Manual  Copyright © 2002 

3. Relative humidity - Normally this parameter is measured directly.  However, 
it can be calculated from ambient temperature and dew point (when dew point 
is measured).  Units are in percent (%). 
 

4. Solar energy - The calculation of this parameter requires solar radiation.  
Units include J/m2, kJ/m2, MJ/m2, Watt-hr/m2 and Langley.  “MJ/m2” is a 
common selection. 
 

5. Wet bulb temperature - The calculation of this parameter requires ambient 
temperature, dew point and barometric pressure.   
 

6. Wind chill (Nov 1, 2001) - This wind chill temperature is based on the joint 
United States and Canadian wind-chill index effective November 2001.  The 
calculation requires ambient temperature and wind speed.  This newer wind 
chill temperature equals ambient temperature when the wind speed is less than 
3 mph. 
 

7. Wind chill (Traditional) - This wind chill temperature precedes the newest 
update of November 2001.  Its calculation requires ambient temperature and 
wind speed.  This older wind chill temperature equals ambient temperature 
when the wind speed is less than 4 mph. 

 
C. “Wind” Derived Database Parameters 
 
“Wind” derived database parameters are discussed in the U.S. Environmental Protection 
Agency (EPA) document titled “Meteorological Monitoring Guidance for Regulatory 
Modeling Applications,” EPA-454/R-99-005, February 2000.  These parameters include: 
 

1. Resultant vector wind direction (for horizontal wind) 
2. Resultant wind speed (for horizontal wind) 
3. Scalar vertical wind direction 
4. Scalar vertical wind speed 
5. Scalar wind direction (for horizontal wind) 
6. Scalar wind speed (for horizontal wind) 
7. Sigma-Phi, standard deviation of vertical wind direction 
8. Sigma-Theta, standard deviation of wind direction (for horizontal wind) 
9. Standard deviation of vertical wind speed 
10. Standard deviation of wind speed (for horizontal wind) 
11. Unit vector wind direction (for horizontal wind) 

 
D. “Agriculture” Derived Database Parameters 
 
“Agriculture” derived database parameters include: 
 

1. Chill Hour (Base with Lower Cutoff and Ceiling Negation) - One chill hour 
accumulates for each hour that the hourly average ambient temperature is 
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between the base temperature and the lower cutoff temperature.  One hour is 
negated for each hour that the ambient temperature is above the ceiling 
temperature. 
 

Hourly Average Temperature Chill Hour 
TEavg ≤ Lower Cutoff 0.0 

Lower Cutoff < TEavg ≤ Base 1.0 
Base < TEavg ≤ Ceiling 0.0 

TEavg > Ceiling -1.0 
 
The lower cutoff, base, and ceiling temperature values are set by the user 
when the database parameter is first created.  Default settings are: lower cutoff 
temperature (32°F), base temperature (45°F), ceiling temperature (65°F). 
 

2. Chill Hour (Base with Lower Cutoff) - This accumulation of chill hours is the 
same as item 1 above, except there is no negation above a ceiling temperature.  
 

Hourly Average Temperature Chill Hour 
TEavg ≤ Lower Cutoff 0.0 

Lower Cutoff < TEavg ≤ Base 1.0 
TEavg > Base 0.0 

 
Default settings are: lower cutoff temperature (32°F), base temperature 
(45°F). 
 

3. Chill Hour (Standard Base Method) - One chill hour is accumulated for each 
hour that the hourly average ambient temperature is below a user-defined base 
temperature.  There is no lower cutoff temperature with this method. 
 

Hourly Average Temperature Chill Hour 
TEavg ≤ Base 1.0 
TEavg > Base 0.0 

 
The default base temperature is 45°F. 
 

4. Chill Unit (32°F to 45°F) - One chill unit is accumulated for each hour that the 
hourly average ambient temperature is between 32 to 45°F.  
 

Hourly Average Temperature Chill Unit 
TEavg ≤ 32 °F 0.0 

32°F < TEavg ≤ 45 °F 1.0 
TEavg > 45 °F 0.0 
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5. Chill Unit (45°F and Under) - One chill unit is accumulated for each hour that 
the hourly average ambient temperature is 45°F or less. 
 

Hourly Average Temperature Chill Unit 
TEavg ≤ 45 °F 1.0 
TEavg > 45 °F 0.0 

 
6. Chill Unit (Utah Model) - One chill unit, or a fraction of a chill unit, is 

accumulated for each hour that the hourly average ambient temperature is 
within the range stated in the table below:  
 

Hourly Avg Temperature Chill Unit 
TEavg < 35 °F 0.0 

35 ≤ TEavg ≤ 36 °F 0.5 
37 ≤ TEavg ≤ 48 °F 1.0 
49 ≤ TEavg ≤ 54 °F 0.5 
55 ≤ TEavg ≤ 60 °F 0.0 
61 ≤ TEavg ≤ 65 °F -0.5 

TEavg > 65 °F -1.0 
 

7. Chill Unit (Utah-Pomology Model) - One chill unit, or a fraction of a chill 
unit, is accumulated (or negated) for each hour that the hourly average 
ambient temperature is within the range stated in the table below:  
 

Hourly Avg Temperature Chill Unit 
TEavg < 34.01 °F 0.0 

34.01 ≤ TEavg < 36.01 °F 0.5 
36.01 ≤ TEavg < 48.01 °F 1.0 
48.01 ≤ TEavg < 54.01 °F 0.5 
54.01 ≤ TEavg < 60.01 °F 0.0 
60.01 ≤ TEavg < 65.01 °F -0.5 

TEavg > 65.01 °F -1.0 
 

8. Growing Degree Day (Integration) - Daily growing degrees are calculated by 
totaling (integrating) the Growing Degree Day values reported for each hour 
of the day. 
 

Hourly Average Temperature Growing Degree Days 
(for the hour) 

TEavg ≤ Base 0.0 
Base < TEavg ≤ Ceiling (TEavg - Base)/24 

TEavg > Ceiling (Ceiling - Base)/24 
 
The base and ceiling temperature settings are supplied by the user when 
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creating the Growing Degree Day database parameter.    The default ceiling 
and base temperatures are 86°F and 50°F, respectively. 

 
9. Growing Degree Hour (Integration) - Hourly growing degrees are 

accumulated for each hour that the hourly average ambient temperature is 
within the range stated in the table below:  
 

Hourly Average Temperature Growing Degree Hours 
TEavg ≤ Base 0.0 

Base < TEavg ≤ Ceiling (TEavg - Base) 
TEavg > Ceiling (Ceiling - Base) 

 
The base and ceiling temperature settings are supplied by the user when 
creating the Growing Degree Hour database parameter.  The default ceiling 
and base temperatures are 86°F and 50°F, respectively. 

 
10. Crop ET (Integration) - Daily Crop Evapotranspiration (ETC) is calculated by 

totaling (integrating) the Crop ET values reported for each hour of the day.   
 
For a crop ET based on a reference to short grass (similar to clipped grass): 

 
ETC = ETos x KC x KSTRESS 

 
For a crop ET based on a reference to tall grass (similar to alfalfa):  
 

ETC = ETrs x KC x KSTRESS 
 

where: 
 
 ETC = Crop Evapotranspiration (mm or inch per period) 
 

ETos = Reference Evapotranspiration calculated from the 
standardized short-grass ASCE Penman-Monteith equation (mm or 
inch per period); see items11 and 12 below. 
 
ETrs = Reference Evapotranspiration calculated from the 
standardized tall-grass ASCE Penman-Monteith equation (mm or 
inch per period); see items11 and 12 below. 
 
KC = Crop coefficient (dimensionless) 
KSTRESS = Stress factor (dimensionless); 0 to 1.0 (1.0 if no stress) 

 
The default KC and KSTRESS coefficients have values of 1.0. 

 
11. Ref. ETos, Short, Standardized ASCE Penman-Monteith: Daily Reference ET 

(ETos) as referenced to a short grass of 0.12 m height (similar to clipped grass) 
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and calculated by totaling (integrating) the Reference ETos values reported for 
each hour of the day.  For further information, refer to the report on The 
ASCE Standardized Reference Evapotranspiration Equation, Environmental 
and Water Resources Institute of the American Society of Civil Engineers, 
Standardization of Reference Evapotranspiration Task Committee, December 
21, 2001. 
 

12. Ref. ETrs, Tall, Standardized ASCE Penman-Monteith: Daily Reference ET 
(ETrs) as referenced to a tall grass of 0.50 m height (similar to full-cover 
alfalfa) and calculated by totaling (integrating) the Reference ETrs values 
reported for each hour of the day.  For further information, refer to the report 
on The ASCE Standardized Reference Evapotranspiration Equation, 
Environmental and Water Resources Institute of the American Society of 
Civil Engineers, Standardization of Reference Evapotranspiration Task 
Committee, December 21, 2001. 

 
E. “Energy” Derived Database Parameters 
 
“Energy” derived database parameters include: 
 

1. Cooling Degree Day (Integration) - Daily cooling degrees are calculated by 
totaling (integrating) the Cooling Degree Day values reported for each hour of 
the day based on the range in the following table: 
 

Hourly Average Temperature Cooling Degree Days 
(for the hour) 

TEavg ≤ Base 0.0 
TEavg > Base (TEavg - Base)/24 

  
The default base temperature is 65°F. 

 
2. Heating Degree Day (Integration) - Daily heating degrees are calculated by 

totaling (integrating) the Heating Degree Day values reported for each hour of 
the day based on the range in the following table: 
 

Hourly Average Temperature Heating Degree Days 
(for the hour) 

TEavg < Base (Base - TEavg)/24 
TEavg ≥ Base 0.0 

  
The default Base temperature is 65°F. 
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F. “Other” Derived Database Parameters 
 
“Other” derived database parameters include: 
 

1. Change - This parameter calculates the change of a parameter between two 
successive measurement intervals (for example, change of barometric 
pressure). 
 

2. Difference - This parameter calculates the difference between two parameters 
of the same type over the same time interval (for example, temperature 
difference as the difference between the measurements from two matched 
temperature probes located at different heights on a meteorological tower. 

 
  Difference = Parameter 1 - Parameter 2 
 

3. Maximum - This parameter calculates the maximum (or high) of a parameter 
over a measurement interval (for example, maximum or peak wind speed). 
 

4. Minimum - This parameter calculates the minimum (or low) of a parameter 
over a measurement interval (for example, minimum or low ambient 
temperature). 
 

5. Rate of a Totalized Value - This parameter calculates the rate of a totalized 
value over a measurement interval (for example, rate of rainfall). 
 

6. Rate of an Averaged Value - This parameter calculates the rate of an averaged 
value over a measurement interval (for example, rate of ambient temperature). 
 

7. Standard Deviation - This parameter calculates the standard deviation of a 
parameter over a measurement interval.  Note that wind speed and wind 
direction parameters require special processing, so their standard deviation 
should be calculated by selecting an appropriate derived parameter from the 
“Wind” tab. 
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APPENDIX B 
MET MIRROR UTILITY 

 
I. Overview 
 
Met Mirror™ is used to create and update a copy of the Met Manager database.   This is 
referred to as mirroring.  The Met Mirror software is used only in a networked 
environment and its use is optional. 
 
II. Installing Met Mirror 
 
The Met Mirror software is automatically installed on a Windows-based workstation 
during installation of the Met Manager software. 
 
IMPORTANT: Met Mirror uses the Windows registry to retain information about its 
definition files.  This information is then read from the registry on startup of Met Mirror.  
Therefore, Met Mirror must be installed in a way that it can have create/read/write access 
to the Windows registry.  Before installing Met Mirror, check with your network or 
system administrator to ensure that your log-on profile is configured to allow Met Mirror 
to have create/read/write access to the Windows registry.   
 
Refer to Section 2.3 for scenarios for using Met Manager, Met Viewer, and Met Mirror.  
Included are requirements for project folder read/write/create access permission 
depending on your application requirements. 

 
IMPORTANT: Configure Met Mirror to automatically startup when Windows starts up.  
Place a shortcut of the Met Mirror executable program (metmrr.exe) in the Windows 
“Startup” folder.  This folder may be located under “Administrators”, “All Users”, 
“Default Users“, or may be applicable only to your particular log-on profile depending on 
your version of Microsoft Windows.  Check with your network or system administrator 
for the proper startup folder to contain the Met Mirror shortcut. 
 
Command line options are not required but are useful for forcing Met Mirror to open a 
particular definition file when starting up in Windows.  If you use a command line 
option, you will want to assign it to the Met Mirror shortcut in the Windows “Startup” 
folder.  See Appendix D.  
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III. Using the Software 
 
When Met Mirror is run, the following dialog is displayed: 
 

 
 

Select the drop down box in the upper left corner to add a new mirror definition name to 
hold the Met Mirror settings, or to select an existing mirror definition name.  As an 
example, the following figure shows that a mirror definition named “TAMU V4 
Mirrored” already exists: 

 

 
 

(The above figure is an example only; your configuration may be different.) 
 

Check the “Hide application on startup” option to hide Met Mirror from the desktop 
when it is run.  Met Mirror appears as an icon in the “tray” region of the Windows task 
bar. 
 
Check the “Perform database wrap” option to wrap the mirrored database on startup of 
Met Mirror with the same wrap options as performed by Met Manager.  This is useful if 

   
Met Mirror™ Utility B-2 Rev: 1.5 



Met Manager™ User’s Manual  Copyright © 2002 

you periodically, but not continuously, run Met Mirror.  In any event, Met Mirror 
performs this wrap function at midnight. Thus if Met Mirror is run continuously, it’s best 
to leave this box unchecked. 
 
Check the “Terminate application after Mirror is up-to-date” to stop Met Mirror as soon 
as it has updated the mirrored database to match the original database managed by Met 
Manager.  For continuous mirroring, leave this box unchecked. 
 
In the “Source folder/directory for Met database”, enter the path and folder name to Met 
Manager’s project. 
 
In the “Destination folder/directory for Met database”, enter the path and folder name to 
Met Mirror’s project.  This is the path and folder name for the destination location of the 
mirrored database.  The path/folder must be created outside of Met Mirror; for example, 
with Microsoft Windows File Explorer software. 
 
Select (check) each of the data tables that you want mirrored.  Note that the hourly data 
table is always mirrored; thus you cannot select it.  It is alright to select a Met Manager 
data table that does not exist as the setting will be ignored.  That way, should a new data 
table later be added to Met Manager, the new table will then be automatically mirrored by 
Met Mirror. 
 
IMPORTANT: Press the “Save” button to save the settings.  The settings will be saved 
in the Windows registry under the definition name given to the mirror. 
 
To start the mirror activity, press the “Start” button.  To hide the mirror from the desktop, 
but still keep its “Met” icon in the tray region of the Windows desktop, press the “Hide” 
button. 
 
Below is an example of settings for a continuously-connected mirror definition named 
“TAMU V4 Mirrored”: 
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(The above figure is an example only; your configuration may be different.) 
 

 
IV. Auto-starting Met Mirror 
 
For normal usage in which Met Mirror continuously maintains a mirrored copy whenever 
Met Manager is running, follow these steps: 
 
1. Run Met Mirror and add a new mirror name, or select an existing name (from the 

drop down box).  Then configure the settings and press the “Save” button. 
 

2. Setup Met Mirror to run in the Windows “Startup” folder as discussed in Section II 
above.  

 
IMPORTANT: If you use a command line option when starting Met Mirror, be sure to 
set the “-o” (oh; not zero) command line option with the identical name of the mirror 
definition.  If the name includes spaces, then you must include the entire -o and name 
within quotation marks (e.g., “-oMirror Name”).  In the above example (Section III), the 
command line option is “-oTAMU V4 Mirrored” to automatically activate a definition 
named “TAMU V4 Mirrored” on startup of Met Mirror. 
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APPENDIX C 
MET DATABASE UTILITY 

 
I. Overview 
 
The Met Database Utility (sometimes referred to as “MetDBU”) is used to perform 
periodic maintenance on a mirrored database.  With this utility, you can restructure the 
database, and can pack it.  Restructuring is useful only to fix a structure problem with the 
mirrored database, should it ever occur. Packing permanently removes all deleted records 
from the database, and should be performed periodically on data tables that are wrapped. 
 
Note:  The restructure and pack capabilities are also included in the Setup menu of Met 
Manager for maintenance of the database managed by Met Manager.  The advantage of 
having a separate utility program is that this program can be run on mirrored copies of the 
database, and independently of Met Manager. 
 
 
II. Installing the Met Database Utility 
 
The MetDBU utility software is automatically installed on a Windows-based workstation 
during installation of the Met Manager software.  Once installed, select and run the Met 
Database Utility program from the Start | Program menu of the Windows desktop.  You 
can also setup a shortcut icon on the desktop. 
 
Note: Command line options are normally not required for MetDBU but are useful for 
forcing MetDBU to start in a particular way.  See Appendix D.  
 
 
III. Restructuring the Project Database 
 
The project database managed by Met Manager or Met Mirror must be restructured when 
changes are made to the database parameters.  For example, when adding or removing 
acquired or derived parameters, the database must be modified to reflect the added or 
removed fields. 
 
IMPORTANT:  Met Manager automatically restructures its project database when new 
parameters are added or deleted.  Therefore you will not normally perform a restructure 
with MetDBU.  The only time you will use MetDBU to perform a restructure is when 
something happens to the structure of a mirrored database, and you need to repair it. 
 
IMPORTANT:  Before restructuring, insure that there are no active connections to the 
database.  This includes connections by Met Manager, Met Viewer, Met Mirror, or any 
other import/export/reporting software.  Stop and close all programs that may have 
connections to the database. 
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CAUTION: Be sure that you have a good backup of the project database before 
restructuring it. 
 
The following dialog is displayed when the Met Database Utility software is run: 
 

 
 
To restructure a database, locate the project folder with the “Browse” button and press 
the “Restructure” button. 
 
Note: The restructure operation can take awhile, in some cases 20 to 30 minutes (or 
longer) depending on the number and size of the data tables, and speed of your network. 
 
The restructure operation can fail for the following reasons: 
 

• There is still an active connection to the database (i.e. Met Manager, Met Viewer, 
or Met Mirror may still be running).  The database cannot be restructured when an 
active database connection exists. 
 

• A file error occurs.  If a file error occurs while attempting to restructure the 
database, the restructure will fail. 
 

IMPORTANT: Following the restructure operation, restart Met Mirror and any other 
programs that need access to the mirrored project database. 
 
IV. Packing the Project Database 
 
The project database managed by Met Mirror must be periodically packed so that deleted 
records are permanently removed from the database.  For instance, if data for a 1-minute 
table is "wrapped" at seven (7) days, the records deleted from the table by the wrap 
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function still remain in the database even though they are not visible to the application.  
Even when a wrap is used, the wrap function does not reduce the actual size of the file.  
To reduce the file size and permanently remove the deleted records, the database must be 
periodically packed. 
 
IMPORTANT: To pack Met Manager’s project database, use the “Pack” operation 
located in Met Manager’s Setup menu.  Only use the MetDBU utility to pack a mirrored 
project database. 
 
Below is a recommended pack schedule; use the minimum pack schedule (i.e., maximum 
frequency) that applies to your table configuration. 
 

Data Table Interval 
(with “Delete data older 

than” option set) 

 
Pack Schedule 

1 Minute Data Table Every 1 month 
5 Minute Data Table Every 3 months 
10 Minute Data Table Every 6 months 
15 Minute Data Table Every 6 months 
20 Minute Data Table Every 6 months 
30 Minute Data Table Every 6 months 

Hourly Data Table Once a year 
 
 

Note: You do not have to pack data tables that are setup with the “Keep data indefinitely” 
option, since these data tables are not wrapped. 
 

Note: When a pack is performed, all the data tables within the project database are 
packed.  That’s why the pack schedule should be based on the minimum period 
(maximum frequency) of the data tables assigned to the project. 
 
IMPORTANT: Before packing, insure that there are no active connections to the 
database.  This includes connections by Met Manager, Met Viewer, Met Mirror, or any 
other import/export/reporting software that is attached to the database.  For all programs 
that may have a connection to the database, stop and close them to remove their 
connections. 
 
To pack the database and permanently remove any deleted data records, select the “Pack” 
tab.  The following dialog is then displayed: 
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Locate the project folder with the “Browse” button and press the “Pack” button.  
 
Note: The pack operation can take awhile, in some cases 20 to 30 minutes (or longer) 
depending on the number and size of the data tables, and speed of your network. 
 
The pack operation can fail for the following reasons: 
 

• There is still an active connection to the project database (i.e., Met Manager, Met 
Viewer, or Met Mirror may still be running).  The database cannot be packed 
when an active database connection exists. 
 

• A file error occurs.  If a file error occurs while attempting to pack the database, 
the pack operation will fail.   

 
IMPORTANT:  Following the pack operation, restart Met Mirror and any other 
programs that need access to the mirrored database. 
 
 
V. Met Database Utility Command Line Options 
 
You can also start the Met Database Utility software with a command line option.   Edit 
the utility’s properties to include a command line startup option. For further instructions, 
see Appendix D - Command Line Options. 
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APPENDIX D 
COMMAND LINE OPTIONS 

 
I. Overview 
 
Why would someone want to use a command line option?  Command line options 
provide flexibility in the startup and subsequent use of Met Manager, Met Viewer, Met 
Mirror, and Met Database Utility software.   For example, in conjunction with a task 
scheduler (such as provided with Windows 98 and beyond), Met Manager can be 
configured to startup and acquire data from a particular data source, for example a “Data 
Log Capture (Modem)” data source, and store the acquired and derived data parameters 
into a particular project folder: 
 

 
 

(Example from “Scheduled Tasks” of the Control Panel of Windows 2000 Workstation) 
 
In this way, Met Manager can retrieve data from multiple remote weather stations and 
can store the data into separate projects.  Or, you may wish to force the software to 
startup and open a particular project and use a particular data source to override any user 
configuration settings.   
 
The command line option is defined in Windows by accessing and selecting a shortcut to 
the program executable, right-clicking on the shortcut with the mouse, and then setting 
the “properties”.  The program executable names are: 
 
 Met Manager = metmgr.exe 
 Met Viewer = metvwr.exe 
 Met Mirror = metmrr.exe 
 Met Database Utility = metdbu.exe 
 
For example, to setup the Met Manager command line, right-click on a shortcut created 
from the Met Manager program executable; then select the “Properties” item: 
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or right-click on Met Manager from the Windows desktop “Start Programs” menu: 
 

 
 

Then select “Properties” and configure the “Target” property with the desired command 
line option: 
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(The above figure is an example only; your configuration may be different.  Also, the 
setup requirements may be different for different version of Microsoft Windows.  The 
above example is for a Windows 2000 workstation.) 
 
An example “Target” command line for Met Manager is:  
 
"C:\Program Files\Met Manager\Met Manager 4\metmgr.exe” "-pC:\my 
projects\weather” "-oDirect Connect” 
 
See below for a description of the above command line option.  
 
IMPORTANT: Met Manager, Met Viewer, and Met Mirror use the Windows registry to 
retain information about how they were last shut down.  This information is then read 
from the registry on startup.  Therefore, these programs must be installed in a way that 
they can have create/read/write access to the Windows registry.  Before installing these 
programs, check with your network or system administrator to ensure that your log-on 
profile is configured to allow these programs to have create/read/write access to the 
Windows registry.   
 
IMPORTANT: Also refer to Section 2.3 for scenarios for using Met Manager, Met 
Viewer, and Met Mirror.  Included are requirements for project folder read/write/create 
access permission depending on your application requirements. 
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IMPORTANT: Configure Met Manager and Met Mirror to automatically startup when 
Windows starts up.  Place a shortcut of the Met Manager and Met Mirror executable 
programs (metmgr.exe and metmrr.exe) in the Windows “Startup” folder.  This folder 
may be located under “Administrators”, “All Users”, “Default Users“, or may be 
applicable only to your particular log-on profile depending on your version of Microsoft 
Windows.  Check with your network or system administrator for the proper startup folder 
to contain the shortcuts.  (You may also want Met Viewer to automatically startup when 
Windows starts up.  If so, the same requirements apply to Met Viewer.)  
 
II. Met Manager 
 
The command line format is: 
 
 ..\path\metmgr.exe [-p][-][project path] [-o][data source name] 
 
where: 
 

“..\path\” is the path to the Met Manager executable program; in the example of 
Section I as “C:\Program Files\Met Manager\Met Manager 4\”.  Replace “..\path\” 
with your actual path name to the Met Manager executable program on your 
computer. 

 
“MetMgr.exe” is the name of the Met Manager executable program 
 
-p is the command line option for specifying a project to open on startup or selecting 

no project to be opened. 
 
For example, to open a project in the folder <C:\My Projects\Weather>, the 
command line is: 
 
“..\path\metmgr.exe” "-pC:\my projects\weather” 
 
To insure that Met Manager does not open a project when it starts up, then the 
command line is: 
 
“..\path\metmgr.exe” -p- 
 
If no -p option is specified, then the default action is to open the project that was 
active when Met Manager was last shut down.  The project pathname is read from 
the Windows registry. 
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-o is the command line option for automatically opening a named data source when 
the project, specified by the -p option, is opened.  This action is valid as long as 
you did not rename the data source within Met Manager. 
 
IMPORTANT:  The data source name within Met Manager must exactly match 
the name given in the -o option. 
 
If no -o option is specified, the default action is to open the named data source 
that was active when Met Manager was last shut down.  If Met Manager was 
logging data from the data source when Met Manager was shut down, then Met 
Manager will begin logging data from the named data source when started back 
up.  However, this default action is not implemented if a project is not opened.  

 
For example, to open a project in the folder <C:\My Projects\Weather> and automatically 
begin data collection using a pre-defined data source name of “Direct Connect” then the 
command line would be: 
 
 “..\path\metmgr.exe” "-pC:\my projects\weather” “-oDirect Connect” 
 
IMPORTANT: If a command line option has embedded blank spaces in it, then the 
entire command line option must be enclosed in double quotation marks. 
 
III. Met Viewer 
 
The command line format is: 
 
 ..\path\metvwr.exe [-p][-][project path] [-u][user name] 
 
where: 
 

“..\path\” is the path to the Met Viewer executable program.  Replace “..\path\” with 
your actual path name to the Met Viewer executable program on your computer. 

 
“Metvwr.exe” is the name of the Met Viewer executable program 

 
-p is the command line option for specifying a project to open on startup or selecting 

no project to be opened. 
 
For example, to open a project in the folder <C:\My Projects\Weather>, the 
command line is: 
 
“..\path\metvwr.exe” "-pC:\my projects\weather” 
 
To insure that Met Viewer does not open a project when it starts up, then the 
command line is: 
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“..\path\metvwr.exe” -p- 
 
If no -p option is specified, then the default action is to open the project that was 
active when Met Viewer was last shut down.  The project pathname is read from 
the Windows registry. 

 
-u is the command line option that specifies the user view settings to apply in Met 

Viewer. 
 
For example, to open a project in the folder <C:\My Projects\Weather> and apply the 
user setup view settings for Met Viewer user <RJones>, then the command line would 
be: 
 
 “..\path\metvwr.exe” "-pC:\my projects\weather” "-uRJones" 
 
Note: At startup, the default action if no -p command line option is specified, is to open 
the project that was opened prior to shutting down Met Viewer.  Similarly, the default 
action if no -u command line option is specified and the same project is opened, is to use 
the view settings of the last user setup that viewed the project.   
 
IMPORTANT: If a command line option has embedded blank spaces in it, then the 
entire command line option must be enclosed in double quotation marks. 
 
IV. Met Mirror 
 
The command line format is: 
 
 ..\path\metmrr.exe [-o][definition name] 
 
where: 
 

“..\path\” is the path to the Met Mirror executable program.  Replace “..\path\” with 
your actual path name to the Met Mirror executable program on your computer. 

 
“metmrr.exe” is the name of the Met Mirror executable program 

 
-o is the command line option for specifying a mirror definition to activate on 

startup.  This definition is retained in the Windows registry. 
 
For example, to run met mirror and activate the definition named <Test Mirror>, then the 
command line would be: 
 
 ..\path\metmrr.exe "-oTest Mirror" 
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Note:  A command argument with [/O] instead of [-o] is accepted in order to be backward 
compatible with previous versions of Met Mirror.  Always use “-o” (oh; not zero) instead 
of “/O” to be compatible with current and future versions of Met Mirror. 
 
Note: At startup, the default action if no -o command line option is specified, is to not 
open any mirror definition.  
 
IMPORTANT: If a command line option has embedded blank spaces in it, then each 
entire command line option must be enclosed in double quotation marks. 
 
V. Met Database Utility 
 
The command line format is: 
 
 ..\path\metdbu.exe [-p][project path] [-u+] [-a][{Pack}{Restructure}] 
 
where: 
 

“..\path\” is the path to the Met Database Utility executable program.  Replace 
“..\path\” with your actual path name to the utility program on your computer. 

 
“metdbu.exe” is the name of the Met Database Utility executable program 

 
-p is the command line option for specifying a project to open.  For example, to open 

a project in the folder <C:\My Projects\Weather>, the command line is: 
 
“..\path\metdbu.exe” "-pC:\my projects\weather” 
 
To insure that MetDBU does not open a project when it starts up, then the 
command line is: 
 
“..\path\metdbu.exe” -p- 
 
If no -p option is specified, then the default action is to open the project that was 
active when MetDBU was last shut down.  The project pathname is read from the 
Windows registry. 

 
-u is the command line option specifying user interaction.  The default is -u- for no 

user interaction.  For user interaction, use -u+. 
 

-a is the command line option for specifying the action for the database utility to 
automatically perform.  The action must be one of the following: “Pack” or  
“Restructure”; for example: 

 
 ..\path\metdbu.exe “-pC:\my projects\weather” -u+ -aPack 
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APPENDIX E 
Calibration Overview 

 
I. Data Path and Adjustments 
 
The path from a physical weather variable to the data displayed in a table or a graph is 
not trivial.  The figure below illustrates a typical path beginning at the input to the MET 
Instrument, proceeding to the Data Logger, and on to the Met Manager™ software for 
storage and presentation. 
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FIGURE 1 

While on its path to the user, the measured weather variable may be altered in up to three 
different ways: 
 

1. The variable may be physically altered by mechanical adjustments in the MET 
Instrument. 
 

3. The variable may be altered by computer calculations (including digital slope and 
offset adjustments) in the Data Logger, Met Manager, or both.   

 

2. The variable may be electronically altered in the MET Instrument, the Data 
Logger, or both.  This usually involves amplifiers and potentiometers that alter the 
analog gain and offset.  
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There are four reasons a weather variable may be altered: 

2. The variable is converted into a digital number that can be stored, displayed, and 
analyzed with the aid of a data logger or computer.   
 

3. The variable is converted into engineering units appropriate for the physical 
weather variable being measured.   
 

4. The variable should be adjusted to agree with accepted calibration standards 
thereby assuring the accuracy of the measurement is suitable for its intended use. 

 

 
Calibration adjustments can be made in any of the three major system components.  It is 
very important that calibration adjustments be made with care to assure corrections are 
not erroneously applied in multiple places.  Multiple calibration corrections could result 
in incorrect values being stored and presented in various tables, reports, and graphs. 
 

 
There are pros and cons to consider when deciding where and how to adjust the 
measurement to agree with calibration standards.  There is usually a tradeoff between 
convenience, component interchangeability, and accuracy.  Component 
interchangeability is enhanced if the Met Instrument and Data Logger are individually 
and independently calibrated.  In doing so, the Met Instrument is connected to an 
appropriate calibration standard and its output is adjusted physically and/or electronically 
to its specified nominal values corresponding to the values of the standard connected to 
its input.  This requires an additional instrument to measure the output of the Met 
Instrument.  Similarly, the corresponding Data Logger channel is calibrated by 
connecting its input to a calibration standard that provides a signal of the same physical 
type (e.g. if the MET Instrument is a temperature to voltage device, then a volt meter and 
source are required) as the output of the Met Sensor and adjusting the Data Logger’s 
output until it agrees with the standard.  Note that this requires two standards and the 
ability to accurately measure the output of the Met Instrument.  It makes the accuracy and 
traceability of the output of the weather instrument an additional calibration and accuracy 
burden.  The benefit is that either the Met Instrument or the Data Logger can be replaced 
and the measurement accuracy will remain with the limits established by the entire 
ensemble of instrumentation.  The calibration ensemble that affects the overall accuracy 
includes: 

1. The variable is converted from its physical form to an electronic signal (voltage, 
current, resistance, counts, pulses, etc.) with appropriate range and resolution.   
 

Each of these reasons can be accomplished in one or more of the major system 
components.  Usually, physical conversion and initial electronic signal scaling are done 
in the Met Instrument.  Signal scaling, conversion to digital form, and initial engineering 
units conversions are often done in the Data Logger.  Base unit and other engineering unit 
conversions are usually done in Met Manager. 

II. Calibration Methods 
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• The Met Instrument (precision, drift, and stability) 

• AND the weather variable calibration standard (accuracy) 
• AND the instrument used to measure the output of the Met Instrument (accuracy) 
• AND the standard used to calibrate the Data Logger (accuracy) 

CAUTION:  In the above context, it is very important that adjustments made in the Met 
Instrument pertain only to the Met Instrument’s accuracy and that adjustments made to 
the Data Logger pertain only to the Data Logger’s accuracy.   

 
Note:  Additionally, steps should be taken during the calibration process to demonstrate 
the overall integrity of the data.  If the data is stored and processed by a computer that is 
located downstream of the Data Logger, it is a good practice to provide calibration data 
that demonstrates that the data stored and presented are in good agreement with the 
weather variable calibration standard.  This requires observations and recording of data 
stored and displayed on the computer located downstream of the Data Logger. 

Accuracy and convenience are enhanced with an “endpoint-to-endpoint” calibration.  
With this type of calibration, a calibration standard for the weather variable is connected 
to the input of the Met Instrument. Then the output of the Data Logger, or the output of a 
downstream computer, is observed.  The values of intermediate signals are not relevant.  
While the Met Instrument and the Data Logger are not interchangeable without 
calibration, the total error is reduced because the calibration ensemble (i.e. the number of 
devices contributing error) has been reduced to only: 
 

• The Met Instrument (precision, drift, and stability) 
• The Data Logger (precision, drift, and stability) 

 
Reducing the total error is great, but a critical question remains.  If the observed output 
does not agree with the standard, where should you make the required adjustments?  
Should you adjust the Met Instrument or the Data Logger?  In most cases, the computer 
downstream of the Data Logger does not provide calibration support.  This is not the case 
with Met Manager.  Met Manager facilitates “endpoint-to-endpoint” calibrations by 
providing calculations to correct for linear errors.  Met Manager also simplifies the 
calibration process. 
 
III. Met Manager Calibration 
 
Met Manager provides three levels of basic signal adjustments: 
 

• Correction for calibration slope and offset (optional). 
• Conversion to a broad set of additional engineering units for display and analysis. 

• The Data Logger (precision, drift, and stability) 

 

 

• AND the weather variable calibration standard (accuracy) 

• Conversion from the Data Logger’s output format to base units. 
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Each level of adjustment made by Met Manager is distinct and separate, having its own 
slope and offset.  

Met Manager’s initial calibration slope and offset adjustments are assigned default values 
of one and zero, respectively.  If these values are not changed (via Met Manager’s 
calibration capability), then it is expected that any necessary calibration adjustments have 
been made in the Met Instrument and/or the Data Logger.  This is usually appropriate for 
standalone applications where the Data Logger is located remotely from Met Manager, or 
in which the data from the Data Logger is made available to more than one external 
application.  For cases in which Met Manager is directly connected to a local Data 
Logger, and is the only direct consumer of the data from the Data Logger, then it is 
appropriate to perform an endpoint-to-endpoint  calibration from the Met Instrument to 
Met Manager using Met Manager’s internal calibration capability. 
 
IMPORTANT:  If calibration adjustments are made at the Met Instrument or the Data 
Logger, then ensure that Met Manager’s calibration slope and offset are set to one and 
zero respectively so that Met Manager will not apply additional calibration corrections to 
the weather variable. 
 

IV. Additional Considerations 
 
If an “endpoint-to-endpoint” calibration with Met Manager is more accurate and more 
convenient and component interchangeability does not drive the decision, then why 
would you ever use another method?  When the system operates in a stand-alone batch 
mode, there may be other computers, in addition to the one running Met Manager, that 
connect to the Data Logger to extract and use the data (See Figure 2 below).  If Met 
Manager were used to adjust for calibration errors, then only Met Manager would have 
the correct calibrated values.  For the other computers to have corrected data values, it is 
important that the data be properly calibrated at the point of distribution.  Therefore, in 
this case, any necessary calibration adjustments should be performed in the MET 
Instrument, the Data Logger, or both.  (An “end-point to end-point” calibration is still 
possible if one considers the output of the Data Logger as the “end-point” of the system 
for calibration purposes.) 
 

Each of the signal adjustments is a linear transformation as described below:   

offsettheisband
slopetheism

adjustmentaftervaluetheisy
adjustmenttopriorvaluetheisx:where

bxmy +•=
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FIGURE 2 
What do you do if you have decided that the calibration adjustments should be made in 
the MET Instrument and Data Logger but the Data Logger is only storing relatively long- 
term aggregate values such as one hour averages?  This can significantly complicate the 
calibration process because it may be difficult to get the calibration standard to create a 
constant value for the entire averaging period.  While it is desirable to calibrate a weather 
station as it operates in its normal configuration, some temporary configuration changes 
may be required in order to get a more timely output response from the Data Logger.  
Consult the weather station or Data Logger user manual for ways to increase the 
frequency of the Data Logger’s output (for calibration purposes) while maintaining the 
integrity of post-calibration long-term aggregate values. 
 
Note:  If the Data Logger’s operating configuration is changed to facilitate calibration 
adjustments, it is recommended that some data be captured, following calibration 
adjustments, with the calibration standard connected and the Data Logger reset back to its 
normal configuration.  This data should be transferred to, and processed by, the post Data 
Logger computer.  Verify that the outputs agree with the calibration standard.  Otherwise, 
find and fix the cause of the error. 
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